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1 Introduction

Creating Web-Server Based HMI's

Thank you for choosing Saia®S-Web technology.
This manual describes the features and use of the Saia®S-Web Editor as add on-
tool with the Saia®PG5 programming utilities. With the S-Web Editor, dynamic
web pages for the Saia®PCD.Web-Server can be created very easily.
Continuous integration and use of Saia®PCD.Web technology is changing the
automation environment in the areas of commissioning, service, control and
monitoring.

Web Browser As Tool For Commissioning And Service

Although most systems, installations and equipment are currently still
commissioned and serviced with specific, proprietary software tools, the use of
web technologies now enables the latter to be replaced with standard tools, such
as Internet Explorer. No specialist know-how is required to operate a browser,
and user acceptance is high. Predefined HTML pages allow optimized device and
system management during commissioning and service. Specific HTML pages for
different user groups also significantly increase convenience and safety, at the
same time greatly reducing costs.

Control And Monitoring With Web Technology

Even for simple control and monitoring functions, costly and often complex Scada
systems have been used. These tasks are ideally suited to the use of a web
server and browser, avoiding the costs of expensive development tools and
runtime licenses. Another advantage of web technology is the vendor-
independent, standard interface between the control system and management
level.

Create Java-Based Web Pages Easily, With The Convenient S-Web Editor

S-Web editor for creation of dynamic, graphical web pages for the Saia®PCD.
Web-Server by simply placing graphical objects and setting their parameters. No
knowledge of HTML or Java programming is required. The graphical objects are
specially adapted to Saia PCD devices. The S-Web editor is an integral part of
Saia PG5 programming tool.

Continuous Access Via Any Preferred Interfaces And Networks

Access to the Web-Server in Saia®PCD devices is possible not only via Ethernet-
TCP/IP, but also via economical, standard serial ports (RS232, RS485,
modem ...) or Profibus networks. All this takes place continuously across the
different network levels.

Saia®PCD.Web-Server Integrated In All Products

Since 2000, a Web-Server has been integrated in the base units of all new Saia
controllers (such as PCS1, PCD2, 3, 4 and PCD3.RIO) at no extra cost.

Basic Principles Of Saia®S-Web
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Web-Server

The Web-Server is the heart of the entire Saia®S-Web concept. The Web-Server
is integrated in the base unit of all new Saia controllers and remote I/Os. It sends
HTML pages and java applets (and any necessary images or other files)
requested by the Web-Browser across the configured communication interface to
the PC or Web-Panel. A Web-Panel is a touch screen panel with browser
functionality for the industrial automation market.
HTML pages, Teq-View files, java applet, images or any other files are stored in
the user program memory of the PCD. They belong to the user program and so
are downloaded from the PG5.

Web-Connect

The Web-Connect PC driver program manages the communication between the
PC or Web-Panel and the PCD/PCS system. Access to the Web-Server in
Saia®PCD devices is possible not only via Ethernet TCP/IP, but also via
economical, standard serial ports (RS232, RS485, modem ...) or Profibus
networks. All this takes place continuously across the different network levels.
The local directory is a directory on the PC/Web-Panel, where the Web-Connect
software is running.
It is possible to save large files (e.g. images, java applet,…) in this directory,
which we don't want to save in the PCD.Web-Server. By this upload time in the
browser and PCD memory space can be reduced.

Web-Browser

Microsoft Internet Explorer 5.5 or Netscape Navigator 6 can be used to display
Saia®PCD.Web pages. A java virtual machine 1.17 or better is required to display
the Web-Editor pages.

S-Web-Editor
The S-Web Editor allows the creation of dynamic java based web pages for the
Saia®PCD. Web-Server by simply placing graphical objects and setting their
parameters. No knowledge of HTML or Java programming is required. The
graphical objects are specially adapted to Saia PCD devices. The S-Web Editor
can be used in standalone or as add on-tool with Saia®PG5 programming tool.
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As add on-tool it is an integral part of PG5 and offers a lot of advantages like
direct use of PG5 symbols. The output of the Web-Editor is a java applet, which is
called from a main html page. For each view (browser screen) an individual
configuration file (*.teq) for the java applet is created.

Web-Builder

The Saia®Web-Builder is a PG5 add on-tool for the management of Saia®PCD.
Web-Server projects.
All files (HTML pages, Teq-View files, java applet, images, etc.), which need to be
stored in the PCD.Web-Server must be converted with the web-builder into a PG5
compatible source file format. During the PG5 build process the PCD.Web-Server
content and specific PCD-Web-Server settings are compiled in the same time as
the whole PG5 project. The Web-Server content is downloaded with the PG5
downloader to the PCD device.
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File Structure & Formats

 
This section explains the project structure and the files which are necessary to
produce a Saia®PCD.Web-Server application with the Web-Editor.

The PCD.Web-Server project is individual for each CPU and is stored in the PG5
Project directory (e.g. C:\PG5 Projects\Project name\CPU Name\..) of the
corresponding CPU. The Web-Editor uses two different directories in the CPU
Project directory:
…\web is the working directory of the Web-Editor. It contains all files created with
the Web-Editor. When starting the Editor from PG5 it uses these files for editing
the project. Note that the PG5 symbol names in the *.teq files are uncompiled
long symbol names. The teq-files from this directory can therefore not be used for
the PCD.Web-Server content.

…\html is the PCD. Web-Server directory, which contains all files that can be
selected and generated with the Web-Builder for the PCD. Web-Server content.
The PG5 symbol names in the teq-files are precompiled short symbol names.
The files (*.html, *.itq, *.tcr, *.teq, *.gif, IMaster.jar) are generated or copied
automatically by the Web-Editor. Note that they are only generated and saved
when saving the project with the "Build All" command. The html file is generated
using the html button or the 'Generate html...' command. Any other files (e.g. text
files), which should also be part of the PCD. Web-Server content can/must be
copied manually in this directory.
To display a PCD.Web-Server project (created with the Web-Editor) the browser
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accesses a HTML file that contains a reference to use the Java-Applet.
Furthermore, it contains reference tags to the *.teq files, which represent the
views that are designed by the user with the Web-Editor. The HTML file is
generated by the Web-Editor (Menu command "Generate HTML")

All Java class files are stored in a so-called Java-archive with the name 'IMaster.
jar'.

To enable a PCD.Web-Server application the following files must be generated
with the Web-Builder into the PCD.Web-Server content:

All teq files that are created by the Web-Editor
All HTML files that are generated by the Web-Editor
Variables initialisation files *.tcr and *.itq

The following files can either be generated with the Web-Builder or they can be
copied to the local directory of the Web-Connect PC.

Additional user-written HTML files (optional)

Image files (*.gif) that are used by the applet or by user-written HTML sources.

The java class library IMaster.jar, which is distributed together with the Web-
Editor

The Web-Editor supports also the creation of macro painter objects (*.esm files)
which can be stored in a macro library directory ('MacroLib'). For the library
directory any name can be given. When creating a Web project, macros can be
stored and read into/from the macro library. A macro is based on standard painter
objects that are grouped using the group function of the Web-Editor and then
saved as macro in the macro library.
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2 Installation

For Windows 32 Bit Operating Systems

The S-Web Editor software is written for use on Microsoft 32 Bit Operating
Systems. The installation script will automatically install all components needed
for operation. The S-Web Editor can be found on the Saia®PG5 Controls Suite
CD Rom and is installed directly from the CD navigation page (start.htm).

The installation script can also be started manually from the CD Rom by starting
the setup program from the Web-Editor directory: ...\Web-Editor\Setup.
exe

The S-Web Editor will be installed as add on-tool for PG5.
Please note that a user-key that contains the Web-Editor license is required.

System Requirements

The S-Web Editor runs on Windows 95/98/ME/NT/2000. For good performance,
we recommend using it on Pentium processors with at least 300MHz clock
frequency and at least 64MB of RAM. The Editor requires about 10MB of hard
disk space. Resolution of at least 1024x768 or better is recommended.
A PG5 version 1.3 or higher is required.

Avoid Problems By Disabling Caching In the Sun Java Virtual
Machine

The IMaster Java Applet sends HTTP GET and POST Requests to communicate
with the PLC's web server. The responses to these requests are generated
dynamically.
To avoid that the Sun Java Virtual caches these dynamically generated
responses, you have to deactivate the caching in your system's control panel:

1.Start->Settings->Control Panel

2.Click on the Java icon
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3.Choose the 'General' tab

4.Click on 'Settings'

5.Click on 'Delete Files...'

6.Deactivate the checkbox 'Keep temporary files on my computer'
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7.Confirm with 'OK'
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3 IE Settings (Only For Windows Vista)

This chapter is only relevant if you work with Internet Explorer on Windows Vista.

Internet Explorer 7 on Windows Vista has a new security function called
'Protected Mode'. This protected mode runs the Java Applet with other security
permissions. The applet can only write to special temporary directories. Write
operations to other directories will also work but they will be redirected by the
operating system to other temporary directories. This can cause problems if you
save a file within an alarming HMI and you try to open the saved file with a macro
that you start from your local PC. You will not see the file in the second applet! To
solve this problem you can add the the URLs to your applets to the 'Trusted sites'.

The following screenshot shows a Java Applet that runs in the 'Protected Mode'

How To Configure The Internet Explorer Browser In Order To Run
The Java Applet Outside the 'Proteced Mode'?

1. Open the Internet options dialog in menu: Extras->Internetoptionen
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2. Choose 'Vertrauenswürdige Sites' in the tab 'Sicherheit' and click 'Sites
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3. Deactivate the checkbox shown in the following screenshot that allows you to
add sites that begin with 'http' (by default trusted sites have to begin with
'https). Then type in the URL and click 'Hinzufügen'.
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Afterwards Internet Explorer deactivates the protected mode for the site you
added in the step before.
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4 Getting Started

Supported Platforms*

- Java Applet
- MicroBrowser
- NanoBrowser

* Refers to all functions described in this chapter

Open a new file

A new PG5 project is first created as explained in the User Manual PG5 26/732.
Create a new program file, which is the same procedure as creating a new IL,
FUPLA, Graftec file etc., except that you choose the file type as Web Editor (.prj),
as shown below:

A new Web Editor Project is created by pressing OK:
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This is the main window of the S-Web Editor application. It controls all the other
windows and is used to do basic settings.
All files belonging to this project will be added to the PG5 project under a sub
directory called 'Web'.

Creating A New View

The next step will be to add new views to the project. This can be done using the
Pr oj ect - >Add- >New menu or with the 'New File' button from the topmost

toolbar. The editor will propose a name, which consists of the project name and
an index.

<your_projektname0>.teq

After that, you can start to enter graphical objects to your new view. You can
choose a variety of objects from the painter toolbar. The meaning of the buttons is
described in the Painter Reference.
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Adding A Static Text Or Reading A Process Variable

In the tutorial, a 'Static Text' painter object was selected. The object can be
placed in the view by pressing the left mouse button to mark the left most top
position of the text, then keeping the mouse down and dragging towards the
rightmost down position, then releasing the button. The user now might want to
change the text. This is done by double-clicking the text object. This will open the
object properties dialog box.

This dialog box contains different tabs, which allow the user to define all
properties of this object. The first tab 'General' contains options, which are
applicable to any object, e.g. position, size, colours and font. The second tab
'Repaints' lets the user define what the object will show on the screen. In the
tutorial, a string containing the text 'Welcome To The Tutorial' should be shown.
To do so, the 'Edit a Source' checkbox should be selected, the 'Type' in the
selection on the left should be set to 'STRING' and the desired text should be
entered in the name field. The user can now press the 'OK' button to close the
dialog.

Alternatively, the type of a 'Static text' painter can be set to HTML_TAG,
CONTAINER or PPO. If type is set to PPO, the 'Static text' painter can be used to
display a process point of your PLC. If you want to read and edit a process point,
then you have to use the 'Editbox' painter that is described in the next chapter
'Editing a Process Variable'.
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Editing A Process Variable (PPO)

In the next step, an 'Edit Box' element will be added. This object allows reading
and modifying a PCD variable (R,F,C…) inside the view. To do so, the user
should press the 'Edit Box' button in the toolbox and placing the object in the
same way as the 'Static Text' object. Then, a double click on the object will open
a dialog box, where the 'Repaints' tab should be selected.

The 'Edit a Source' checkbox must be selected and the 'Type' choice should be
set to 'PPO', where 'PPO' stands for 'Process Point', indicating that a variable
from the PCD System should be used. In the 'Name' edit field you should now
enter a symbolic name. A valid name could look like 'TempVessel_1'. A global
symbol or a system symbol may be used by pressing the 'Select' button, which
opens a dialog with all the global and system symbols programmed in the PG5.
Choose the symbol that you want to use and press OK or double click on the
symbol, which will then place this symbol in the Name field.
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The 'OK' button of the properties dialog will then save these settings to the view.
All the process points defined in the project can then be configured with the limits
(min and max values), format and unit value (example °C) by opening the process
point dialog using the menu Project ->Init PPOs... These process points are only
linked with the relative addresses, which are the symbols defined in PG5, when a
build is made of the whole project in PG5

Creating A Second View

A second view should now be added the same way. This can be done by the
menu as presented above, or alternatively, simply by pressing the 'New File'
button from the toolbox. The suggested name will be 'Tutorial2.teq' and the file
will be added automatically to the project. The user can also add a text object
indicating the text 'This is the second view…' to the file.

Navigating Between Two Views

The next step will be to add buttons, which allows the user to navigate between
the two pages. To do so, the 'Button' object in the toolbar must be selected and
the object should be placed in the view 'Tutorial1.teq'. A double-click will open the
dialog box again, where the 'Repaints' tab should be selected. On this tab, the
user can enter the text that should be displayed on the button. This is done in the
same way as shown with the 'Static Text' object.
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Next, the user should go to the 'Actions Jumb' tab, where the 'View Jump'
checkbox must be selected. Inside the 'view name' edit field, the user can now
enter the name of the view where the button should jump to, e.g. 'Tutorial2.teq'.

Define the button label:

Define the view jump:

A similar button can now be added to the second view 'Tutorial2.teq', where the
name in the action tab should refer to 'Tutorial1.teq'.

Creating An Application

In the next step, the 'HTML' file, which contains the tutorial applet, will be
generated. This can be done with the menu Project->Generate HTML.. or with the
respective button from the toolbox. The S-Web Editor will suggest the filename
Tutorial.html and add the file to the project. Then, all files should be saved using
the menu File->Save All or by pressing the respective button from the toolbox.

First Test Inside The Browser

The project can now be generated with the PG5 and downloaded to the PLC or
quickly checked directly with a PC-Browser like MS Internet Explorer. Just open
the file
<your projectname>.html from within your browser. Of course process
points (PPOs) will not be linked yet this way.

Before you download your project to the PLC you have to make a 'Build All'.
Choose menu Project->Build All or click on the following icon from the
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toolbar:

('Build All' icon)
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5 Using Fore- And Background (TEQs)

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

Three Layer Concept

Fore- and background files are an advanced feature and not necessary for simple
projects. The idea of using a fore-/background file is based on a three-layer
approach to define a user view. The user can edit each layer separately. The
runtime will merge the three layers to one view. The user can assign a foreground
and a background to each view separately, but their use is an option.

The background view may typically contain controls that are used in an identical
way on many other views. Integrating them in a background will increase the
productivity especially in case of changes. Typical controls to be used in a
background can be function keys, buttons or message lines.

The foreground view is typically used to display splash messages which may
occur during an exception on the PLC. If the user wants to make sure that an
alert will be displayed in all conditions, no matter which view is actually used by
the operator, the same foreground.teq should be added to all views of the project.

The controls used in this layer should therefore be linked with a condition, so in
regular operation, no controls will be visible from the foreground teq.

Foreground TEQ

Basically every view can be used as a foreground Teq for one or more other
views. Foreground teqs will overlap the actually loaded view during the runtime.
With foreground teqs it is not necessary to copy parts of your HMI if they occur in
more than one view. For example important warnings or state indicators. For
layout elements you better use background teqs.

Creating A foreground Alarm TEQ

The first step will be to add new views to the project. This can be done using the
Project->Add->New menu or with the 'New File' button from the topmost toolbar.

Add and configure an alarm

Please insert the following Painter in your View:

Define the message

Open the property window with a double-click on the added painter.
Replace the String 'STATIC TEXT' with your message:
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Example:

Configure the alarm condition

The warning appears if myVar2 is smaller than 25.
Define this condition in the tab 'Repaints':

Define The View As A Foreground TEQ

You can set a view as the default foreground teq for the project, or just for
particular views.

Set a default foreground-teq for your project.

Choose the menu Pr oj ect - >Pr oj ect  Conf i gur at i ons. .  . In the dialog

tab 'Project - Teq Configuration' you will find the dropdown 'foreground teq'. Select
the filename of your 'alarm.teq' and confirm with 'OK'.

This setting will affect all views that you create from now on, not the existing ones.
Use the method 'Set a foreground teq for the actual view' if you want to set a
foreground teq for an existing view.
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Set a foreground teq for the actual view

Open first the teq view which should have a foreground-teq. In the dialog 
Pr oj ect - >Teq v i ew configurations you can set a foreground teq for the

actually opened view.

Background TEQ

Using background teqs can avoid to copy parts of your HMI if the same elements
occur in more than one view, e.g. layout elements or navigation buttons.
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Just like when using foreground teqs, you can also set a view as the default
background teq for a project, or just for particular views. See 'Set a default
foreground-teq for your project'
'Set a foreground teq for the actual view' for details.

Warning: AWT Components appear always in front during runtime so you can't
put other components over these.
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6 Processpoints (PPOs) Initialising

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

Init PPO Dialog

Once the Web Editor project has been completed and all the graphical views
have been created, the user must open the 'PPOs Init' dialog using the menu
Project-> Init PPOs... to be able to complete the configuration of all the symbols
used in the project.

The dialog displays a list of all used symbolical names together with their
configuration. Double click a field of the list and its configuration can be modified.
By leaving the dialog with 'OK' a file called '<your_projectname>.tcr' will be
generated. This file is automatically saved to the PG5 project in the sub directory
'Web'. When a 'Build All' is done with the Web Editor, then this file is copied to the
html sub directory of the PG5 project. The Web Builder needs the html sub
directory in the PG5 project to be able to display all the resources in this sub
directory that could be chosen by the user to download to the PLC. It is important
that '<your_projectname>.tcr' file is chosen with the Web Builder to download it to
the PLC. The meanings of the different fields are as follows:

PPO min Val & PPO max Val

Only used for 'Editbox' painter objects to offer a range check for edited values.
Only values within the range PPO min. Val to PPO max. Val. is accepted by the
'Editbox'.
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PPO format Val
For PCD-text make sure having used the 'string' format in the 'init PPO'
dialog

Defines the display format of a PPO according to the PG5 format definition. An
example of how it is displayed in the browser for each format is shown:

    STRING-i                                This is also a text

It is very important to define the right format for every PPO! For example a PCD-
text must be defined as 'String' in the 'Init PPO' dialog. Otherwise the
corresponding painter will display the message 'syntax error'.
Please read the chapter 'Error Messages'

PPO Unit Val
String that is displayed together with the PPO and that can be used to indicate the
unit of the PPO.

Examples
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7 Special HTML Tag Names

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

Special HTML Tags

The S-Web browser (IMaster Java Applet or MicroBrowser) uses some special
HTML Tags. The name of these HTML Tags are reserved.
If you see one of them in the 'Cross Ref' window of a macro, don't modify them
and never reuse the same name. 

HTML Tag
Example

Description Supporte
d by
Java
Applet
Client*

Supported
by
MicroBro
wser*

Supporte
d by
NanoBro
wser

<PARAM
NAME="Encodin
gPPO"
VALUE="UTF-
8">

Enable the UTF-8 encoding
for the reading and writing of
PPO variables. X X -

* X = supported, - = not supported

** not supported on all platforms

Avoid That The S-Web Editor Overrides Your Custom HTML Tags

The S-Web editor emits some runtime parameters directly into the HTML.
Therefore the HTML file will be overriden everytime on re-build.
In order to keep your custom HTML Tag persistent in the HTML file, it is allowed
to insert custom HTML Tags in certain sections of the HTML file.

There are two sections that should be changed manually, since the editor will
override them:
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Change or add custom HTML Tags here...
<!-- START TAG1 ALL TEXT UNTIL END OF THAT TAG IS OVERWRITTEN
FROM EDITOR DURING HTML FILE GENERATION -->
Everthing that is inside this section should not be changed manually.
<!-- END TAG1 -->
Change or add custom HTML Tags here...
<!-- START TAG2 ALL TEXT UNTIL END OF THAT TAG IS OVERWRITTEN
FROM EDITOR DURING HTML FILE GENERATION -->
Everthing that is inside this section should not be changed manually. 
<!-- END TAG2 -->
Change or add custom HTML Tags here... 



33

Saia-Burgess Controls Ltd. Filetransfer To PCD

 

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

8 Filetransfer To PCD

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

'Build all'

After having initialised all process points (PPOs) you should choose the command
'Build All' from 'File' menu to save the entire project. The 'Build All' command
copies all required files from the PG5 project sub directory 'Web' to the PG5
project sub directory 'html'.

Then, double-click on your *.wsp file inside your PG5 Project Manager (Web-
server Project file, created in PG5 by Menu Fi l e- >New. . - >Web- ser ver

Pr oj ect )  and you will see the following dialog:

On the left side of the dialog you have all resources of your PG5 \html sub
directory. On the right side all resources which will be downloaded to the PLC are
listed. With the Button 'Add->' you can choose the files needed to be downloaded
to the PLC. It is important that the files <your_projectname>.itq,
<your_projectname>.tcr, '<your_projectname>.teq' and '<your_projectname>.
html' have to be added and downloaded to the PLC.

Finally, you press the button 'Generate' and close the dialog. Now, in your PG5
environment you can build your PG5 project and download it to your target PLC.

File Transfer To PCD System From S-Web-Editor FTP-Client

This editor features an integrated FTP client which can download all required
HMI-project files to the PLC. The download dialogue can be opened either by
clicking the download button from the toolbox:
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or by selecting the menu Project -> Download Project. This will open the following
dialogue:

By pressing the button 'Download Project' all necessary files of the HMI project
will be downloaded to the webserver's root directory.

Using Sub-Directories

It is also possible to store the HMI-project into sub-directories on the PLC. The
desired sub-directory name should be entered into the edit-field
(<mySubDirectory>). The button 'Make/Change Dir' will change the current
directory on the PLC. The current subdirectory will then be shown in the upper
edit-field called 'Remote Directory'. If the entered directory does not exist, it will be
created automatically. The button 'Up Dir' will change the current working
directory to the directory above.
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A following 'Download Project'-action will store all project files to the subdirectory
path indicated in the 'Remote Directory' field.

The FTP client will usually point to the PLC web server's root directory. Please be
careful when using 'Up Dir', because it is possible to download files outside of the
web server's root directory.

Some FTP servers do not understand the FTP 'Up Dir' command. Therefore It is
also possible, to move one directory upwards by typing '../' into the field beside
'Make/Change Dir'. The next step would be to click 'Make/Change Dir'.
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9 Updating Values From The Target

Each view contains a number of references to 'process points' (PPOs) of the PCD
System. In order to achieve a good performance in updating these values, the
painters do not ask the webserver to update each value separately. When the
applet is initializing, it collects all 'process points' that are referenced, makes a list
and sends this list to the server. This request informs the server, the values of
which have to be maintained for the current view. When this view needs to update
itself, it asks for the updated request list, which will be returned by the server. This
list contains all values that are actually needed. The user can choose between
two modes of requests:

Single Request Comprising All Views

Supported Platforms

- Java Applet

Only one request list is generated for the applet; it covers all views that are
included. The advantages are:

Less files and therefore less overhead on the embedded file system.
Instant initialization, because all process points are already known to the server.

One Request For Each View

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

This option will make the applet generating a request for each view. The
advantages are:

If the applet contains many views using many variables the complete result set
has to be loaded from the target, also containing values that are not used by the
actual view. Posting a request for each view is therefore faster for complex HMIs.

This option is set in the HTML file containing the applet. The tag is called
'OrderPerView' and can be set in the 'Project Configuration' dialog box from the
menu 'Project'.

Update Period

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser
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The period in which the applet will be notified of changes of its process points can
be set by the user. The default operating mode of an applet is polling.

The period is set in the Pr oj ect - >Pr oj ect  Conf i gur at i ons. . .  Dialog.

Actions On Condition

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

For certain properties of the painters you can indicate a condition, which has to be
true to make the property active. Examples are the 'Edit a Source' property in the
'Repaints' tab of the property dialog or the 'Border Advanced' tab, where you can
set the color of a painter depending of a condition. The format of these conditions
is always the same and is explained here.

First you choose the type of the variable of which the condition shall depend.
Choose 'PPO' for real process points or 'CONTAINER' for HMI-internal variables.
Then indicate the name of the variable in the field 'Name'. Now you can set the
value in the field 'Value' to which the variable shall be compared to and the type of
comparison that can be:

!= not equal

< smaller than

<= smaller or equal than

== equal
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>= greater or equal than

> equal than
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10 Working With Error Codes

Supported Platforms

- Java Applet
- MicroBrowser

By using this 'error code' functionality, the user can define his own system
messages that are displayed as a function of a PPO error code number (e.g.
integer indicating an error code).

In simple cases, an error message can be issued as a string from the PLC. The
drawbacks of these methods are the following:

If the error strings shall be multilingual and the language will be changed on the
panel, this will be rather difficult to solve.

String management on the PLC uses a lot of memory an is rather complicated

The concept to be explained in this chapter allows the PLC to issue an error-code
(as an Integer). This error code will be used to determine the respective text from
the language resource that is currently selected.

A CSV language resource file is used to manage error codes and messages.

How To Make Use Of Error Codes

Set the source type of the painter that displays the error message to 'HTML Tag'.

To designate the respective error-string, the following syntax must be used:

ErrorCode_@PPO_MyPPOName@

ErrorCode_ Prefix for your error codes. This is free text.

MyPPOName PPO which contains the actual error code

The HTML-Tag: 'ErrorCode_@PPO_MyPPOName@' will be replaced at runtime
by HTML tags like 'ErrorCode_0', 'ErrorCode_1',.. 'ErrorCode_N.
If the PPO returns the value '1' the message that corresponds to 'ErrorCode_1'
will be shown.

Create a CSV file which includes the messages and the error codes:
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Import the CSV file with the Project->Add To Project->File... menu into your
project.
Choose Project-> Project configurations... activate the checkbox 'HTML
Parameters in CSV file' and insert the filename of your error code CSV file into
the dropdown 'csv file'.

If you work with language files you can insert the error codes and messages into
every language file. Refer to the chapter 'Multilingual HMI's' for details.
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11 Multilingual HMIs

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

In this chapter you will learn how to create multilingual HMIs. The user will be able
to switch the language by pressing a button in your HMI.

The concept is based on language resource files. For each language to be used,
a separate file must be added to the project. These files are in a CSV (comma
separated values) format and can be edited with any standard ASCII text editor
(read the section below 'Working With Unicode' if you want to use Unicode).

As source type for all language dependant texts you have to use the 'HTML TAG'
info-type, instead of e.g. 'STRING'.

The S-Web Editor is able to collect all 'HTML TAG' references and to generate a
CSV file including all 'HTML TAG' references. You can modify this automatically
generated CSV file and translate the 'HTML TAG' references into any language.

For example you can insert a button into your TEQ-view that changes the current
language of your HMI during runtime with a simple button-action.

Define What Should Be Translated

Open the property window of the painter that should be translated and set the
DropDown list 'Type' to 'HTML-Tag'. Repeat this step for all painters that you want
to translate:

The string 'Bitte Passwort eingeben:' is now the 'HTML TAG' reference. This
string will be shown if no CSV-file is loaded during runtime. You can also enter a
name like 'PWTEXT1' and later you can create a CSV file which translates this
into 'Bitte Passwort eingeben:' and another one which translates it into 'Please
enter your password:'

Create One CSV File For Each language

Before the editor will create a CSV including the 'HTML TAG' references, you
have to define the filenames of your CSV files. Use the menu Pr oj ect -

>Pr oj ect  conf i gur at i ons. . .  and type in the filenames into 'csv files

(update)'.



42

Saia-Burgess Controls Ltd. Multilingual HMIs

 

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

 
Close the 'Project Configurations' dialogue and choose 'Generate HTML TAGS
CSV file' from the main toolbar:

The editor will create the CSV files defined in the list 'csv files (update)'. After the
CSV file is created once, the 'Generate HTML TAGS CSV file' functionality
updates your existing CSV files.
If you define a new 'HTML TAG' reference, the editor will automatically add it (on
the first line) to your existing CSV files, if you use 'Generate HTML TAGS CSV
file'. The editor keeps all your translations that you have already made. If you
remove 'HTML TAG' references from your HMI, the editor will show a dialogue.
You have the choice between keep or remove old 'HTML TAG' references.

Open the CSV file you have created with the 'Generate HTML TAGS CSV file'
function in a text editor like Notepad. Insert the translation for each string and
save the file.

Syntax: HTML TAG r ef er ence;  t r ansl at i on

Repeat this step for each of your language CSV files.
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Define The Default Language CSV File

Use the menu Pr oj ect - >Pr oj ect  conf i gur at i ons. . .  and go to the tab

'Project - Applet Advanced'.
Activate the option 'HTML Parameters in csv file', otherwise the runtime browser
or Java-applet searches the 'HTML TAG' references in the HTML file during
runtime.

Insert the filename of your CSV language file, that you want to load at startup of
HMI :

Create The Language Switch Button

The next step is to create a button for switching the HMI language at runtime:
Add a button painter into your main view

Open the painter's property window (double click on it).

Replace the text 'BUTTON' in the tab 'Repaints' with your own label:
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Go to the tab 'Actions Set Variables' and activate checkbox 'Set a Variable' and
take the settings from following the screenshot:

 
If you only have one CSV file you can't switch back to the 'original language'.
Therefore you have to create an additional CSV file:

Add a button painter into your view for the 'original language':

Open the painters property window (double click on it).

Go to the tap 'Repaints' and replace the text 'BUTTON' in the tab 'Repaints' with
your own label. Now go to the tab 'Actions Set Variables' and take the settings
from the following screenshot:
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In the case described in this tutorial the language is german at startup. But the
user can switch the language to english by clicking the button 'English HMI
Version'.

Working With Unicode

The runtime Java-applet and MicroBrowser can display Unicode text.

Some fonts can not display all of the Unicode characters. It is recommended to
use the font 'MS Sans Serif' which is a good choice for Unicode characters.

Don't edit your CSV file directly in the S-Web Editor, because the text window of
the S-Web Editor saves the CSV file in ASCII mode. You can use Notepad for
example to edit your CSV files (or any other text editor which allows you to save
files in Unicode format). In the 'Save As' dialogue in Notepad you can choose
'Unicode' in the DropDown 'Encoding'. Use the format 'Unicode Text' in MS Excel.

If you saved your CSV file in Unicode format and you have chosen a font in your
HMI which is able to display Unicode characters, the Unicode strings should be
displayed correctly. You needn't make additional settings in the S-Web Editor, if
you want to use Unicode.
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12 Working With Macros

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

Macro objects can be used to manage often used painter combinations and their
configuration in a separate file (*.esm).

Since version 5.12 the editor creates macro files with *.esm file extension. The
editor is backward compatible with *.tlb files which is the old macro format.

Individual Solutions

Contact us if you need an individual painter. IniNet Solutions GmbH creates
customized Painters. These are delivered as macro objects and can be imported in
your project with the menu Li br ar y- >Get  obj ect  f r om l i br ar y. . . .

Build Your Own Macro

1. Create a new project named "myMacro" for example. (How to create a new
project is described in the chapter Getting Started)

2. Create a new Teq view with the Project->Add to Project->New menu.

3. Insert and configure all painters that should be included in the macro object

4. Select all Painters and click the group symbol in the bottom toolbar (see
chapter Group Functions for details)

5. Select the created painter group macro and create the macro file with the menu
Library->Insert object into library....

6. Choose a name for your macro (*.esm) and click "New_Save".
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'Extra files' are additional files such as GIFs or TXT files. Click 'Add Files..' to
define them. If your macro don't needs any file resources you can leave 'Extra
files' blank.

Inserting A Macro Object From The Library

With the menu function Library->Get object from library... you can insert a library
object into the active teq-view. After having inserted such an object you normally
should alter its references. This is done by double-clicking on it which will pop up
the group dialog. Select the Cross-reference tab and change the references
according to your needs.

You can ungroup the macro object to modify their position. Do this with the
ungroup symbol in the bottom toolbar:

Removing A Macro Object From The Library

With the menu function Library->Remove object from library.. you can remove
and delete a library object. A file selection dialog will appear where you can select
the object(s) to be removed.

Modify An Existing Macro

The user might want to make modifications to an existing macro and then store
the modified macro under his own name. The problem about this is the fact that a
macro can consist of several files (images, PPO and container intitialisation,
macro dialog, etc.). Mainly when the user wants to modify a macro with an own
macro dialog (e.g. Tacho), this dialog must also be stored together with the
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modified macro. Therefor, a macro cannot simply be copied and renamed, but
must be modified following the procedure as described:

Li br ar y- >Modi f y macr o f r om l i br ar y. .

Choose the macro you want to modify and apply the changes with the editor.
Please note that deleting core objects of certain macros might result in an
inproper operation. Changing size, layout, color and font properties or adding
additional objects is always possible without causing problems.

Li br ar y- >I nser t  obj ect  i nt o l i br ar y. .

Now save your modified macro under the new name. In the 'Save' dialog, you
have the possibility to add files to your macro that must be part of it (e.g. you have
added GIF images).

Important Notice: Please do not close the temporary created TEQ-View. 
Use Library->Insert object into library..! 
If you did by accident, just close and open the editor

again.



49

Saia-Burgess Controls Ltd. Multiple Views

 

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

13 Multiple Views

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

This section explains the user how to set up an HMI consisting of multiple views.
As we are developing for a networked environment, there are certain points that
must be considered for the design of such a solution in order to obtain the best
results in terms of performance and memory footprint.

In general, there are two different ways of how to change from one view to
another:

Multiple Views In One Applet

The user requests one HTML page with the browser. This page (<your

pr oj ect name>. ht ml ) contains one applet ( I Mast er . j ar ), which references

multiple views (stored as *.teq files). This is the fastest way to switch from one
view to another. All views and the corresponding applet code are loaded and
started when loading the HTML file <your projectname>.html into the browser. 

This file is created from the project menu: ' Pr oj ect - >Gener at e HTML' .

Link To Another HTML File

It is also possible to link an applet view to another HTML view, which may contain
an applet, too. The disadvantage is, of course, that the browser needs a certain
time to load and initialise the new page and applet. Nevertheless, this feature can
be useful in certain cases like:

links to help files (stored as HTML)
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links to HMI's from other webservers, to create 'virtually' one single HMI

links to other applets or pages that are not created with S-Web Editor
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14 Java Security Settings (For Microsoft VM)

This chapter is only relevant if you work with Microsoft VM.

Some times you need to do some operations that the Java security model doesn't
allow on your browser. For example if you need to send a file on the server (field
download or file upload). So, to force these kinds of operations you have to run
Java applet(s) outside the Java security sandbox, and allow all permissions for
applet downloaded from a trusted site.

How to configure the Internet Explorer browser in order to run the Java
applet(s) outside the Java security sandbox?

1. Open the Internet options dialog in menu: Tools->Internet Options... (or Alt T
and O).

2. Choose tab "Security"

3. Double-click on the green "Trusted Sites" icon.

4. Deselect the checkbox "Require Server verification (https:) ...".

5. Press button "Sites..." and add the web site where the applet is located (for
example: MyPCName, or http://MyWebFrontServer), and click "OK".

6. Press the button "Custom Level…" (for trusted sites).
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7. Select on the list : Java->Java Permission->Custom

8. Now, you can press the press button "Java Custom Settings…"

9. Choose tab "Edit Permission"

10.And select on the list: Unsigned Content->Run Unsigned Content->Enable
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11.Then press the "OK" and "Apply" buttons.

12.Restart the browser and try your applet again.

A green icon should be displayed on the status bar of the Internet Explorer
browser to indicate that you are displaying contents from a trusted site.
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15 Signed Applets (For Sun VM)

This chapter is only relevant if you work with Sun VM.

The S-Web Editor works with signed applets. A dialog box like the following will
appear if you use Sun VM PlugIn:

Accept the certificate with "Yes" or "Always". If you don't accept the certificate the
applet can't save files to local harddisk.
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16 Working With MicroBrowser

This chapter describes MicroBrowser for Saia Terminals (uBTerminal).

uBTerminal containers

Container variables, available to the user, are included in the firmware of these
terminals.

Containers let the application program exchange information with the firmware. All
container variables have the prefix "uBT_".  Caution: case sensitive !!!

Container variables available for QVGA MB panels

Container variable Description

uBT_Version Read current firmware version

uBT_IsConfigChang
ed

Read 0 - Configuration unchanged
Read 1 - Configuration is changed

uBT_RestoreConfig Write 1 - Last saved configuration is restored

uBT_SaveConfig Write 1 - Current configuration is saved. When IPAddr,
SubNetMask
or Default Gateway is changed, restart the terminal.

uBT_EnableCache Read/Write 0 - Cache is disabled. Each file is loaded
every time.

Read/Write 1 - Cache is enabled. A loaded file will, if
present, be taken from the cache. When switched off,
cache files are deleted. When switched on, cache files
are updated.

uBT_DispType Read display type: Mono or Color

uBT_DispResolution Display resolution:

x - x axis [pixels] example: 320
y - y axis [pixels] example: 240
z - colour depth per pixel (bits per pixel) example: 8

uBT_IsTSPresent TouchScreen present
Read 0 -  No
Read 1 - Yes

uBT_DoLcdCalib If TouchScreen present
Read/write 1 - a recalibration is executed.

uBT_LcdContrast Read/write: contrast value between  0 and 20

uBT_BackLight Read/write 0 - Backlight OFF
Read/write 1 -  Backlight ON

uBT_BackLightTime
out

Read/write timeout in minutes. If no user action is
registered during this time, the backlight is switched off.
If the value is 0 - the backlight is always active (switched
on).
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uBT_TCPIPAddr Read/write TCP/IP address of terminal. Modification
forces a restart.

uBT_SubNetMask Read/write subnet mask of terminal. Modification forces
a restart.

uBT_DefaultGatewa
y

Read/write default gateway of terminal. Modification
forces a restart.

uBT_BuzzVol Read/write buzzer volume (0 - 20)

uBT_BuzzFreqIndex Read/write buzzer frequency (0 - 6)

uBT_EnableSIP Read/write SIP - Soft Input Panel
Write 0 - SIP is disabled. Virtual keyboards are
disabled.
Write 1 - SIP is enabled. Virtual keyboards (alphapad.
teq and keypad.teq) are enabled.

Container variables available for VGA MB panels

auto-
upda
te
Conf
ig
file

Container Type Default Min
Value
Min
Lengt
h

Max
Value
Max
Lengt
h

Description

yes uBT_Alarm
Frequency

ANSI Text
String

1000 125 8000 Frequency setting of
the acoustic alarm
(Hz)

(Rounded to
125,250,500,1000,20
00,4000,8000)

no uBT_Alarm
Start

Decimal
value string

0 0 30000
: 50
Sec

Start of acoustic
alarm, interval time
(mSec),

finished by any touch
on the screen.

yes uBT_Alarm
Volume

Decimal
value string

10 0 20:
100%

Acoustic alarm
volume setting

yes uBT_AutoR
epeat

Boolean
value string

0   SIP Key board:
Autorepeat on(1), off
(0)

yes uBT_Backli
ght

Boolean
value string

ON   Backlight on(1), off
(0)

At any touch of the
screen the back light
switches on again.

At back light on the
count down for the
back light timeout
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restarts.

yes uBT_BackL
ight
Timeout

Decimal
value string

15 0 5000 Time (min) after
which the backlight
switches off.

At any touch of the
screen the back light
switches on and the
count down restarts.

yes uBT_Boote
rVersion

ANSI text
string

Current
version
string

0 8 Firmware booter
version
Read only string

yes uBT_BuzzF
req

ANSI text
string

500 125 8000 Frequency setting of
the acoustic beep at
touch

(125,250,500,1000,2
000,4000,8000)

yes uBT_Buzz
OnOff

Boolean
value string

TRUE   Acoustic beep at
touch on (1)/off (0)

yes uBT_BuzzV
ol

Decimal
enumerate
d value
string

0 : OFF 0 20 :
100%

Acoustic beep at
touch, volume setting

yes uBT_Config
Type

ANSI text
string

Current
Config
Type

0 24 Configuration Type
Read only string

yes uBT_Config
Version

ANSI text
string

Current
Config
Version

0 4 Configuration Version
Read only string

yes uBT_Defaul
tGateway

IP address
string

0x000000
00

  Gateway address for
remote (peer)
access, 0 not
configured

no uBT_DispR
esolution

ANSI text
string

<Screenw
idth>

<Screenh
eight>

<Colorde
pth>

0 16 Resolution
information
Read only string

no uBT_DispT
ype

ANSI text
string

Color 0 10 Display type
information
Read only string

yes uBT_Enabl
eCache

Boolean
value string

TRUE   Filecache use (1), 0
no filecache

yes uBT_Enabl
eSIP

Boolean
value string

TRUE   External SIP
Keyboard use (1), 0
no keyboard use
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auto-
upda
te
Conf
ig
file

Container Type Default Min
Value
Min
Length

Max
Value
Max
Length

Description

yes uBT_FirstPadN
ame

Decimal
enumerat
ed value
string

0  alphapa
d.teq

First used
entry pad file
index

no uBT_FlashStatu
s

Decimal
value
string

0 0 255 M1 Flash

status

20: Device
present,no file
system

21: Device
present,file
system OK

22: Device
present, error
at file system
creation

23: Device
present, busy
creating file
system

24: Device
present, busy
with flash
sector based
compression

-1: Unknown
error

yes uBT_FocusBord
er
Width

Decimal
value
string

2 0 7 Active object
focus frame
line width
(pixel): 1-5

yes uBT_InactivityP
oll
Time

ANSI text
string

0 0 5 Touch /
Keyboard
inactivaty
supervisory
selection (1),
at 0 off.

Used for a
switch to a
less frequent
touch /
keyboard
entry polling
mode.
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no uBT_IntFlashSt
atus

Decimal
value
string

0 0 255 Internal Flash
status

20: Device
present,no file
system

21: Device
present,file
system OK

22: Device
present, error
at file system
creation

23: Device
present, busy
creating file
system

24: Device
present, busy
with flash
sector based
compression

-1: Unknown
error

yes uBT_IntroGraph
ic
Name

ANSI text
string

SaiaSUGr
ande.gif

0  Intro Graphic

yes uBT_IntroGraph
icX
Pos

Decimal
value
string

100 0 639 Intro Graphic
position

yes uBT_IntroGraph
icY
Pos

Decimal
value
string

50 0 479 Intro Graphic
position

yes uBT_IntroText ANSI text
string

Welcome 0 32 Intro text

yes uBT_IntroTextX
Pos

Decimal
value
string

400 0 639 Intro text
position

yes uBT_IntroTextY
Pos

Decimal
value
string

300 0 479 Intro text
position

yes uBT_TCPIPAdd
r

IP
address
string

0xAC1703
DF:
192.168.1
2.90

  Own IP
Address

no uBT_IsTSPrese
nt

Decimal
value
string

current
value

0 255 Touch screen
detected (1), if
0 calibration
at start-up has
/ will be
skipped.

no uBT_LastKeyEv
ent

ANSI text
string

 0 32 Last key
event code
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no uBT_LastKeyEv
ent
Up

ANSI text
string

 0 32 Last key up
event code

yes uBT_LcdContra
st

Decimal
value
string

10 0 20:
100%

Contrast /
Backlight
brightness
setting (0:20)

auto-
upda
te
Confi
g
file

Container Type Default Min
Valu
e
Min
Leng
th

Max
Valu
e
Max
Leng
th

Description

yes uBT_LocalFile
Search

Decimal
enumerate
d value
string

0:OFF 0 2 Select local
filesearch mode

0: no local file use

1: use local files
before remote

2: use remote files
before local

The local search
order is fixed, in
order of use:

- Video cache
(image only)

- File cache (if
enabled)

- Internal Flash

- M1_Flash

- SD Card Flash if
used

no uBT_MACAdd
r

ANSI text
string

 0 20 Own MAC address

no uBT_MultiKey
Value

ANSI text
string

 0 6 External SIP
Keyboard multi key
indication (1), 0 no
actual multi key
active

yes uBT_SbusAdd
r

Decimal
value string

10 0 253 Own Sbus address
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yes uBT_Seconds
ToIn
activity

ANSI text
string

0 0 5 Touch / Keyboard
inactivaty
supervisory time
(Sec)

Used for a switch
to a less frequent
touch / keyboard
entry polling mode.

yes uBT_SerialNu
mber

ANSI text
string

 0 12 Serial Number

no uBT_Setup ANSI text
string

 0 10  

yes uBT_SubNet
Mask

IP address
string

0xFFFF0
000

  Remote (Peer) IP
address mask

yes uBT_Version ANSI text
string

Current
version
string

0 32 Firmware version

Read only string

*   Generally IPv4 private addresses are used. Standard settings are:
     - 1 x A class, with subnet addresses 10.x.x.x, and mask 255.0.0.0  - parts may
be used also
     - 16 x B class,  with subnet addresses 172.16.x.x up to 172.31.x.x and mask
255,255,0,0 – 
       parts or combinations may be used also
     - or 256 x C class, with subnet addresses 192.168.0.x up to 192.168.255.x 
and mask 255,255,255,0 -
       combinations may be used also

Recognized Fonts of the MB-Panel PCD7.D4xx QVGA and VGA
resolution.

Default fonts available for QVGA MB panels

Font and font style Character Size

Arial 10, 12, 16

Arial Bold 14, 20

Courier New 10, 12, 16

Courier New Bold 14, 20

Tahoma 10, 12, 16

Tahoma Bold 14, 20

Default fonts available for VGA MB panels

Font and font style Character Size
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Arial 10, 12, 16, 20, 24, 36

Arial Bold 14, 20, 24, 36

Courier New 12, 16, 20

Courier New Bold 14, 20

Tahoma 12, 16, 20, 24

Tahoma Bold 14, 20, 24

If you do not pay attention at the text font and style you use in Web-Editor, you
take the risk to display undesired characters. Here below the little translation table
of some common Font and style.

Examples of Interpretation of wrong sizes or styles (QVGA).

Arial 8, 20 à Arial 8 becomes Arial 10, Arial 20 become Arial Bold 20
Arial Bold 12, 24 à Arial Bold 12 und 24 become Arial 12
Courier New 8, 20 à Courier New 8 becomes Courier New 10, Courier
New 20 becomes Courier New Bold 20
Courier New Bold 10 à becomes Courier New 10
Tahoma 8, 20 à Tahoma 8 becomes Tahoma 10, Tahoma 20 becomes
Tahoma Bold 20
Tahoma Bold 16 à becomes Tahoma 16
Arial 12 Italic à becomes Arial 12
Arial 12 Bolld & Italic  à become Arial 12
Lucida Calligraphy 12 à becomes Arial 12

Refer to the chapter 'WYSIWYG For Fonts' for more details

Programming Function keys for web panel with Fkeypads

Place a button on the view and open the function keys tab.

Use the syntax: FKEY_1, FKEY_2 … FKEY_12 , …and ESC
The number of buttons depends on how many Fkeys you want to use.

N.B.: case sensitive.

Example: With the comfort line MB panel, 12 function keys are available.
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Do not use the “Hide Painter” command to hide the button.

A button hidden in this way will, in fact, be briefly visible on-screen when the page
is changing.

We advise you to place the buttons on an enlarged part of the background layer.

Further detail:

Use the advanced features of TEQ views.

One TEQ view can be made with three different layers. Each layer can be edited
separately by the user. At runtime, the three layers will merge into one view.

What's the drill?

Create a background TEQ and enlarge it. Buttons corresponding to the Fkeys can
be placed in the enlarged area. In this way, they will be invisible on the screen
panel.

(Example with MB QVGA panels: standard size is 320 x 240, enlarged size is 320
x 280).

(Example with MB VGA panels: standard size is 640 x 480, enlarged size is 640x
560).

Further information

Documents References Comment www

User’s guide QVGA MB
panels

26/869 English

User’s guide VGA MB
panels

26/858 English (in the
packing)

Manual QVGA and VGA MB
panels

26/851 EN English www.sbc-support.
ch/
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Manual QVGA and VGA MB
panels

26/851 DE German www.sbc-support.
ch/

Manual QVGA and VGA MB
panels

26/851 FR French www.sbc-support.
ch/
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17 Working With NanoBrowser

NanoBrowser is optimised for eDisplay hardware with its limited amount of
memory. NanoBrowser implements almost all features known from embedded
MicroBrowser and is 100% compatible to the S-Web Editor. The workflow you are
familiar with has not changed. S-Web Editor checks several project parameters in
order to ensure that the HMI project fits to the eDisplay hardware and its memory
limitations (will be done during the 'Build All' process).

The Project Wizard And eDisplay Related Project Options

S-Web Editor reads information about the eDisplay hardware limitations from a
hardware profile that is built-in the project wizard.

S-Web Editor project wizard:

According to the hardware profile the project wizard will make the project settings
that fit best to the eDisplay hardware (TEQ-View Size, zoom factor, colour…etc.).
S-Web Editor automatically sets the recommended project settings for the
eDisplay hardware.

Project's 'Build Advanced' settings activated by the project wizard:
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NanoBrowser uses SpiderControl Font files in order to make the fonts that you
use in your HMI project available for the eDisplay. S-Web Editor reads your
language CSV files to figure out which Unicode character for what font type and
size is required for the HMI. S-WebEditor creates SpiderControl Font files that
contain exactly these Unicode characters and nothing else. This makes it
possible to use any Unicode character that is included in the respective TrueType
you use in your HMI (please see chapter Multilingual HMIs, Working With
Unicode).

Since version 5.14.05, the S-Web Editor is able to generate SpiderControl Font
files (have 'fnt' file extension) during the 'Build All' process. SpiderControl Font will
be downloaded and built with all other project files, so you don't need to do
anything special. If you choose the eDisplay hardware profile, the option that
causes the S-Web Editor to generate SpiderControl Font file is automatically
activated.

As you saw in the screenshot before, the S-Web Editor knows an option called
'Convert project's Gif to Bmp' in case of the eDisplay hardware. S-Web Editor
generates monochrome Bitmaps during the 'Build All' process if this option is
active. It is not recommended to deactivate this option, because eDisplay is not
able to display GIF images.

If you work with eDisplay, 'Generate/Update Scalable html files' is a useful S-Web
Editor feature. The MicroBrowser and Java-Applet runtime engine is able to scale
the HMI by a factor you define in the S-Web Editor project configurations (please
see chapter 'Editor Reference>Main Window').

NanoBrowser Macro Library

S-Web Editor comes with a MacroLibrary that was adapted for the small display
sizes and memory limitations of the eDisplay (please see chapter 'Macro Library
Index').
The macro format is the same for all platforms, if you consider the limitations of
display size and memory you are able to work with the same Macros you made
for other S-Web Editor HMI projects.
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What you must know to create a user project?

User project start name

The default html user project start name is ‘estart.html’ .

Character Editing

Character Editing does work for PPO with STRING format

Maximum of PPOs, containers, painters … per project and per view

 number

Max PPO per project 100

Max Container per project 16

Max HTML Tag per project 1000

  

Max PPO per view 30

Max Container per view 16

Max HTML Tag per view 1000

Max Painter per view 20

See also /Web Editor/ SaiaDefaultSpiderHWProfile.shp

Navigation

Cause of the system of navigation (no touch screen) , one but only one 
“EventP_SetFocus_onGainFocus” macro is necessary in each teq view. You
advice to put this macro under a Jump action to another page.

Default Fonts, Fonts and Font generator
In the project configuration, select Tahoma regular 8, 10 or 12 as default font !!!!

Default Fonts

The 3 default fonts and size are:

Tahoma regular 8 
Tahoma regular 10 
Tahoma regular 12

These fonts can be used in all case, for PPOs, Containers, Strings or html tags.

Other Fonts

Painters Format Taho
ma

Taho
ma

Taho
ma

Add*
font 1

Add*
font

Add*
font

Add*
font
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regul
ar 8

regula
r 10

regul
ar 12

2 3 4

Button + Static
text

String x x x     

 PPO x x x     

 Contain
er

x x x     

 Html
Tag

x x x x x x x

Edit-box PPO x x x     

 Contain
er

x x x     

Multi-line label String x x x     

 Html
Tag

x x x x x x x

Macros         

Table control  x x x     

Drop down PPO  x x x     

Drop down html
tag

 x x x x x x x

         

* created with the font generator (Project configuration: Generate Spider Font
Files)

Further information

Documents References Comment www

User’s guide eDisplay PCD7.
D300E

26/870 English sbc-support.ch
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18 XX7 Variable List Import

Supported Platforms

- Java Applet
- MicroBrowser

As from S-Web Editor 5.15 you can use XX7 symbols instead of just PDP
memory addresses like PDP,,MW500,d.
XX7 symbols can be imported by browsing the .s7p file symbol as displayed in the
picture below:

Additionally, it is also possible to use container offset inside XX7 symbols. This is
very useful when accessing your S7 data arrays and even arrays of structures
with the help of container variables.

The following steps describe how to set up an XX7 project and link it to the .s7p
project file. Afterwards, you will learn how container offset can be used with s7
PPO symbols.

How To Set Up The XX7 Project

1. Choose the menu command File->New Project to get the 'Project Creation'
dialogue. Define a project name and click 'Browse' to select your project
directory. Confirm with 'OK'. 
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2. Choose the menu Pr oj ect - >Pr oj ect  Conf i gur at i ons. . .

3. Change the project type from 'Saia Standard' to 'Saia XX7' as displayed in the
picture below:
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This step changes the project type and automatically replaces your
IMasterSaia5_15_00.jar with IMasterXX7_5_15_00.jar, which is the Java
Applet that is specific to XX7 projects.

4. Open the tab 'Project - Advanced'. Reopen the menu Pr oj ect - >Pr oj ect

Conf i gur at i ons. . .  if you already confirmed with 'OK' during the last step.

5. Choose 'Browse' near the text field 'Saia xx7 PPO variable list Project File' to
select your .s7p file.
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6. Choose the S7 program name and confirm with 'OK.

7. Confirm the project configuration dialogue with 'OK'.

8. Insert a new TEQ view into your project with Pr oj ect - >Add To Pr oj ect -

>New. . .  

9. Insert an edit box painter.
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10.Double click on the inserted edit box painter to open the painter properties
window and switch to the tab 'Repaints'.

11.Click select to open the S7 symbol browse dialogue:

12.Choose the desired S7 variable symbol and confirm with 'OK'.

13.Define the Main TEQ in the project configurations. Choose Pr oj ect -

>Pr oj ect  Conf i gur at i ons. . .  and switch to 'Project - Applet Advanced'.

14.Choose the function 'Build All' to prepare your project.

15.The project can be downloaded to your target now. Do this with the FTP
function inside the S-Web editor. 
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Please also see the section 'File Transfer To PCD System From S-Web-Editor
FTP-Client' in the 'Filetransfer to the PCD system' chapter.

Container Offset And XX7 Symbol Names

It is possible to work with '@CO' syntax to access structures within an array. S-
Web editor calculates the memory offset automatically. You don't have to care
about the real byte offset of your structure.

There is no need to type in the whole variable. Just use the 'PPO Selector'
dialogue, as you did in the last example.

Example of a member variable addressed by a container offset:

The syntax is the same as you might know from the Container Offset chapter.
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Important Notice: If you work with S7 symbols you cannot use the '@COFF'
syntax also known as 'Incremental Container Offset'. 
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19 Containers

Geben Sie hier den Text ein.

19.1 Initialising Containers

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser

A Container is a local variable inside the HMI. They are only visible within one or
more views. By the menu function Pr oj ect - >I ni t  Cont ai ner s. . .  the

property dialog of the containers will be opened where they can be initialised to a
desired value. Instead of the menu function you can also use the "Init container
vars" button from the topmost toolbar:

All containers are listed here.

You can set the initial value of each Container by clicking into the column "Initial
Value". By leaving the dialog with 'OK' a file called <your _pr oj ect name>. i t q

will be generated.

MB_tmz_en and MessageBoxCO are predefined Container variables which are
always present.

19.2 Container Offset

Supported Platforms

- Java Applet
- MicroBrowser
- NanoBrowser



77

Saia-Burgess Controls Ltd. Containers

Container Offset

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

With the 'Container Offset' function you can integrate arrays into an HMI. For
example you have one edit field (source type 'PPO') and an additional one for
the offset (source type 'CONTAINER'). The user can now control which array-
element should be shown by typing 1, 2, 3 or 4 into the edit field with the offset
container.
For the edit field which should show the values of your array, you have to use a
special syntax.

Example:  Incremental Container Offset 

1. Insert two 'Edit Box' Painters into a new TEQ-View.

2. Define the source type 'CONTAINER' for one of the inserted edit boxes and
enter a name. At runtime the user can control the offset of the PPO by entering
an integer into this offset 'Edit Box'.

3. Define the source type 'PPO' for the second 'Edit Box'. What you now enter in
the name field is a special syntax:

General syntax for container offset:

Syntax in the case of absolute PDP-addresses:



78

Saia-Burgess Controls Ltd. Containers

Container Offset

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

The text from the prefix '+@COFF_' until the delimiter '@' will be replaced with
the value of 'ContainerName'.
It assumes the value of the container is an integer value.

4. Chose 'Build All' and download your project with PG5.

What will now happen at runtime?

Defined PPO name: PDP,,R1000+@COFF_MyContainer@,d

'PDP,,R1000' is the base PPO address. This base address will now be
incremented by the offset given in the container 'MyContainer'. This happens
because of the keyword '+@COFF_'. The second '@' is the end delimiter.

String Replacement

Syntax For The PPO Name
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The text from the prefix '@CO_' until the delimiter '@' will be replaced with the
string in the container 'ContainerName'.

Please don't use symbolic PPO variables and string replacement with @CO.
Always use an absolute PPO address like PDP,,F2004...
Important Notice: Please do not use the offset syntax for addressing PPO
variables by PPO variables:

19.3 Session Container

Supported Platforms

- Java Applet
- MicroBrowser

Session containers are mentioned to keep an information during the whole
session, even if the user jumps to the HMI of another PLC (URL Jump). There
are 20 session containers with predefined names: "_NOINITSESSCO_0" ...
"_NOINITSESSCO_19"

Use them for example to keep user's level given by a Password Entry Page
during the whole session.

The session ends if the user closes the browser client.

19.4 Special Container Names

Supported Platforms

Please see spreadsheet below

Special container variables

The S-Web browser (IMaster Java Applet or MicroBrowser) uses some special
Container variables. The name of these Container variables are reserved.

If you see one of them in the 'Cross Ref' window of a macro, don't modify them
and never reuse the same name.

The special Container variables are listed in this chapter or they have a name
starting with '@MACRO'.

Container names beginning with the prefix '"?S_" are reserved for internal use.

Container-Name Description Supported by *
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Java
Applet
Client

Micro
Browser

Nano
Brows

er

@BLINKCO The SpiderControl browser does
automatically toggle the value of that
container (0/1) at every period. (read-
only)

X X -

@CURRENT_PA
GE

Name of the current TEQ view (read-
only)

X X X

@LAST_PAGE Name of the last TEQ view (read-
only)

X X X

@FOCUS Please see Set Focus On Gain Focus
macro

- X X

@LANGUAGE Contains the name of the language
CSV file.

X X X

@MB_FKEY_EV
ENT

Last function key (read-only) X X -

@MB_FULL_RE
DRAW

Write '0' or '1' to disable or enable the
full redraw mode

- X -

@MODAL_
FOREGROUND

Permits to disable or enable the
modal foreground TEQ (0 = disable;
1 = enable).

X X -

AUTOINCRCO This container is automatically
incremented by SpiderControl
browser at every period.
i.e.: Animated GIF macro with modulo
action to define GIF filename's index.

X X -

IMaster.
VERSION

IMaster Java Applet version number
(read-only)

X - -

IsWebBrowser Is equals to '0' for browsing with local
file, = '1' for remote access (read-
only)

X X -

MB_APP_VERSI
ON

MicroBrowser version number (read-
only)

- X -

MB_VERSION NanoBrowser version number (read-
only).
For MicroBrowser it is the version
number of the XML configuration file.

- X X

MB_Backlight ** Write 0 or 1 to turn off/on the display
or the LCD backlight

- X -

MB_BringWindo
wToTop **

Write the name of the window, or a
part of the window name, to bring it
on the top. Writing "_self" will bring
the MicroBrowser on top.

- X -

MB_Buzzer ** Write '0' or '1' to disable or enable the
buzzer.

- X -

MB_ConcecutivU
pdate
PPOCGIErrorsC
ount

The number of consecutively failed
HTTP requests for PPO updates
(Order Values Read File or ILR
Updates). Resets to 0 after one
successful request. Can be used to
detect problems with the connection

X X

Version 
1.5.15.1

13
and

-
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to the web server. newer

MB_ExeToTop ** Write the name of the program to
bring on the top into this container.

- X -

MB_FOCUS Get object id (0..n) of the current
focused object or write the the current
focus. '-10' means no selection.

- X -

MB_Gateway Client's gateway address (read-only) - X -

MB_HEAP1_SIZ
E

Shows the number of bytes used in
Heap1 memory (read-only)

- - X

MB_HEAP2_SIZ
E

Shows the number of bytes used in
Heap2 memory (read-only)

- - X

MB_LocalHostN
ame

Local host name (read-only) - X -

MB_inactivity_pt
s_ms

Refresh period in milliseconds of the
SpiderControl browser's refresh state
'inactivity'.
Corresponds to the setting of the
'inactivity_pts_ms' defined in the XML
configuration file (uBrowser.xml).

- X -

MB_inactivity_to
_sec

Time in seconds until MicroBrowser's
refresh switches to the state
'inactivity'. The parameter
'MB_inactivity_pts_ms' defines the
refresh period in milliseconds of
'inactivity' state.
Corresponds the the setting
'inactivity_to_sec' defined in the XML
configuration file (uBrowser.xml).
Useful to avoid unnecessary network
traffic in case of user inactivity.

e.g.:
MB_inactivity_pts_ms = 5000
MB_inactivity_to_sec = 60
The refresh period is set to 5000 ms
after 60 sec of inactivity (inacivity
means no user interaction).

- X -

MB_InactivityCo
unter

This variable increments every
second.
Set to '0' as soon as a user action
occurs.

You can reset this counter e.g. with
an Event-Painter to '0'. But you
cannot write another value into this
container.

i.e.: Event Timeout Logout Macro
described in the chapter Automatical
View Jump

X X x

MB_InactivityCo
unterMin

This variable increments every
minute. Reset to 0 on any mouse or
key action of the user. Useful for
logout. (read-only)

X X -

MB_IpAddress Client's IP-Address (read-only) - X -

MB_OS_VERSI Version identifier of the operating - X -
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ON system (read-only)

MB_PERCO_0
MB_PERCO_1
...
MB_PERCO_19

Please see chapter 'Persistent
Containers'

- X -

MB_PLATFORM Platform name, which is one of the
following identifiers "uBT", "uBCE",
"uBXP", ... (read-only)

- X -

MB_PollTimeSub
stitute

Allows to set at any time a new
refresh period in milliseconds, (0:
means Client uses the default refresh
period defined in the project).

X X -

MB_SCREEN_H
EIGHT

height of the screen in pixel (read-
only)

- X -

MB_SCREEN_W
IDTH

width of the screen in pixel (read-
only)

- X -

MB_StartProces
s **

Write the name of the application to
start. Write "killme" will close the
MicroBrowser program itself.

- X -

MB_Subnet Client's subnet mask (read-only) - X -

MB_tmz_en Switch ('0' or '1') between local time
zone and UTC time (e.g. used in time
indications of trending and alarming).
See 'MicroBrowserSetup.pdf' for
more details.

X X -

MB_UpdateAfter
Co
Write

Write '0' or '1' to improve the reaction
time after writing on any CO

- X -

MB_UpdateAfter
Ppo
Write

Write '0' or '1' to improve the reaction
time after writing on any PPO

- X -

MB_Volume ** Defines volume in percent - X -

MB_WakeUp ** Write '1' to wake up the client and to
stop the screen saver

- X -

MessageBoxCO Reserved container used in message
box TEQ view

X X -

MSGBOX_NR Number of messages appended in
the message box

- X -

_KEYEVENT Used by the keypad TEQ to append
new characters

- X -

_KEYPAD Current value to edit in keypad view - X -

_KEYPAD_DES
T_
NAME

Name of the keypad's destination
variable name

- X -

_KEYPAD_DES
T_TYPE

Type of the keypad's destination
variable type

- X -

_KEYPAD_OPE
N

Open keypad view - X -

_KEYPAD_SHIF Used by keypad as caps-lock - X -
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T functionality

_KEYPAD_TF_F
OCUS

Used to select the editable text field
after closing the keypad.

- X -

_KEYPAD_MIN Show the min value of the edited
(PPO) variable (not formatted in case
of e.g. DEC.2)

X X -

_KEYPAD_MAX Show the max value of the edited
(PPO) variable (not formatted in case
of e.g. DEC.2)

X X -

_KEYPAD_FOR
MAT

Show the format value defined in
TCR file, of the edited (PPO) variable

X X -

MB_SCREEN_B
PP

Show the number of bit per pixel
used by the display, 8, 16 or 24-bpp

- X -

MB_ERRORTYP
E

The value will change according to
the type of the latest error: 
0: For web server errors
1: For min max bounds check errors
Can be used for MsgBox.teq
customization.

X - -

* X = supported, - = not supported
** not supported on all platforms

Reserved Name spaces and Container Names
The following container names are used by the browser for macro internal logic
only. Do not use these prefixes or names for your own container variables.

Reserved Name AppendSrcToLocalFileResultCo

Reserved Name WriteSrcToLocalFileResultCo

Reserved Prefix ?S_ 

Reserved Prefix MB

Reserved Prefix @MACRO

19.5 Persistent Containers

Supported Platforms

- MicroBrowser

This chapter is only relevant if you have a MicroBrowser target as a client.
Persistent containers have special names like this:

MB_PERCO_[0...19](for example MB_PERCO_2)

The values of persistent containers are stored permanently on the file system. If
you close MicroBrowser the values of the persistent containers are not lost.
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This is very useful if you want to save language settings for example. The
persistent containers have no specific purpose, you can use them for your own
needs.
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20 Advanced Functions

20.1 Macro Library Index

This chapter lists all official macros of the Macro Library ('MacroLib'). It offers a
short overview about their functionality and lists the references to other chapters
for detailed descriptions.

Some macros have more than one data source or destination. The table shows
only the source and destination that is important to understand the macro's
functionality. If you wish to have more information please see the respective
chapter (e.g. for trending or alarming).

Macros differ in their complexity. Some of the macros consist out of only of one
Painter others are more complex and consist out of many Painters. Every macro
has its own configuration dialogue so you don't have to care about the different
painters of a macro and how they interact.

\SaiaAlarmingMacro

Macro Name Filename
Description/
Comment

Online Alarm List 2
MacroAlarmingDefOnline_5_15_
00f.esm

Overwiew Alarming
(2),
Online Alarm List (2)

Offline Alarm History 2
MacroAlarmingHisOffline_5_15_
00b.esm

Overwiew Alarming
(2),
Offline Alarm History
(2)

Online Alarm History 2
MacroAlarmingHisOnline_5_15_
00b.esm

Overwiew Alarming
(2),
Online Alarm History
(2)

Online Alarm List
MacroAlarmingDefOnline_5_14_
05.esm

Alarming Overview,
Online Alarm List

Offline Alarm History
MacroAlarmingHisOffline_5_13_
06.esm

Alarming Overview,
Offline Alarm History

Online Alarm History
MacroAlarmingHisOnline_5_14_
05.esm

Alarming Overview,
Online Alarm History

\SaiaAlarmingMacro\QVGAcolors

Macro Name Filename (add '_5_13_01.esm')
Description/
Comment

Online Alarm List QVGA Q_MacroAlarmingDefOnline
Alarming Overview,
Online Alarm List

Online Alarm List QVGA Q_MacroAlarmingDefOnlineCo Alarming Overview,
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Macro Name Filename (add '_5_13_01.esm')
Description/
Comment

(Complete) mplet Online Alarm List

Online Alarm List QVGA
(Minimal)

Q_MacroAlarmingDefOnlineMini
Alarming Overview,
Online Alarm List

Offline Alarm History
QVGA

Q_MacroAlarmingHisOffline
Alarming Overview,
Online Alarm History

Online Alarm History
QVGA

Q_MacroAlarmingHisOnline
Alarming Overview,
Online Alarm History

Online Alarm List QVGA,
FKEY (Complete)

QFKEY_MacroAlarmingDefOnlin
eComplet

Alarming Overview,
Online Alarm List

Online Alarm List QVGA,
FKEY (Minimal)

QFKEY_MacroAlarmingDefOnlin
eMini

Alarming Overview,
Online Alarm List

Offline Alarm History
QVGA, FKEY

QFKEY_MacroAlarmingHisOfflin
e

Alarming Overview,
Offline Alarm History

Online Alarm List QVGA,
FKEY

QFKEY_MacroAlarmingHisOnlin
e

Alarming Overview,
Offline Alarm History

\SaiaEventList

Macro Name Filename
Description/
Comment

Event List EventsList_5_15_00m.esm Event List Overview

\SaiaGeneral\MicroBrowser

Macro Name Filename (add
'_5_13_40.esm')

Data
Source

Data
Destination

Description/
Comment

Set Focus
Event-
Painter (On
Gain Focus)

EventP_SetFoc
us_onGainFoc
us

X and Y
coordinate
s of the
Event-
Painter

@FOCUS Use this macro to
define which painter
should be selected
first. Please see
chapter 
MicroBrowser
Specific Macros.

\SaiaGeneral\PasswordLogin

Macro Name Filename (add
'_5_13_40.esm')

Data
Source

Data
Destinati
on

Description/
Comment

Password Dialog PasswordDialog_ STRING, CONTAI Login with
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Macro (User
Level)

UserLevel PPO,
CONTAINE
R, HTML
TAG

NER,
PPO

password (no
username
required)
Please see
chapter Password
Entry Page

Password Dialog
Macro (User
Level)
Auto TEQ-Jump

PasswordDialog_
UserLevel_Auto

STRING,
PPO,
CONTAINE
R, HTML
TAG

CONTAI
NER,
PPO

Login with
username and
password
Please see
chapter Password
Entry Page

Logout Event-
Painter (On
Timeout)

EventP_Logout_
onTimeout

STRING,
PPO,
CONTAINE
R, HTML
TAG

TEQ
INDEX,
CONTAI
NER

Please see
chapter Password
Entry Page

\SaiaGeneral\URLJumps

Macro Name Filename (add
'_5_13_40.esm')

Data
Source

Data
Destinat
ion

Description/
Comment

URL Jump Button
(On Mouse Down)

ButonURLJump_on
MouseDown_5_14
_30.esm

STRING,
PPO,
CONTAINE
R, HTML
TAG

URL Performs an URL
Jump On Mouse
Down. The user
can define the
Button's label as a
STRING, PPO,
HTML TAG or
CONTAINER.

URL Jump Event-
Painter
(isEqual)

EventP_URLJump
_
isEqual

STRING,
PPO,
CONTAINE
R, HTML
TAG

URL Performs a URL
Jump if X is equal
to Y. Where X and
Y can be STRING,
PPO, CONTAINER
or HTML TAG

URL Jump Event-
Painter
(On Timeout)

EventP_URLJump
_
onTimeout

STRING,
PPO,
CONTAINE
R

URL Performs a URL
Jump after a
specific time of
user inactivity

\SaiaGeneral\ViewJumps

Macro Name Filename (add
'_5_13_40.esm')

Data
Source

Data
Destinat
ion

Description/
Comment

View Jump Event-
Painter
(isEqual)

EventP_ViewJump
_
isEqual

STRING,
PPO,
CONTAINE

TEQ
INDEX

Performs a TEQ-
View Jump if X is
equal to Y. Where
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R, HTML
TAG

X and Y can be
STRING, PPO,
CONTAINER or
HTML TAG

View Jump Event-
Painter
(On Timeout)

EventP_ViewJump
_
onTimeout

STRING,
PPO,
CONTAINE
R, HTML
TAG

TEQ
INDEX

Performs a TEQ-
View Jump after a
specific time of
user inactivity

\SaiaGeneral\WriteSourceToDestination

Please refer to the chapter Write Source To Destination Macros for details

Macro Name Filename (add
'_5_13_40.esm')

Data
Source

Data
Destinat
ion

Description/
Comment

Write Source To
Destination
Event-Painter
(On Lost Focus)

EventP_writeSrc2D
st_
onLost

STRING,
PPO,
CONTAINE
R, HTML
TAG

PPO,
CONTAI
NER

Writes the source
data to the
destination data
'On Lost Focus'

Write Source To
Destination
Event-Painter
(On Repaint)

EventP_writeSrc2D
st_
onRepaint

STRING,
PPO,
CONTAINE
R, HTML
TAG

PPO,
CONTAI
NER

Writes the source
data to the
destination data
'On Repaint'

Write Source To
Destination
Event-Painter
(On Gain Focus)

EventP_writeSrc2D
st_
onGain

STRING,
PPO,
CONTAINE
R, HTML
TAG

PPO,
CONTAI
NER

Writes the source
data to the
destination data
'On Gain Focus'

Write Source To
Destination
Event-Painter
(isEquall)

EventP_writeSrc2D
st_
isEqual

STRING,
PPO,
CONTAINE
R, HTML
TAG

PPO,
CONTAI
NER

Writes the source
data to the
destination data if
X is equal to Y.
Where X and Y
can be STRING,
PPO, CONTAINER
or HTML TAG

Write Source To
Destination
Event-Painter
(isGreater)

EventP_writeSrc2D
st_
isGreater_5_14_19
.esm

STRING,
PPO,
CONTAINE
R, HTML
TAG

PPO,
CONTAI
NER

Writes the source
data to the
destination data if
X is greater to Y.
Where X and Y
can be STRING,
PPO, CONTAINER
or HTML TAG

\SaiaGeneral
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Macro Name Filename Data
Source

Data
Destina
tion

Description/
Comment

DropDown List DropDownList_5_1
4_23.esm

STRING,
HTML
TAG

PPO,
CONTAI
NER

Implements a
DropDown that
reads the list of
items from a
STRING or HTML
TAG and uses a
PPO or
CONTAINER to
point to the current
item

DropDown List
with GIF Label

DropDownListGifBu
tton_5_14_28.esm

FILE
(GIF),
HTML
TAG

PPO,
CONTAI
NER

Implements the
same function as
the macro
'DropDown List'
and has an
additional GIF
image for the
arrow symbol (can
be replaced).

Animated GIF AnimatedGif_5_13_
01.esm

FILE - Implements an
animated GIF
functionality.
Refer to the
chapter Animated
GIF Macro

Blinker Blinker_5_10_00.tlb @BLINKC
O
(CONTAIN
ER)

- Blinker

Tacho Tacho_5_14_29.
esm

STRING,
PPO,
CONTAIN
ER, HTML
TAG

- Implements a
tachometer

Table Control
Editable PPO
Page Jump

TableControl_Edita
blePPO_PageJump
_5_10_00.tlb

PPO,
CONTAIN
ER

PPO Table control
consisting of
separate edit-fields

Language Button LanguageButton_5
_14_28.esm

STRING
(language
filename)

@LANG
UAGE
(CONTAI
NER)

Implements a
button to change
the language
during runtime

Local Time
Enable Checkbox

TrdAlr_LocalTimeE
nabler_5_13_05.
esm

STRING CONTAI
NER
(MB_tmz
_en)

All time references
in trending and
alarming macros
are shown in the
UTC format during
runtime. It is
possible to switch
to the local time
zone.

With this macro
the user can
change the time
format during
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runtime.

\SaiaHDLogTrendMacro

Macro Name Filename (add '_5_14_03.esm') Description/Comment

HDLog Trend
Macro (Complete)

RemoteOffSavedTrdComplete Please see chapter 
HDLog Trend Macros

HDLog Trend
Macro (Minimal)

RemoteOffSavedTrdMini Please see chapter 
HDLog Trend Macros

\SaiaTrendMacro

Please see chapter Trend Macros Introduction to understand the concepts of
Online, Offline and Saved Trending.

Macro Name
Filename (add '__5_13_01.
esm') Description/Comment

Offline Saved Trend
(Complete)

OfflineSavedTrendComplete Please see chapter Offline
Saved Trend Complete

Offline Saved Trend
(Minimal)

OfflineSavedTrendMinimal Offline Saved Trend
Minimal

Offline Saved Trend
(Scalable)

OfflineSavedTrendScalable Offline Saved Trend
Complete

Offline Trend
(Complete)

OfflineTrendComplete Offline Trend Complete

Offline Trend
(Minimal)

OfflineTrendMinimal Offline Trend Minimal

Offline Trend Load X
Min Definition
(Minimal)

OfflineTrendMinimalOnLoadXMin
Def

Offline Trend Minimal

Offline Trend
(Scalable)

OfflineTrendScalable_5_13_01.
esm

Offline Trend Scalable

Offline Trend Load X
Min Definition
(Scalable)

OfflineTrendScalableOnLoadXMi
nDef

Offline Trend Scalable

Online Trend
(Complete)

OnlineTrendComplete Online Trend Complete

Online Trend
(Minimal)

OnlineTrendMinimal Online Trend Minimal

Online Trend
(Scalable)

OnlineTrendScalable Online Trend Scalable
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\SaiaTrendMacro\QVGAcolors

Macro Name Filename (add '_5_13_01.esm') Description/Comment

Offline Saved Trend
QVGA (Minimal)

Q_OfflineTrendMinimal Offline Trend Minimal

Offline Saved Trend
QVGA, Save To File
(Minimal)

Q_OfflineTrendMinimal_Save2Fil
e

Offline Trend Minimal

NanoBrowser Macro Library (eDisplay) 

Macro Name Filename
(add
'_5_14_03.
esm')

Data Source Data
Destination

Description/
Comment

NanoBrowser
Blinker

eD_Blinker @BLINKCO
(CONTAINER)

- Blinker macro

NanoBrowser
URL Jump
Button (On
Mouse Down)

eD_ButonU
RLJump_on
MouseDow
n

STRING, PPO,
CONTAINER,
HTML TAG

URL Performs an URL
Jump On Mouse
Down. The user
can define the
Button's label as
a STRING, PPO,
HTML TAG or
CONTAINER.

NanoBrowser
DropDown List

eD_DropDo
wnList

STRING, HTML
TAG

PPO,
CONTAINER

Implements a
DropDown that
reads the list of
items from a
STRING or
HTML TAG and
uses a PPO or
CONTAINER to
point to the
current item

NanoBrowser
Logout Event-
Painter (On
Timeout)

eD_EventP
_Logout_on
Timeout

STRING, PPO,
CONTAINER,
HTML TAG

TEQ INDEX,
CONTAINER

Please see
chapter 
Password Entry
Page

NanoBrowser
URL Jump
Event-Painter
(isEqual)

eD_EventP
_URLJump
_isEqual

STRING, PPO,
CONTAINER,
HTML TAG

URL Performs a URL
Jump if X is
equal to Y.
Where X and Y
can be STRING,
PPO,
CONTAINER or
HTML TAG

NanoBrowser
URL Jump
Event-Painter
(On Timeout)

eD_EventP
_URLJump
_onTimeout

STRING, PPO,
CONTAINER

URL Performs a TEQ-
View Jump after
a specific time of
user inactivity

NanoBrowser
View Jump

eD_EventP
_ViewJump

STRING, PPO,
CONTAINER,

TEQ INDEX Performs a TEQ-
View Jump if X is
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Event-Painter
(isEqual)

_isEqual HTML TAG equal to Y.
Where X and Y
can be STRING,
PPO,
CONTAINER or
HTML TAG

NanoBrowser
View Jump
Event-Painter
(On Timeout)

eD_EventP
_ViewJump
_onTimeout

STRING, PPO,
CONTAINER,
HTML TAG

TEQ INDEX Performs a TEQ-
View Jump after
a specific time of
user inactivity

NanoBrowser
Write Source
To Destination
Event-Painter
(isEquall)

eD_EventP
_writeSrc2
Dst_isEqual

STRING, PPO,
CONTAINER,
HTML TAG

PPO,
CONTAINER

Writes the
source data to
the destination
data if X is equal
to Y. Where X
and Y can be
STRING, PPO,
CONTAINER or
HTML TAG

NanoBrowser
Write Source
To Destination
Event-Painter
(On Gain
Focus)

eD_EventP
_writeSrc2
Dst_onGain

STRING, PPO,
CONTAINER,
HTML TAG

PPO,
CONTAINER

Writes the
source data to
the destination
data 'On Gain
Focus'

NanoBrowser
Write Source
To Destination
Event-Painter
(On Lost
Focus)

eD_EventP
_writeSrc2
Dst_onLost

STRING, PPO,
CONTAINER,
HTML TAG

PPO,
CONTAINER

Writes the
source data to
the destination
data 'On Lost
Focus'

NanoBrowser
Write Source
To Destination
Event-Painter
(On Repaint)

eD_EventP
_writeSrc2
Dst_onRep
aint

STRING, PPO,
CONTAINER,
HTML TAG

PPO,
CONTAINER

Writes the
source data to
the destination
data 'On Repaint'

NanoBrowser
Password
Dialog Macro
(User Level)

eD_Passwo
rdDialog_U
serLevel

STRING, PPO,
CONTAINER,
HTML TAG

CONTAINER,
PPO

Login with
password (no
username
required)
Please see
chapter 
Password Entry
Page

NanoBrowser
Table Control
Editable PPO
Page Jump

eD_TableC
ontrol_Edita
blePPO_Pa
geJump

PPO,
CONTAINER

PPO Table control
consisting of
separate edit-
fields

Set Focus
Event-Painter
(On Gain
Focus)

EventP_Set
Focus_onG
ainFocus

X and Y
coordinates of
the Event-
Painter

@FOCUS Use this macro
to define which
painter should be
selected first.
Please see
chapter 
MicroBrowser
Specific Macros.
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What is a 'Data Source' or 'Data Destination'?

most of the macros write a source to a destination to perform the required action.
The following data types (also called infos) are possible: STRING, PPO,
CONTAINER, HTML TAG, URL, FILE, TEQ INDEX

What is an Event-Panter (EventP)?

An Event-Painter is an invisible Painter object that is able to perform actions
depending on specific events and defined conditions. The following events are
possible:

Name When do they occur?

On Gain Focus: User jumps on a TEQ-View

On Lost Focus: User leaves a TEQ-View

On Repaint: Every period

On Mouse
Down:

Mouse click

Conditions:

Name When are they true?

On Timeout: Value of @MB_InactivityCounter is higher than X

Is Equal If X is equal to Y

20.2 General Purpose

20.2.1 Animated GIF Macro

In the S-Web Editor you can't import animated GIFs directly. There are several
different animated GIF formats which are incompatible to each other.
The S-Web Editor implements the animated GIF functionality as a macro object.
The idea of this macro is, that you have to save your animation as separate static
GIF files.
The index in the filenames of these GIF files defines the display order of the
pictures during the animation.
Define the gif filenames in a way that they are all extended with the appropriate
index. This could look like this:

myAni0.gif
myAni1.gif
...
myAniN.gif (replace the 'N' with the last number)

During runtime the macro will loop through all those gifs in the right indexed order
at each period.
The animation jumps back to gif '0' when the last index is reached.
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Name: AnimatedGif_[EDITOR_VERSION].tlb

What the user has to do

1. Import the macro
2. Double click and choose the 'Cross Ref' tab
3. The following window appears:

CONTAINER
"AnimatedIndexC
O"

Contains the actual gif filename index during
runtime. You have to change the Container name,
if you have more than one macro-object in your
HMI. Extend for example the container name with
an additional number:
AnimatedIndexCO
AnimatedIndexCO1
...
AnimatedIndexCON

Be sure that you don't use the macro-object more
than once with the same index Container name in
your HMI.

CONTAINER
"AUTOINCRCO"

Don't modify this container name

STRING "%" Don't modify this string

STRING
"NbrImages"

Replace this string with the number of animation's
images. If you have the following images for
example:
myAni0.gif
myAni1.gif
...
myAni4.gif

You have to replace the 'NbrImages' string with '5'
(because index starts at '0').
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FILE
"Animated@CO_
AnimatedIndexC
o@.gif"

The Animated GIF macro determines the image's
filename with 'Container Offset' (see chapter 
Container Offset for details).
Please modify the first part of this string now
('Animated').
In the case of the example with 'myAni0.gif' the
string should look like this:
FILE "myAni@CO_AnimatedIndexCo@.gif"

If you modified the name of the Container
'AnimatedIndexCO' you have to update the
Container name in this string too.
Replace the string between the '@' signs with the
new name of your index container.

4. Confirm your modifications and close the 'Cross Ref' window. Your animated
gif should work now in the browser.

20.2.2 Write Source To Destination

The macros described in this chapter can be used to write a source to a
destination. The source is a static string, PPO variable, Container variable or
HTML Tag.
The destination is always a PPO or Container variable. The user will not see the
macro during the runtime, because it is built with Event-Painters (only visible in
the S-Web Editor).

Macro Name Filename (add
'_5_13_40.esm')

Data Source Data
Destinatio
n

Description/
Comment

Write Source
To Destination
Event-Painter
(On Lost Focus)

EventP_writeSrc2D
st_
onLost

STRING,
PPO,
CONTAINER,
HTML TAG

PPO,
CONTAINE
R

Writes the
source data to
the destination
data 'On Lost
Focus'

Write Source
To Destination
Event-Painter
(On Repaint)

EventP_writeSrc2D
st_
onRepaint

STRING,
PPO,
CONTAINER,
HTML TAG

PPO,
CONTAINE
R

Writes the
source data to
the destination
data 'On
Repaint'

Write Source
To Destination
Event-Painter
(On Gain
Focus)

EventP_writeSrc2D
st_
onGain

STRING,
PPO,
CONTAINER,
HTML TAG

PPO,
CONTAINE
R

Writes the
source data to
the destination
data 'On Gain
Focus'

Write Source
To Destination
Event-Painter
(isEquall)

EventP_writeSrc2D
st_
isEqual

STRING,
PPO,
CONTAINER,
HTML TAG

PPO,
CONTAINE
R

Writes the
source data to
the destination
data if X is
equal to Y.
Where X and Y
can be
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STRING, PPO,
CONTAINER or
HTML TAG

What is an Event-Panter (EventP)?

An Event-Painter is an invisible Painter object that is able to perform actions
depending on specific events and defined conditions.

The following events are possible:

Name When do they occur?

On Gain
Focus:

User jumps on a TEQ-View

On Lost
Focus:

User leaves a TEQ-View

On Repaint: Every period

What the user has to do

S-Web Editor provides a simple dialogue to configure the Event-Painter macros.
Double click the imported macro in order to open the macro configuration
dialogue:

If you wish to read more about how to use macros, please refer to the chapter 
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Working With Macros.

20.2.3 Password Login Macros

S-Web Editor offers several macros to implement a password entry page for your
HMI. The approach works with a Container variable that holds the current user
level. If the HMI user enters a correct password the macro sets the user level to
the corresponding value. You are able to define up to four different user levels
with a separate password. Dependant on this user level you can restrict the
access to your HMI by hiding or disabling Painter objects or groups.
With an additional macro it is possible to check if the user typed in a correct user
name (please see list below).

Macro Name Filename
(add
'_5_13_40.
esm')

Description

Password Dialog
Macro (User Level)

PasswordDi
alog_
UserLevel

Basic password entry page
macro that works with four user
levels and password

Password Dialog Auto
TEQ Jump Macro
(User Level,
Username and
Password)

PasswordDi
alog_
UserLevel_
Auto

Password entry page that
provides an additional username
check and an automatic TEQ-
View jump if the user typed in a
correct username and password

Logout Event-Painter
(On Timeout)

EventP_Log
out_
onTimeout

Performs a logout after a certain
time of inactivity (inactivity
means no user interaction). The
logout mechanism resets the
user level to '0' and performs a
TEQ-View Jump to a logout
TEQ-View

What the user has to do

S-Web Editor provides a simple dialogue to configure macros.

Double click the imported macro in order to open the macro configuration
dialogue.

If you wish to read more about how to use macros, please refer to the chapter 
Working With Macros.
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20.2.4 DropDown List

A DropDown List is an object which opens upon selection and offers a choice of
different elements. The user selects one of them, and the selection closes again,
showing nothing but the selected element.

The DropDown List object is linked to two data-sources:
A PPO or Container variable where the index (as an integer) of the chosen
element is read and written to. 'item1' is linked to index 0, 'item 2' to index 1, etc.

A list containing the text items (item1, item2, ..) which can be modified at will by
the user. There are two possible sources for an item list.

The listed can either be defined as a string using the object's dialog, or as a
HTML-tag, where the item-string can be defined in a language dependant csv-file
(see also chapter Multilingual HMI's).

Macro Name Filename Data Source
Data
Destination

DropDown List DropDownList_5_13_40.
esm

STRING, HTML
TAG

PPO,
CONTAINER

What the user has to do

The item-list must be entered as a single string using '\n' (two characters) as a
separator.

Example:
None\nMove1\nMove2\nMove3\nMove4\nMove5\nMove6

Previous macro versions used the character '¢' (ASCII 162) as separator. IMaster
Java-Applet und MicroBrowser are backward compatible to this separator.

S-Web Editor provides a simple dialogue to configure the Event-Painter macros.
Double click the imported macro in order to open the macro configuration
dialogue.

If you wish to read more about how to use macros, please refer to the chapter 
Working With Macros.

20.2.5 Automatical TEQ/URL Jump

Automatical TEQ/URL Jump macros can be used to force a TEQ-Jump or URL-
Jump if a certain condition is true or a event occurs. The user will not see the
macro during the runtime, because it is built with Event-Painters (only visible in
the S-Web Editor).
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The following events are possible:

Name When do they occur?

On Gain
Focus:

User jumps on a TEQ-View

On Lost
Focus:

User leaves a TEQ-View

On Repaint: Every period

Conditions:

Name When are they true?

Is Equal If X is equal to Y

\SaiaGeneral\URLJumps

Macro Name Filename (add
'_5_13_40.esm')

Data
Sourc
e

Data
Desti
natio
n

Description/
Comment

URL Jump
Event-Painter
(On Repaint)

EventP_URLJump_onRep
aint

STRIN
G,
PPO,
CONT
AINER,
HTML
TAG

URL Performs an URL
Jump On Repaint.

URL Jump
Event-Painter
(isEqual)

EventP_URLJump_isEqua
l

STRIN
G,
PPO,
CONT
AINER,
HTML
TAG

URL Performs a URL
Jump if X is equal to
Y. Where X and Y
can be STRING,
PPO, CONTAINER
or HTML TAG

URL Jump
Event-Painter
(On Timeout)

EventP_URLJump_onTim
eout

STRIN
G,
PPO,
CONT
AINER

URL Performs a URL
Jump after a specific
time of user inactivity

\SaiaGeneral\ViewJumps

Macro Name Filename (add
'_5_13_40.esm')

Data
Sourc
e

Data
Desti
natio
n

Description/
Comment
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View Jump
Event-Painter
(On Repaint)

EventP_ViewJump_onRep
aint

STRIN
G,
PPO,
CONT
AINER,
HTML
TAG

TEQ
INDE
X

Performs a TEQ-
View Jump On
Repaint.

View Jump
Event-Painter
(isEqual)

EventP_ViewJump_isEqu
al

STRIN
G,
PPO,
CONT
AINER,
HTML
TAG

TEQ
INDE
X

Performs a TEQ-
View Jump if X is
equal to Y. Where X
and Y can be
STRING, PPO,
CONTAINER or
HTML TAG

View Jump
Event-Painter
(On Timeout)

EventP_ViewJump_onTim
eout

STRIN
G,
PPO,
CONT
AINER,
HTML
TAG

TEQ
INDE
X

Performs a TEQ-
View Jump after a
specific time of user
inactivity

What the user has to do

S-Web Editor provides a simple dialogue to configure the Event-Painter macros.
Double click the imported macro in order to open the macro configuration
dialogue.
If you wish to read more about how to use macros, please refer to the chapter 
Working With Macros.

20.2.6 Table Control/Spread Sheet

This macro can be used like a table control consisting of separate edit-fields,
each of them pointing to a PPO. The PPO can be read and written. The table can
be scrolled page-wise (page up and page down) using the two buttons showing
arrows. Line-wise scrolling is not supported.

The table control is based on an indexed addressing mechanism, where the
address-offset can be modified dynamically with an up and down button. The
offset is stored in a container variable called 'listOff'.

The table is organized in rows, where each row represents an array of a certain
PPO base address. The container offset is added to the base offset. The base
offset is defined for each object fields PPO reference.

The table control can be modified in every way, e.g. rows and columns can be
added or deleted. The existing rows show an addressing scheme for sample
PPO's. To modify these PPO's, it is recommended to select all objects of a row
and to use the Cross Ref function. PPO names can be updated separately. A
more efficient way is to use the 'Find/Replace' function which can be found on the
'Cross Ref' tab. This function performs a substring replace on all selected objects.
E.g. if you want to exchange the row using 'PDP,,R100x,d' PPO name by a
symbolic array named myVar[x], do the following:

1. select the complete row and open the 'Cross Ref' dialog (right mouse button
menu or bottom tool box). Select the 'Cross Ref' tab.
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2. Press the 'Find/Replace' button. Enter 'PDP,,R100' in the 'Find' field and
'myVar[' in the 'Replace' field. Press 'OK'. Then enter ',d' in the 'Find' field and
']' in the 'Replace' field. Press 'OK'.

If you use more than one instance of this object in one project, make sure to
exchange the container variable name to a unique identifier for each table,
otherwise the table offset of all your tables will be synchronized.

Name: TableControl_EditablePPO_PageJump_[EDITOR_VERSION].tlb

What the user has to do

1. Import the macro

2. Ungroup the macro

3. Modify rows and columns

4. In the page-up/down buttons: modify the increment/decrement step according
to the number of rows

5. In the page-down button: modify the 'hide/disable' condition to hide the button,
if the last page is reached, according to the number of elements that you have
defined in your arrays.

6. Delete the comment section

20.2.7 Blinker

The blinker macro toggles between two colors every period. You can define these
colors. Make a double click on the inserted macro and click the entry 'Rectangle
Repaint'. In the tab 'Border Advanced' you can define the two colors.
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Name: Blinker_[EDITOR_VERSION].tlb

What the user has to do

1. Import the macro: load macro library-> Object from the macro library ...
2. Double-click macro library
3. Tab 'Advanced Selection'
4. Double-click entry 'Rectangle Repaint'
5. Tab 'Setting Advanced'
6. Define the desired colors

20.2.8 MicroBrowser Specific Macros

This chapter describes macros which are only supported in the MicroBrowser
client. This means they write or read from special MicroBrowser Container
variables.
MicroBrowser specific macros can be found in the macro library directory
'SaiaGeneral/MicroBrowser'.

Set Focus On Gain Focus

Place this macro in front of the Painter you want to have selected first when the
TEQ view is loaded (e.g. useful if you have a 'Next Page' Button).
MicroBrowser reads the coordinates of the macro and selects the object with the
closest coordinates.

\SaiaGeneral\MicroBrowser

Macro Name Filename (add '_5_13_40.esm') Data
Source

Data
Destin
ation

Set Focus Event-
Painter (On Gain
Focus)

EventP_SetFocus_onGainFocus X and Y
coordinat
es of the
Event-
Painter

@FOC
US

What the user has to do

1. Import the macro

2. Place the macro in front or back of the painter that should be selected first.
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20.3 Trend Macros

20.3.1 Introduction

Introduction

What kind of trend-objects can be used?

The libraries (Offline, Offline Saved, Online) offer three different types of trending
macros. Every macro varies in terms of complexity and functionality.

Client-Sided Trending

The easiest way to record a trend is to record a PPO in the browser. The value is
drawn by the Java-Applet or MicroBrowser to a trend curve. If the user leaves the
trend HMI, the value will not be recorded any longer. This trend type is called '
Online Trend' which is described in the respective chapters later on. But this type
of trending is only of limited use.

PCD RAM Based Trending (for small data amount)

Offline trends refer to records that were made by the PLC. The user can access
the PLC whenever he likes and can watch the trend history which was recorded
by the PLC. Access to PLC's which record such trends can very often be of
limited bandwidth. The user therefore has the possibility to select the range of the
recording in order to load only a part of the data stored on the PLC. All data that is
loaded to the client is then stored locally inside the client. The user can navigate
and zoom inside the uploaded data at will. It is possible to upload additional data
(if only a fraction had been loaded before) at any time. Data which is already
stored in the client will not be lost.
The PCD holds the data of Offline Trend macros in RAM. If you use these macros
you are very limited in how much trending data you can manage. If you wish to
record trending data over a longer time, it is better to use the macros described in
the next section.

PCD Flash Based Trending (for large data amount)

HDLog Trend Macros are able to manage large amount of trending data. This is
possible, because the new approach is to store the trending data on the flash
memory of the PCD and not in RAM as Offline Trend Macros. Please refer to
chapter 'PCD Flash Based trending' for more details.

Viewing Trend Logfiles

It is possible to save the uploaded data to a local file (on the client side). The
recordings can be saved on a harddisk. These files are stored in a CSV format
and can be analysed in external programs (like Excel, etc.). It is also possible to
reload these files with the browser. The user might want to analyse the saved
trend curves in a situation when no online connection to a PLC is active.
Therefore, a group of additional macro-functions is offered for this purpose.

These macros are called 'Offline Saved Trend'. An HMI for offline analysis may
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be loaded directly from the hard-disk of the PC. No download of the S-Web HMI
to a PLC is necessary, because no connection to PPO's is required. Like this, a
user can have a local application on a PC that runs autonomously without any
network connections.

Maximal Number Of Trends Per Macro

For Offline Trend the configuration of a trend macro is stored in a string that has a
maximum size of 2 KB.
The size of a trend curve is 90 bytes + trend name length.
For example if your trend names have about 10 characters length:
2000 bytes / (90 byte + 10 byte) = 20 trends

For HDLog Trend macros the maximum number of trend curves is 10.

20.3.2 PCD Flash Based Trending

20.3.2.1 HDLog Trend Macros

HDLog Trend Makros

HDLog Trend Macros are able to manage a large amount of trending data. This is
possible, because the new approach is to store the trending data on the flash
memory of the PCD and not in RAM as Offline Trend Macros.
In comparison to Offline Trend macros there is also a difference in how the
browser client communicates with the PCD: In case of HDLog Trend macros the
trending data is stored and organised in files. This means the browser client will
get files with trending data from the PCD; So HDLog macros don't have to use
CGI calls in order to receive the trending data from the PCD.

How To Work With HDLog Trend Macros In The Editor

First of all you have to define the HDLog HDF files in the project's configuration
window:

Use the menu Pr oj ect - >Pr oj ect  conf i gur at i ons. . .  and add your

HDLog files by clicking 'Add' like shown in the screenshot below.
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(PG5 creates these HDF files, please refer to the PG5 manual)

Confirm with OK and now import the following macro:

\SaiaHDLogTrendMacro

Macro Name Filename (add '_5_13_40.esm')

HDLog Trend Macro
(Complete)

RemoteOffSavedTrdComplete

S-Web Editor provides a simple dialogue to configure the HDLog Trend macro.

Double click the imported macro in order to open the macro configuration
dialogue:
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Displ
ayed
Time

Defines the displayed time range

Store
d
Time

Maximum amount of data that the client holds in RAM

Show
Grid

Show grid during runtime?

Auto
matic
Y...

Show Automatic Y Axec description?

Add Adds a trend curve

Inser
t

Inserts a trend curve above the line that is currently
selected

Rem
ove

Removes the selected trend curve

If you click 'Add' or 'Insert' you see a list of all available curves provided by the
defined HDLog files:
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If you wish to read more about how to use macros, please refer to the chapter 
Working With Macros.

How To Use The HDLog Trend Macros At Runtime

The handling of the HDLog Trend Macros is simple and very similar to other trend
macros.

You can make use of the Zoom and Scroll buttons in order to adapt the
displayed time range to your own needs. This may cause the client loads new
trending files from the PCD

Clear Logs will erase the trending data, that the clients currently holds in RAM
(not on PCD's Flash).
Save Logs to file: Use this button to save the currently loaded trending data
into a file on your local harddisk.
Stop Load Data: Abort the loading of new trending files (usually trending data
is loaded from more than one file)

Reload Last: Reloads the latest Trend file from the PCD Target

If the TEQ-View with the HDLog Trend macro opens, it will show as default the
time range of the last 10 hours (see Configuration Dialogue of the macro
'Displayed Time [s]') as shown in the screenshot below:
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Use Zoom and Scroll buttons to adapt the shown time range. If you click the
coloured button a dialogue to change the trend curves colour will appear

Variations Of HDLog Trend Macros

Additionally, two proposals for both a very simple as well as a modifiable HDLog
trend macro have been added to the library.

Macro Name Filename (add '_5_14_23.esm')

HDLog Trend Macro
(Scalable)

RemoteOffSavedTrdScalable

HDLog Trend Macro
(Minimal)

RemoteOffSavedTrdMini
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The scalable HDLog shows all ten lines of the configurable curves, so no scrolling
is required during runtime. If the user wants to configure less than ten curves, he
can delete the unused lines.
The minimal macro has no runtime options to modify the trends. Every trend that
was defined with the editor will be loaded and displayed.

Stop Loading During Runtime

After the Macro has started to load the HDLog files from the PLC's flash, this
might take some considerable time to upload. Using the 'Stop Loading' button
allows to stop the upload.

20.3.3 PCD RAM Based Trending

20.3.3.1 Overview

This chapter gives you an overview about the offline trend macros. The
differences in handling for every macro is described in a separate chapter:

1. Offline Trend Complete

2. Offline Trend Minimal

3. Offline Trend Scalable

The Offline Trend Painter is a macro object which can be imported with the menu
Library->Get object from library. This macro can be used to load historical logged
data from a Saia®PCD and display the data in graphical trend curves. The PCD
records the data using the HDLog FBox library. The HDLog library is provided
together with the Web-Editor and can be installed or copied into the PG5&/Libs/
usr FBox directory. The FBoxes must be used in a PG5 Fupla project to record
historical data. The recording settings are done in the FBox adjust settings. For
details refer to the Online Help of the FBox. Before designing an offline trend in
the web-editor a corresponding PG5 fupla project with the HDLog FBoxes must
be created and compiled. The PG5 symbols of the trending data blocks are then
available in the web-editor.

How To Work With Offline Trend Macros In The Editor

The trend macros consist of several painter objects which are grouped to one
macro-object. The user can ungroup the macro and access each element
separately. Most of these objects are not editable with the standard dialog of this
editor.

Anyway, all references inside these objects can be accessed and modified by
using the CrossRef function. As the trending macro contains a rather complex
functionality, it is not recommended to modify the references, but the user can
easily move or resize the objects of this macro.

The objects of the trend-macro communicate with each other via container
variables. The names of these containers will be extended by a unique code at
the moment when the user imports the macro. This is necessary to generate a
unique instance of the trend macro object. The names to be generated may have
the form e.g.
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 "@MACRO_NewYMax.122345676788990"

The user should not modify such values, as they are generated and modified
automatically. If you export a modified macro, the editor will automatically remove
these indexes. So, you don't have to care about it.

Insert An Offline Trend Into Your View

1. Create a new Teq view in the project you want to insert the Online Trend
Painter. Do this with Project-> Add to Project-> New.
(How to create a new project is described in the chapter Getting Started)

2. Insert the Online Trend Macro object into your teq view choose Library-> Get
object from library

3. Change to your "MacroLib" directory. Select the file name of the offline trend
macro you want to insert:
Offline Trend Complete: "OfflineTrendComplete.tlb"
Offline Trend Minimal: "OfflineTrendMinimal.tlb"
Offline Trend Scalable: "OfflineTrendScalable.tlb"

The inserted Offline Trend Complete:

Offline Trend Minimal:
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Offline Trend Scalable:

Configure The Macro

The following section explains how to configure curves in offline trend macros
painter (it is basically the same in all offline macro variants):
1. Double-click on the inserted object to open the Cross Ref dialog

2. Click on the entry ".._Macro Offline Trend_Repaint:_@MACROOFTActive...."
in the Advanced Select tab. Alternatively, it is also possible to ungroup the
trend-macro and to double click on the painter object which will display the
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trend curves (uppermost object).

3. Go to the tab Macro Offline Trend
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4. Click "Select" next to the "Base PPO Name" text field to choose the PG5
symbol (e.g. Trend_Base_DB) which indicates the base address of the data
structure defined by the HDLog Init FBox. If any other PPO is used the result
will fail. The basic data block contains basic information (e.g. data base size,
number of trends, &) for all trend curves of the HDLog data base.
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5. Confirm your choice with "OK"

6. Now, the trend curves to be displayed shall be selected. Click "Select" next to
the "PPO Name" text field.

7. Select a PPO and click "OK". This variable MUST contain a trend data
structure which is defined by the trend FB. If the user indicates any other
PPO's, the result will fail. The trend PPO contains information and data of one
trend curve.

8. Define the curve color and the Y-Min and Max value

9. Click "Add" to add your curve define to the trend

10.Repeat the steps 9-12 for all curves you want to add to the trend.
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If you want to change a curve definition, click on the entry in the list do your
modifications and confirm with "Update" .

Show Grid (Optional)

This option will add a 10x10 pixel grid to your trend. You will find this checkbox in
the Macro Offline Trend tab:
1. Double-click on the inserted macro to open the Cross Ref dialog

2. Click on the entry ".._Macro Offline Trend_Repaint:_@MACROOFTActive...."
in the Advanced Select tab

3. Activate the checkbox "Show Grid".

4. Now leave the dialog Macro Offline Trend and Cross Ref with "OK".

Automatic Y axes description (Optional)

"Automatic Y axes description" will add a description for each curve to the y-axis
at runtime. The description shows you a scale from the defined "Y Min" to "Y
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Max".
If you have 2 curves for example, one description will be added to the left side
and one to the right (as shown in the picture below).
The color of the scale will be the same as the color of the curve which belongs to
it.
The automatic description at runtime:

1. Double-click on the inserted macro to open the Cross Ref dialog

2. Click on the entry ".._Macro Offlien Trend_Repaint:_@MACROOFTActive...."
in the Advanced Select tab

3. Activate the checkbox "Automatic Y axes description".

4. Now leave the dialog Macro Offline Trend and Cross Ref with "OK".

Automatic Y axes description string formatting

Please take care on Y Min and Y Max string length and formatting: The
description strings may overlap each other like in the picture below if they are too
long:

Therefore you have the possibility define the value formatting with Y Min and Y
Max strings and the font size.
The Y Min and Y Max defines the string formatting so: If you define '0.1' as the Y
Min and '1.234' as your Y Max the value formatting has one integer and three post
decimal positions.
The maximum number of post decimal position that appears in Y Min or Y Max
will determine the value formatting. This means that values are truncated in some
cases.

You are able to use the scientific notation in defining Y Min and Y Max. In this
case the values will be displayed exponentially.
With this notation the string length in the sample below was reduced from 7 to 4
characters ('100000' becomes '1E6').
And you must enter '-1e1' as Y Min and '1E6' as Y Max.
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String formatting can be defined in the Y Min and Y Max field in the macro
configuration dialog and during runtime.

Prepare The Project

1. Choose Project-> Init PPOs and click "OK". (The added PPO's were initialized)

2. If you created a new teq you have to generate a new html file with Project->
Generate HTML...

3. Choose File-> Save All...

4. Compile and download your project now with PG5.

How To Use The Offline Trend Macros At Runtime

These sections describes how to use the offline trend macros during runtime. The
specific differences in using the offline trend macros is described in separate
chapters.

Zoom And Scroll Buttons

After uploading data, the curves will be painted. Now you can navigate with the
scroll and zoom buttons:
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Save Trend Curves To Local Hard Disk

It is possible, to save the recorded trends to the local hard disk of the client. The
curves will be saved in a csv-format. As a Java Applet has very limited access to
the resources of the host computer, certain limitations must be considered.

The file download works different with Microsoft VM as with Sun VM, you have to
change the security settings:
Microsoft VM: Java Security Settings
Sun VM: Signed Applets (For Sun VM PlugIn)

To download the the logfile click "Save Logs to file":



119

Saia-Burgess Controls Ltd. Advanced Functions

Trend Macros

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

Clear Logs

Curve points which are already loaded will be overwritten in the applet buffer if
you load them more than once. And new curve points will be added. Use "Clear
Logs" if you want to clear all the loaded trend curves.

20.3.3.2 Offline Trend Complete

Please see Offline Trend Overview for general information about how to use the
offline trend macros.

How To Use The Offline Trend Complete At Runtime

Overview

This section explains how the offline trend macro will be used at runtime. The
browser will show a view like this:
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Start Load Data Uploads the selected trend in the list of activated PPO's
trends.

Load Infos Loads the attributes to the selected entry in the activated
PPO's trends list

start date/time start date and time point of the range shown

end date/time end date and time point of the range shown

zoom buttons Increases or decreases the time axis

scroll buttons scroll back and forward on the time axis

activated
PPO's trends

The list of all activated PPO's trends.

PPO
Name:

PPO Name of the selected trend

RGB: Red Green Blue value for the curve
Min/Max: shown value range on the y-axis

Update:
Click on the "Update" Button after modify the
RGB, Min or Max values.

Add:
Insert a selected trend PPO's trend form the list of
available PPO's trends by clicking the "Add"
button.

Removes
:

Removes the selected PPO entry in the activated
PPO's list.

available PPO's
trends

The list of all available trends. During runtime new trends
can be added by clicking the "New" Button.

Clear Logs Clears the buffer

Save Logs to
file

Saves the data logged in buffer until now in a text file which
can be downloaded

Curve info The "Curve Info" list shows details about curve points
selected by the user.
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Add a PPO's trend

Select an entry from the list of available PPO's trends:

Click "Add" to add the selected entry to the list of activated PPO's trends:

Click "Load Infos" to load the number of points to be downloaded and the start/
end index. The 'load info' function will read some information of the selected
curves. It will count the number of samples which are already recorded in the
PLC. If several curves are added to the list on the right, the number of samples of
these curves will be added. Like this, the user can estimate how much time the
loading will take. This is very useful, if the user accesses the PLC via a slow
connection like a modem.
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Click on the entry in the list of activated PPO's trends to see and edit the details.
The edit-fields left from the 'Update' Button indicate the min and max values of
the respective trend. The two edit-fields below (Just above the list box) will be
updated only after a 'Load Info' command and indicate the position of the start-
and the end pointer of the curve in the DB structure of the PLC. The user can
modify these pointers to reduce the number of data to be loaded from the PLC.
Because the trends can be recorded event-driven, it is not possible to know the
start- and stop-time and date before having loaded all samples to the client. This
is therefore the only way how the user can select the area that he wants to load.

The loading can be done in several attempts. If the selection of a curve did not
cover the desired period, the user can modify the pointers to another position.
The data that will be loaded during a second phase will be added to the data that
is already present in the client.
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Optional: Edit Min/Max, start/end index or RGB color. Edit a value press "ENTER"
and click on the Update button.

Click "Start Load Data" to initialize the upload process. If the upload takes too
long, this process can be interrupted by pressing the button 'Stop Loading'. The
data that was loaded so far is not lost.
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After uploading data, the curves will be painted. Now you can navigate with the
scroll and zoom buttons:

Curve Info

The "Curve Info" list shows details about curve points.
Just click somewhere in the trend timeline. The selected point will be marked with
a green line.
The first entry on the list is the point selected by the user. The list shows details
about the point next to user selected point for every curve (only backwards).
The first green colored entry in the list shows you details about the point selected
by the user (Value is "USER !")

The screenshot shows a scalable offline trend painter, but it is the same in the
offline trend complete macro:



125

Saia-Burgess Controls Ltd. Advanced Functions

Trend Macros

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

20.3.3.3 Offline Trend Scalable

Please see Offline Trend Overview for general information about how to use the
offline trend macros.

How To Work With Offline Trend Scalable In The Editor

Adapt The Offline Trend Scalable Macro Object Own Your Own Needs

1. The macro contains some italic written comment text fields which should be
removed. Ungroup the offline trend macro object, select the text field
comments and delete them. What you now see is the blank macro-object.

The macro-object contains several event painters positioned under the other
objects (labeled with "EventP"). If you move some of the painters you will see
these special painters. You must not delete these EventP objects because
provide some parts of the macro functionality.The user will not see them during
runtime anyway.

2. There is also a "Curve Min/Max" and a "Curve info" section which is optional
(can be removed). This means they are not required by any variant, but they
provide additional functionality to the user.
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These edit boxes give you
the possibility to modify the
y-min and max of your
curves during runtime.
Please see the section
"Configure The Macro"
further down for details.

During runtime the user can
select a point in the y-axis.
This "Curve info" list will
display details about curve
points that are next to the
selected point. Please see
the section "How to use the
Simplified Offline Trend at
runtime" further down for
details

The macro object contains the painter for two possible variants. You can use the
"A-Variant" or the more simpler "B-Variant".
Please do now the steps in "Offline Trend Scalable A-Variant" or "Offline Trend
Scalable B-Variant".

Offline Trend Scalable A-Variant

Don't delete any objects outside the sections of the variant you don't want to use.
Except the painters in the optional sections and the comment text fields.

1. Ungroup the offline trend macro object if you don't have yet.

2. Select all the objects in the section of the "B-Variant" and delete them.

You can freely reposition and resize all the objects.

Offline Trend Scalable B-Variant

Don't delete any objects outside the sections of the variant you don't want to use.
Except the painters in the optional sections and the comment text fields.

1. Ungroup the offline trend macro object if you don't have yet.
2. For the B-Variant select and delete all the objects in the A-Variant section.
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You can freely reposition and resize all the objects.

Curve Min/Max (Optional)

These edit boxes give you the possibility
to modify the y-min and max of your
curves during runtime.

 

1. Select the edit boxes for the first curve.

2. Open the Cross Ref dialog and go to the tab General.

3. Change the outline color to the color of the corresponding curve (curve color
can be changed in the Macr o Of f l i ne Tr end dialog).
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You will see the outline colors only during runtime. The default outline color is
black.

4. Do the steps 1-3 for all trend curves.

5. If you have just two trend curves for example, you can delete the other edit
boxes.

Prepare The Project

1. Choose Project-> Init PPOs and click "OK". (The added PPO's were initialized)

2. If you created a new teq you have to generate a new html file with Project->
Generate HTML...

3. Choose File-> Save All...

4. Compile and download your project now with PG5.

Create Your Own Offline Trend Macro

 
If you want to use your modified scalable as macro-object in further projects. You
can simply export all the objects as a new macro:

1. Select all objects which should be added to your own macro-object

2. Group the objects with:
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3. Choose Li br ar y- > I nser t  obj ect  I nt o l i br ar y.

4. Save the created macro under a new name.

How To Use the Offline Trend Scalable At Runtime

This section explains how the offline trend macro will be used at runtime.

First Steps

"B-Variant" with optional "Curve info" and "Curve Min/Max:

1. Click "Load Infos" to see how many curve points are available for this trend. If
you use the "A-Variant" go directly to step 3 because there is no "Load Infos"
available. In "A-Variant" you are also able to load a specific number of curve
points, but you can't see how many points are available.

2. Leave the value "ALL" if you want to load all available points or enter a number:

3. Click "Start Load Data". The trend curves are loading now. You can cancel the
download with "Stop Load Data" if it takes too much time and enter a lower
number of points to be loaded

4. Use the scroll and zoom buttons if the trend looks like in the picture below:
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Curve Min/Max

With the objects in the optional section "Curve Min/Max" you are able to modify
the minimal and maximal value for each curve during runtime:
1. Modify the "Min" or "Max" of a trend

2. To update the trend click "Y Range Update".

As you see the automatic description will be updated too.

Curve Info

The "Curve Info" list shows details about curve points.

Just click somewhere in the trend timeline. The selected point will be marked with
a green line.
The first entry on the list is the point selected by the user. The list shows details
about the point next to user selected point for every curve (only backwards).
The first green colored entry in the list shows you details about the point selected
by the user (Value is "USER !")
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20.3.3.4 Offline Trend Minimal

Please see Offline Trend Overview for general information about how to use the
offline trend macros.

How To Use The Offline Trend Minimal At Runtime

This section explains how the offline trend macro will be used at runtime.

First Steps

The offline trend minimal:

1. Click "Load Infos&Datas" to start loading trends informations and data.

2. Leave the value "ALL" if you want to load all available points, or enter a number
so only the entered number of last logged point will be loaded:

3. The trend curves are loading now. You can cancel the download with "Stop
Load Data" if it takes too much time and enter a lower number of points to be
loaded.
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4. Use the scroll and zoom buttons if the trend looks like in the picture below:

20.3.4 Online Trending

20.3.4.1 Overview

Introduction

This chapter gives you an overview about the online trend macros. The
differences in handling for every macro is described in a separate chapter:

1. Online Trend Complete

2. Online Trend Minimal

3. Online Trend Scalable
4.
The Online Trend Painters are macro object which can be imported with the
menu Library->Get object from library. The Online Trend Painter creates the
curves during runtime and stores these data into a buffer. The data sources are
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regular process points which will be recorded by the browser client. The number
of values that will be recorded by the trend-object can be configured. If the
number of samples exceeds this size, the oldest entries will be erased. If the user
leaves the view the recorded data will be lost.

How To Work With Online Trend Macros In The Editor

The trend macros consist of several painter objects which are grouped to one
macro-object. The user can ungroup the macro and access each element
separately. Most of these objects are not editable with the standard dialog of this
editor.

Anyway, all references inside these objects can be accessed and modified by
using the CrossRef function. As the trending macro contains a rather complex
functionality, it is not recommended to modify the references, but the user can
easily move or resize the objects of this macro.

The objects of the trend-macro communicate with each other via container
variables. The names of these containers will be extended by a unique code at
the moment when the user imports the macro. This is necessary to generate an
unique instance of the trend macro object. The names to be generated may have
the form e.g. '

@MACRO_NewYMax.122345676788990'. 

The user should not modify such values, as they are generated and modified
automatically. If you export a modified macro, the editor will automatically remove
these indexes. So, you don't have to care about it.

Insert An Online Trend Into Your View

1. Create a new Teq view in the project you want to insert the Online Trend
Painter. Do this with Pr oj ect - >Add t o Pr oj ect - > New. (How to create a

new project is described in the chapter Getting Started)

2. Insert the Online Trend Macro object into your teq view choose Li br ar y-

>Get  obj ect  from library

3. Change to your "MacroLib" directory. Select the file name of the online trend
macro you want to insert:
Online Trend Complete: "OnlineTrendComplete.tlb"
Online Trend Minimal: "OnlineTrendMinimal.tlb"
Online Trend Scalable: "OnlineTrendScalable.tlb"

The inserted Online Trend Complete:
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Online Trend Minimal:

Online Trend Scalable:
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Configure The Macro

1. Double-click on the inserted object to open the Cr oss Ref  dialog

2. Click on the entry ".._Macro Online Trend_Repaint:_@MACROActiveTrends."
in the Advanced Sel ect  t ab. Alternatively, it is also possible to ungroup the

trend-macro and to double click on the painter object which will display the
trend curves (uppermost object).
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3. Go to the tab Macro Online Trend
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4. Click "Select" to see which PPO's are available. The user shall select regular
process points which contain one single value. These process points will be
available during runtime. They will be added to the list 'Available Process
Points' (on the right side).The user can select at runtime, which of these curves
should be displayed or not. The user will select a variable from the list
'Available Process Points' and add it to the list 'Activated Process Points' to
make it visible.

5. Confirm your choice with "OK"

6. Define the curve color and the Y-Min and Max value. These values will be the
defaults when the object starts in the browser. The scaling can also be
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changed later during runtime.

7. Click "Add" to add your curve define to the trend

8. Repeat the steps 7-10 for all curves you want to add to the trend.

If you want to change a curve definition, click on the entry in the list do your
modifications and confirm with "Update" .

Prepare The Project

1. Now leave the dialog Macro Online Trend and Cross Ref with "OK".
2. Save your view with File-> Save
3. Choose Project-> Init PPOs and click "OK". (The added PPO's were initialized)
4. If you created a new teq you have to generate a new html file with Project->

Generate HTML...
5. Choose File-> Save All...
6. Compile and download your project now with PG5.

How To Use The Online Trend Macros At Runtime

These sections describes how to use the online trend macros during runtime. The
specific differences in using the online trend macros is described in separate
chapters.



139

Saia-Burgess Controls Ltd. Advanced Functions

Trend Macros

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

Save Trend Curves To Local Hard Disk

It is possible, to save the recorded trends to the local hard disk of the client. The
curves will be saved in a csv-format. As a Java Applet has very limited access to
the resources of the host computer, certain limitations must be considered.

The file download works different with Microsoft VM as with Sun VM, you have to
change the security settings:

Microsoft VM: Java Security Settings
Sun VM: Signed Applets (For Sun VM PlugIn)

 

Set Your Own Start Date/Time

Click "set manual" enter/time, press "ENTER" and click "set auto".
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20.3.4.2 Online Trend Complete

Please see Online Trend Overview for general information about how to use the
online trend macros.

How To Use The Online Trend Complete At Runtime

 
Overview

This section explains how the online trend macro will be used at runtime. The
browser will show a view like this:
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If you edit a text field always press enter to confirm the value

start date/
time

start date and time point of the range shown

end date/time end date and time point of the range shown

scroll buttons scroll back and forward on the time axis

set manual Click this button if you want to set the start point of
the range shown manually.

activated
PPO's trends

The list of all activated PPO's trends.

PPO
Name:

PPO Name of the selected trend

RGB: Red Green Blue value for the curve
Min/
Max:

shown value range on the y-axis

Update:
Click on the "Update" Button after modify the
RGB, Min or Max values.

Add:
Insert a selected trend PPO's trend form the
list of available PPO's trends by clicking the
"Add" button.

Remove
s:

Removes the selected PPO entry in the
activated PPO's list.

available
PPO's trends

The list of all available PPO's trend. During runtime
new trends can be added by clicking the "New"
Button.

PPO
Name:

Enter the name of the PPO you want to add

RGB: Set a RGB color for the new curve
Min/
Max:

shown value range on the y-axis

New Click on the "New" button to add the defined
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PPO

zoom buttons increases or decreases the time axis

Clear Logs Clears the buffer

Save Logs to
file

Saves the data logged in buffer until now in a text file
which can be downloaded

 

How to use the Online Trend at runtime

Add an activated PPO's trend

Select an entry from the list of available PPOs and click "Add".
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Modify properties of an activated PPO's trend

Select a trend from the list on the left. The name, color, YMin and YMax will be
copied to the edit-fields above. The properties can be modified in these edit-fields.
After changing a property please confirm by pressing "ENTER". If you changed
the properties update the curve by pressing "Update".

Add a PPO that is not on the list of available PPOs

With the editor, the user has added the PPO's that shall be available for trending
at runtime.

Additionally, it is possible to add a PPO at runtime. This can be done by indicating
the address of the respective PPO. The use of symbolic names is not possible at
this stage.

Enter The name of the PPO that is not on the list of available PPOs, confirm with
"ENTER" and click on the "New" Button.
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20.3.4.3 Online Trend Minimal

Please see Online Trend Overview for general information about how to use the
online trend macros.

How To Use The Online Trend Minimal At Runtime

This section explains how the online trend macro will be used at runtime.
The online trend minimal:
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Use the scroll and zoom buttons to navigate in your trend.

20.3.4.4 Online Trend Scalable

Please see Online Trend Overview for general information about how to use the
offline trend macros.

How To Work With Online Trend Scalable In The Editor

For information about how to use the Online Trend Scalable in the editor please
see the chapter Offline Trend Scalable. Its is basically the same except there is
no "A" or "B-Variant".
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20.3.5 Offline trending

20.3.5.1 Offline Saved Trend Complete

The Offline Saved Trend Painters are macro objects which can be imported with
the menu Li br ar y- >Get  obj ect  f r om l i br ar y . These macro objects need

no further configuration. They are used to load previously recorded trend curves
from a CSV file. Therefore you needn't to configure any PPOs.

How To Use The Offline Saved Trend Complete At Runtime

Overview

This section explains how the offline saved trend complete macro will be used at
runtime. The browser will show a view like this:

If you edit a text field always press enter to confirm the value

start date/time start date and time point of the range shown

end date/time end date and time point of the range shown

scroll buttons scroll back and forward on the time axis



147

Saia-Burgess Controls Ltd. Advanced Functions

Trend Macros

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

activated
PPO's trends

The list of all activated PPO's trends.

PPO
Name:

PPO Name of the selected trend

RGB: Red Green Blue value for the curve
Min/Max: shown value range on the y-axis

Update:
Click on the "Update" Button after modify the
RGB, Min or Max values.

Add:
Insert a selected trend PPO's trend form the list of
available PPO's trends by clicking the "Add"
button.

Removes
:

Removes the selected PPO entry in the activated
PPO's list.

available PPO's
trends

The list of all available PPO's trend. During runtime new
trends can be added by clicking the "New" Button.

PPO
Name:

Enter the name of the PPO you want to add

RGB: Set a RGB color for the new curve
Min/Max: shown value range on the y-axis

zoom buttons increases or decreases the time axis

Load Data... Loads trend data form a file

Clear Logs Clears the buffer

Save Logs to
file

Saves the data logged in buffer until now in a text file which
can be downloaded

 

Load trend data

Click "Load trend data" to load trends from a file.
Please read the chapter Java Security Settings (for Microsoft VM) or Signed
Applets (for Sun VM) if the open dialog don't appears.

Add an activated PPO's trend

Select an entry from the list of available PPOs and click "Add".

Modify properties of an activated PPO's trend

Select a trend from the list on the left. The name, color, YMin and YMax will be
copied to the edit-fields above. The properties can be modified in these edit-fields.
After changing a property please confirm by pressing "ENTER". If you changed
the properties update the curve by pressing "Update".
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20.3.5.2 Offline Saved Trend Minimal

The Offline Saved Trend Painters are macro objects which can be imported with
the menu Li br ar y- >Get  obj ect  f r om l i br ar y . These macro objects need

no further configuration. They are used to load previously recorded trend curves
from a CSV file. Therefore you needn't to configure any PPOs.

How To Use The Offline Saved Trend Minimal At Runtime

This section explains how the offline saved trend minimal macro will be used at
runtime.

The offline saved trend minimal:

Use the scroll and zoom buttons to navigate in your trend.

Load trend data

Click "Load trend data" to load trends from a file.

Please read the chapter Java Security Settings (for Microsoft VM) or Signed
Applets (for Sun VM) if the open dialog don't appears.

20.3.5.3 Offline Saved Trend Scalable

The Offline Saved Trend Painters are macro objects which can be imported with
the menu Library->Get object from library. These macro objects need no further
configuration. They are used to load previously recorded trend curves from a CSV
file. Therefore you needn't to configure any PPOs.

How To Work With Offline Saved Trend Scalable In The Editor
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For information about how to use the Offline Saved Trend Scalable in the editor
please see the chapter Offline Trend Scalable. Its is basically the same except
there is no "A" or "B-Variant".

How To Use The Offline Saved Trend Scalable At Runtime

Load trend data

Click "Load trend data" to load trends from a file.

Please read the chapter Java Security Settings (for Microsoft VM) or Signed
Applets (for Sun VM) if the open dialog don't appears.

20.4 Alarming Macros

20.4.1 Alarming Overview

Introduction

This chapter gives you an overview about the alarm macros. The differences in
handling for every macro is described in a separate chapter:

1. Online Alarm List
2. Online Alarm History
3. Offline Alarm History

The alarm painters are macro objects which can be imported with the menu 
Li br ar y- >Get  obj ect  f r om l i br ar y . These macros can be used to load

historical logged alarm data from a Saia®PCD and display the data in alarm lists.
The process signals are monitored and alarms picked up independently of the
web browser in the PCD control. The actual alarm function is implemented in the
firmware on the PCD control. It is activated and parameterized using CSF (Call
System Function) instructions, or SFC (System Function Call) instructions for xx7
controls. A Fupla FBox library for the PCD Classic is available. The alarms are
stored in alarm lists in the nonvolatile internal memory of the PCD control.
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How To Work With Offline Alarm History In The Editor

The alarm macros consist of several painter objects which are grouped to one
macro-object. The user can ungroup the macro and access each element
separately. Most of these objects are not editable with the standard dialog of this
editor.

Anyway, all references inside these objects can be accessed and modified by
using the CrossRef function. As the trending macro contains a rather complex
functionality, it is not recommended to modify the references, but the user can
easily move or resize the objects of this macro.

The objects of the alarm-macro communicate with each other via container
variables. The names of these containers will be extended by a unique code at
the moment when the user imports the macro. This is necessary to generate an
unique instance of the alarm macro object. The names to be generated may have
the form e.g.

 "@MACRO_NewYMax.122345676788990". 

The user should not modify such values, as they are generated and modified
automatically. If you export a modified macro, the editor will automatically remove
these indexes. So, you don't have to care about it.

Insert An Alarming Macro Into Your View

1. Create a new Teq view in the project you want to insert the alarm painter. Do
this with Project->Add to Project->New.
(How to create a new project is described in the chapter Getting Started)

2. Insert the alarm macro object into your teq view choose Library-> Get object
from library

3. Change to your "MacroLib" directory. Select the file name of the offline trend
macro you want to insert:

Online Alarm List: "MacroAlarmingDefOnline.tlb"
Online Alarm History: "MacroAlarmingHisOnline.tlb"
Offline Alarm History: "MacroAlarmingHisOffline.tlb"

The inserted Online Alarm List:
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Online Alarm History:

Offline Alarm History:
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Configure The Macro

The following section explains how to configure the alarm macros painter (it is
basically the same in all alarm macro variants):

1. Double-click on the inserted object to open the Cross Ref dialog

2. Click on the entry ".._Macro his Offline Alarm..." (Offline Alarm History) in the
Advanced Select tab.

Online Alarm List: ".._Macro Def Online Alarm..."
Online Alarm History: ".._Macro his Online Alarm..."
Offline Alarm History: ".._Macro his Offline Alarm..."

3. Alarm List PPO Name (in all alarm macro variants):

First of all you have to enter the alarm list PPO name. The alarm macro will
take the alarm list name from the given PPO.
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4. Click the 'Select' button next to the 'Alarm List PPO Name' text field to choose
the PG5 symbol (e.g. A.Alarm.ThisAlarmList.MyName). By the PG5 symbol the
Alarm Macro is referenced to the corresponding alarm list in the PCD.

The PG5 symbol of the alarm list is automatically generated when using the
Alarming FBox library. The user can define the Alarm list name by entering
resp. modifying the name of the FBox.
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The Alarming library is provided together with the Web-Editor and can be
installed or copied into the PG5&/Libs/usr FBox directory. For more details
refer to the online help of the FBox library.

5. Alarm Texts (optional):
If you activate the drop down 'Alarm Texts From CSV File' the java-applet loads
the alarm descriptions from the CSV-file, otherwise the applet will load the
alarm descriptions from the DB.

If you want to use a csv file for your alarm descriptions, activate the checkbox
'Alarm Texts From CSV File'. Enter the size (number of alarm types) of your
alarm list and confirm your choice with 'OK'. Now use the menu function
Project->Generate HTML TAGS CSV file. The editor will generate a new csv
file. Open the csv file in a text editor like notepad and define your alarm
description by replacing the default text like shown in the picture below:
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Use the menu function Pr oj ect - >Pr oj ect  conf i gur at i ons. . .  and

enter the filename of the generated csv file into the field 'csv file' (in the tab
'Project - Applet Advanced').

6. Alarms State Colors:
For every of the following states you can define a color

No state no state
ON alarm is active
ON ACKED alarm is active and acknowledged
OFF alarm is inactive
OFF ACKED alarm is inactive and acknowledged

example alarm list:

7. Filter - Sort:
'Filter - Sort' appears only in the configuration dialog of the Online Alarm List
(see chapter Online Alarm List for details):
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 Prepare The ProjectIf you created a new teq you have to generate a new html
file with Pr oj ect - > Gener at e HTML. . .

1. Choose Fi l e- > Save Al l . . .

2. Compile and download your project now with PG5.

20.4.2 Online Alarm List

How To Use The Online Alarm List At Runtime

 
Overview

The Online Alarm List contains an overview of all alarm types. Actions which are
performed in this list will be applied to all occurred alarms of the selected alarm
type. The user has the possibility to set filters and to choose between several
sorting modes.
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ID, Alarmtext and Counter refer to the alarm type. Time On, Time Off and ACK
refer to the last alarm from ID defined type

ID Unique alarm type Identifier

Alarmtext alarm type description text

Time On At this moment the alarm became active

Time Off At this moment the alarm became inactive. '---' means that the
alarm is still active

ACK In the column ACK shows, whether the alarm is acknowledged
(ACK) or not acknowledged (NCK)

Counter Shows how many alarms occured of the respective alarm type

Acknowledge
Selected
Alarms

Acknowledges all alarms of the selected alarm types

Delete
Selected
Alarms

Deletes all alarms of the selected alarm types

Acknowledge
Alarm List

Acknowledges the entire alarm list

Delete Alarm
List

Deletes the entire alarm list

Total Entries Number of alarm types

Filter Mode No Filter - shows all alarm types
Active Alarms - shows only the alarm types which are active at
the moment
Alarms count - shows only alarm types which were at least
once active
Active or NAK Alarms - shows alarm types which are active or
not acknowledged
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Sort Mode Not Sorted - not sorted
Active Time Sorted - the newest alarm is on top

Select Mode Click this button to switch between single and multi-line
selection

20.4.3 Offline Alarm History

How To Use The Offline Alarm History At Runtime

Overview

Offline Alarm History is a time sorted list containing all occurred alarms. The
newest alarm appears on top. The list is empty at the beginning, the user loads
the alarms by clicking on 'Load Alarm List'. 'Total Entries' indicates the number of
existing alarms. 'Loaded Alarms' the number of already loaded alarms. By clicking
on 'Save To File' a CSV-file will be generated automatically. The CSV-file can be
viewed in any spreadsheet program.
You can sort the list by clicking on the title of a column. 

Click on 'Time On' to sort the alarms in the order they occured.

TID Unique alarm type Identifier

Alarmtext Alarm type description text

Time On At this moment the alarm became active

Time Off At this moment the alarm became inactive. '---' means that the
alarm is still active

ACK In the column ACK shows, whether the alarm is acknowledged
(ACK) or not acknowledged (NCK)
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Load Alarms
List

Loads the alarms

Save To File Generates a CSV-file containing all alarms

Loaded / Total
Entries

Number of occurred alarms

Save Alarm List To Local Hard Disk

Screenshot of the CSV-file generated by clicking on 'Save To File':

The file download works different whether you use a Microsoft VM or a Sun VM,
you have to change the security settings:

Microsoft VM: Java Security Settings
Sun VM: Signed Applets (For Sun VM PlugIn)

20.4.4 Online Alarm History

How To Use The Online Alarm History At Runtime

 
Overview

Offline Alarm History is a time sorted list containing the occurred alarms. The
newest alarm appears on top.
The java-applet loads only the alarms which are shown on the actual page. In the
Online Alarm History the user can perform actions like acknowledge or delete
alarms.
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TID Unique alarm type Identifier

Alarmtext alarm type description text

Time On At this moment the alarm became active

Time Off At this moment the alarm became inactive. '---' means
that the alarm is still active

ACK In the column ACK shows, whether the alarm is
acknowledged (ACK) or not acknowledged (NCK)

Ack Selected
Alarms

Acknowledges all selected alarms

Delete Selected
Alarms

Deletes all selected alarms

Ack Alarms Type Acknowledges all alarms of a type. Select any alarm of
the type you want acknowledge all alarms of.

Delete Alarms
types

Deletes all alarms of a type. Select any alarm of the type
you want delete all alarms of.

Ack Alarm List Acknowledges the entire alarm list

Delete Alarm List Deletes the entire alarm list

Total Entries Number of occurred alarms

20.5 Alarming Macros (2)

20.5.1 Overview Alarming (2)

Introduction

This chapter gives you an overview about the alarming generation 2 macros. The
differences in handling for every macro is described in a separate chapter:
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1. Online Alarm List (2)
2. Online Alarm History (2)
3. Offline Alarm History (2) 

The alarm painters are macro objects which can be imported with the menu
Library->Get object from library. These macros can be used to load historical
logged alarm data from a Saia®PCD and display the data in alarm lists. The
actual alarm function is implemented in the firmware on the PCD control.

Alarming Generation 2 Facts

Extensions

Groups and priorities
Alarm texts in a separate file
Short and long description texts
Texts on 2 lines
Uses the new FBox „Alarm2 SWeb“
Additional help text
New macro configuration dialogues 

Requirements

S-Web Editor Version 5.15
Available for PCD-NT

How To Work With Alarm 2 Macros In The Editor

The alarm macros consist of several painter objects which are grouped to one
macro-object. All alarming generation 2 macros offer a comfortable configuration
dialogue. 
In addition, the user can ungroup the macro and access each element separately
(resizing or removing of objects). But be careful, some of the objects are Event-
Painters that are required for internal use.

Insert An Alarming Macro Into Your View

1. Create a new TEQ view in the project you want to insert the alarm painter. Do
this with Project->Add to Project->New. 
(How to create a new project is described in the chapter Getting Started)

2. Insert the alarm macro object into your TEQ view choose Library-> Get object
from library

3. Change to your "MacroLib" directory. Select the file name of the offline trend
macro you want to insert:

Online Alarm List: "MacroAlarmingDefOnline_5_15_01.esm"
Online Alarm History: "MacroAlarmingHisOnline_5_15_01.esm" 
Offline Alarm History: "MacroAlarmingHisOffline_5_15_01.esm" 
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The inserted Online Alarm List (2):

Online Alarm History (2):
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Offline Alarm History (2): 

Configure The Macro

The following section explains how to configure the alarm macros painter (it is
basically the same in all alarm macro variants): 

1. Double-click on the inserted object to open the configuration dialogue
2. Setup your macro as described in the following sections: 

Basic Alarm List Configuration (Section 1)

1. Click the corresponding 'browse' button in order to select PPO for the alarm list
name:
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2. Select the variable with the alarm list name in the dialogue:

(After configuring this PPO, the alarm list macro is connected to the
corresponding object instance in your PG5 program.)

3. The alarm list macro can show several texts describing (short, long and help
texts) the occurring alarms during runtime. These texts are defined in the ASV
files. 
In the configuration dialogue, only the start name of the ASV file has to be
defined. The file name will then be completed automatically with the suffix of
the current language (more details during the next steps).

Define the *.asv Start File Name 

Please do not change 'AL' since this is the predefined beginning of every ASV
file. The name in our example '_alarmTexts' can be any name you like (avoid
special characters or long names).
You are going to define these ASV files a few steps later. At first we complete
the configuration of our macro.

Column Selection and Resizing (Section 2)

1. Optional: Deselect the check boxes of the columns you do not wish to see
during runtime.
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2. Optional: Resize the width of each column by clicking the arrow left respectively
arrow right buttons.

Filter and Text Options (Section 3)

1. Setup the default filtering mode (Filter Default Value):

No Filter: shows all alarm types
Active Alarms: shows only the alarm types which are active at
the moment
Alarms count: Shows only alarm types which were at least once
active
Active or NAK Alarms: shows alarm types which are active or not
acknowledged

2. Each line will be colored during runtime. There are several modes available.
The corresponding drop down defines which one will be chosen by default.

State Color Mode: Color depends on the event state
Group Color Mode: Color depends on the group membership
Prio Color Mode: Color depends on the event priority

3. Define if you wish to see only alarms of a specific priority (default: All):

4. Choose the priority comparison operator in the second column and the priority
to compare with in the third column:

= Show only alarms that have a priority that is equal to PrioN
> Show only alarms that have a higher priority than PrioN
< Show only alarms that have a lesser priority than PrioN

Where PrioN can be: Prio0, Prio1...Prio7

5. Define if you wish to see only alarms of a specific group membership (default:
All):

6. Choose the group comparison operator in the second column and the group ID
to compare with in the third column:

= Show only alarms that have a group ID that is equal to GroupN
> Show only alarms that have a higher group ID than GroupN
< Show only alarms that have a lesser group ID than GroupN
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Where GroupN can be: Group0, Group1...Group31

7. Check 'Display Long Alarm Texts' to see the long version of the alarm
description during runtime.

8. You may also check 'Display Alarm Texts On 2 Lines' in order to ensure that
the text fits into the column width.

Setup the Color Settings (Section 4) 

1. This section of the configuration dialogue is reserved for the color definition of
each mode. Setup the colors according to your own needs for each mode step-
by-step.

ON Color for alarm is active
ON ACKED Color for alarm is active and acknowledged
OFF Color for alarm is inactive
OFF ACKED Color for alarm is inactive and acknowledged

2. Click on the white corresponding buttons to define each color

3. Confirm your configuration with 'OK' after finishing the color definition. 

Defining the Alarm Texts

As mentioned in the previous steps, the alarm texts can be defined in language
dependant ASV files.
In our example the beginning of each file is 'AL_alarmtTexts'. In order to complete
the file name the browser takes a language dependant suffix during runtime.

Here is the complete ASV file name syntax:

AL_Name_LanguageDependantSuffix.ASV

The italic written part of the name depends on your configuration
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The bold/blue written part of the file name is predefined

LanguageDependantSuffix will be dereferenced with the value of the HTML
TAG 'LANG_SYMB'

The 'Language Dependant Suffix' has its origin in the corresponding language
CSV file.
For 'LANG_SYMB' please use small identifiers with two characters like DE, FR or
EN (you may lookup the language codes in ISO 639-1). After the definition of your
language CSV files you need to set the HTML TAG called 'LANG_SYMB' in each
language file. 

Please see chapter Multilingual HMIs in order to learn how to setup a language
file like 'en.csv'. 
The following lines show the file format of an ASV file:

#!Version;1
#!BB1
#!
DEFSTATUS;DefStat1;DefStat2;DefStat3;DefStat4;DefStat5;
DefStat6;
DEFSTATUS;my state 1 string;my state 2 string;
#!EB1
#!BB2
#!
ID;ShortText;DetailedText;Help;Status1;Status2;Status3;
Status4;Status5;Status6;Status N
1;Motor1;Ventilation Kino 1 Cooler pump motor1 protection
tripped; Motor1 Power;Normal;Fault
2;Motor2;Ventilation Kino 2 Cooler pump motor2 protection
tripped; Motor2 Power;Normal;Fault
3;Motor3;Ventilation Kino 3 Cooler pump motor3 protection
tripped; Motor3 Power;Normal;Fault
4;Motor4;Ventilation Kino 4 Cooler pump motor4 protection
tripped; Motor4 Power;Normal;Fault
5;Motor5;Ventilation Kino 5 Cooler pump motor5 protection
tripped; Motor5 Power;Normal;Fault
6;Motor6;Ventilation Kino 6 Cooler pump motor6 protection
tripped; Motor6 Power;Normal;Fault
#!EB2

#!Version, #!DEFSTATUS, #!BB1, #!EB1, #!BB2, #!EB2, are reserved tokens (do
not change these tokens). Other lines beginning with #! will be ignored (can be
used for comments)

Important Notices
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The browser client cannot load any alarm or event messages if
LANG_SYMB is not defined:

Ensure that a valid language CSV file is defined in your project and loaded during
runtime. It is important that the HTML Tag called 'LANG_SYMB' is defined at any
time to the appropriate language dependant suffix for ASV files.
AL_Name_LanguageDependantSuffix.ASV
Where LanguageDependantSuffix is the value of the HTML Tag 'LANG_SYMB
'.

If no language dependant CSV file is defined yet, click on the corresponding 'CSV'
button in the toolbar to define one.
After the file has been generated, check if the 'LANG_SYMB' has the expected
value (in the example below 'EN'):

Use the menu Pr oj ect - > Pr oj ect  conf i gur at i ons. . .  and go to the tab

'Project - Applet Advanced'.
Activate the option 'HTML Parameters in CSV file' and choose the language CSV
file:

Prepare The Project

1. If you created a new TEQ you have to generate a new html file with Pr oj ect -
> Gener at e HTML. . .

2. Choose File-> Save All...

3. Compile and download your project now with PG5.

20.5.2 Online Alarm List (2)

How To Use The Online Alarm List (2) At Runtime

Overview
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The Online Alarm List contains an overview of all alarm types. Actions which are
performed in this list will be applied to all occurred alarms of the selected alarm
type.

Columns

ID, Prio, Group, Alarm Text, Active and Counter refer to the alarm type. Time On,
Time Off and ACK refer 
to the last alarm from ID defined type.

ID Unique alarm type Identifier

Prio Priority of the alarm type

Group Group membership of the alarm type

Alarm Text Alarm type description text

Time On At this moment the alarm became active

Time Off
At this moment the alarm became inactive. '---' means that the
alarm is still active

ACK
In the column ACK shows, whether the alarm is acknowledged
(ACK) or not acknowledged (NAK)

Active
Usually is set to 1, which means that the alarm type is activated.
Probably set to 0 during service operations.

Counter Shows how many alarms occurred of the respective alarm type

Buttons and Functions

Ack Selected
Alarms

Acknowledges all alarms of the selected alarm types

Delete
Selected
Alarms

Deletes all alarms of the selected alarm types
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Single/Multiple
Select

Switches between the two selection mode (single- and multi-
selection mode)

Ack Alarm List Acknowledges the entire alarm list

Delete Alarm
List

Deletes the entire alarm list

Total Entries Number of alarm types

Enable
Selected
Alarms

Enable the selected alarm type

Disable
Selected
Alarms

Disable the selected alarm type. Suppresses the occurrence
of new alarms (of this specific type), e.g. while service
operations.

Advanced Off/
On

Switches the macro view to the 'Standard' mode

Enable Alarm
List

Enable all alarm types of this list

Disable Alarm
List

Disables all alarm types of this list. Suppresses the
occurrence of new alarms, e.g. while service operations.

Help Text On/
Off

Enables the help texts in the yellow rectangle for the 'Default'
mode view

Filter Filtering Options

Short/Long Switches between long and short alarm descriptions

Filter

Filter Mode
No Filter:
Shows all alarm types

Active Alarms:
Shows only the alarm types which are active at the moment

Alarms count > 0:
Shows only alarm types which were at least once active

Active or NAK Alarms:
Shows alarm types which are active or not acknowledged
Non Ack Alarms:
Show only non acknowledged alarms

Disabled Alarms:



171

Saia-Burgess Controls Ltd. Advanced Functions

Alarming Macros (2)

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

Show only disabled alarms

Enabled Alarms:
Show only enabled alarms

Sort Mode Not Sorted

Active Time Sorted:
Show the newest alarm on top

Group Choose the group comparison operatorand the group ID to
compare with:

  =   Show only alarms that have a group ID that is equal to
GroupN
  >   Show only alarms that have a higher group ID than
GroupN
  <   Show only alarms that have a lesser group ID than
GroupN

Where GroupN can be: Group0, Group1...Group31

Prio Choose the priority comparison operator and the priority to
compare with:

  =   Show only alarms that have a priority that is equal to
PrioN
  >   Show only alarms that have a higher priority than PrioN
  <   Show only alarms that have a lesser priority than PrioN

Where PrioN can be: Prio0, Prio1...Prio7

20.5.3 Offline Alarm History (2)

How To Use The Offline Alarm History At Runtime

Overview

Offline Alarm History is a time sorted list containing all occurred alarms. The
newest alarm appears on top. The list is empty at the beginning.

The user loads the alarms by clicking on 'Load Alarm List'. 

'Total Entries' indicates the number of existing alarms. 

'Loaded Alarms' the number of already loaded alarms. 

By clicking on 'Save To File' a CSV-file will be generated automatically. The
CSV-file can be viewed in any spreadsheet program.

You can sort the list by clicking on the title of a column. Click on 'Time On' to sort
the alarms in the order they occurred.

Advanced Mode View
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Columns 

TID Unique alarm type Identifier

Prio Priority of the alarm

Group Group membership of the alarm

Alarm Text Alarm type description text

Time On At this moment the alarm became active

Time Off
At this moment the alarm became inactive. '---' means that the
alarm is still active

ACK
In the column ACK shows, whether the alarm is acknowledged
(ACK) or not acknowledged (NAK)

Functions and Buttons

Please note: All actions will not take effect until you press the 'Load Alarm List'
button again.

Load Alarms
List

Loads the alarms

Save To File Generates a CSV-file containing all alarms

Loaded / Total
Entries

Number of occurred alarms

Long/Short Switches between long and short alarm description texts 

Save Alarm List To Local Hard Disk

Screenshot of the CSV-file generated by clicking on 'Save To File':



173

Saia-Burgess Controls Ltd. Advanced Functions

Alarming Macros (2)

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

The file download works different whether you use a Microsoft VM or a Sun VM,
you have to change the security settings:

Microsoft VM: Java Security Settings
Sun VM: Signed Applets (For Sun VM PlugIn)

20.5.4 Online Alarm History (2)

How To Use The Online Alarm History At Runtime

Overview

Online Alarm History is a time sorted list containing the occurred alarms. The
newest alarm appears on top. 
The browser loads only the alarms which are shown on the actual page. In the
Online Alarm History the user can perform actions like acknowledge or delete
alarms.

Advanced Mode View

Columns
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TID Unique alarm type Identifier

Prio Priority of the alarm

Group Group membership of the alarm type

Alarm Text Alarm type description text

Time On At this moment the alarm became active

Time Off
At this moment the alarm became inactive. '---' means
that the alarm is still active

ACK
In the column ACK shows, whether the alarm is
acknowledged (ACK) or not acknowledged (NAK)

Buttons and Functions

Ack Selected Alarms Acknowledges the selected alarm

Delete Selected
Alarms

Deletes all selected alarms

Single/Multiple
Select

Switches between the two selection modes (single- and
multi-selection mode)

Ack Alarm Types Acknowledges all alarms of the selected alarm types

Delete Alarm Types Deletes all alarms of the selected alarm types

Total Entries Number of alarm types

Ack Alarm List Acknowledges the entire alarm list

Delete Alarm List Deletes all alarms of this list

Advanced Off/On Switches the macro view to the 'Standard' mode

Filter Filtering Options

Short/Long Switches between long and short alarm descriptions

Help Text On/Off Enables the help texts in the yellow rectangle for the
'Default' mode view

Filter View

Group Choose the group comparison operatorand the group ID to compare
with:

  =   Show only alarms that have a group ID that is equal to GroupN
  >   Show only alarms that have a higher group ID than GroupN
  <   Show only alarms that have a lesser group ID than GroupN
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Where GroupN can be: Group0, Group1...Group31

Prio Choose the priority comparison operator and the priority to compare
with:

  =   Show only alarms that have a priority that is equal to PrioN
  >   Show only alarms that have a higher priority than PrioN
  <   Show only alarms that have a lesser priority than PrioN

Where PrioN can be: Prio0, Prio1...Prio7

20.6 Event List Overview

Introduction

The event list macro can be used to load historical logged events from a
Saia®PCD and display the data in customizable lists. 
In addition to historical logged events, the macro also displays the most recent
events at the beginning of the list.

An example for an event list running in the web browser (scroll further down for
more details):

Facts

The most recent events reside in the PCD's RAM memory and the files are
stored in the PCD's Flash memory
Every event list can be based either on daily, weekly or monthly files
The event list macro can be imported with the menu Li br ar y- >Get  obj ect

f r om l i br ar y  choose the file 'EventsList_[Version].esm' from the sub-

directory 'SaiaEventList' 
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How To Work With Event List In The Editor

The event list macros consist of several painter objects which are grouped to one
macro-object. The user can 'ungroup' the macro and access each element
separately. it is not recommended to modify the references, but the user can
easily move or resize the objects of this macro.

To configure your macro simply double click on the inserted macro in order to
open the configuration dialogue. Please read the step-by-step tutorial in the next
sections.

An example for the event list configuration dialogue:

Inserting An Event List Macro Into Your View

1. Create a new TEQ view in the project you want to insert the event list macro. 
Do this with Pr oj ect - >Add t o Pr oj ect - >New. 

(How to create a new project is described in the chapter Getting Started)

2. Choose the menu menu Li br ar y- >Get  obj ect  f r om l i br ar y  

Alternatively click on the corresponding toolbar icon:

3. Change to your 'MacroLib' directory and select the file name 'EventsList_
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[Version].esm' 

The inserted event list should look like shown in the picture below:

Configure The Macro

1. Double-click on the inserted object to open the configuration dialogue 
2. Setup your macro as described in the following sections:

Basic Event List Configuration (Section 'Events List')

1. Click the corresponding 'browse' button in order to select PPO for the event list
name:
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2. Select the variable with the event list name in the dialogue:

(After configuring this PPO, the event list macro is connected to the
corresponding object instance in your PG5 program.)

3. The event list macro can show several texts describing (short, long and help
texts) the occurring events during runtime. These texts are defined in the ASV
files. 
In the configuration dialogue, only the start name of the ASV file has to be
defined. The file name will then be completed automatically with the suffix of
the current language (more details during the next steps).

Define the *.asv Start File Name 

Please do not change 'AL' since this is the predefined beginning of every ASV
file. The name in our example '_eventTexts' can be any name you like (avoid
special characters or long names).
You are going to define these ASV files a few steps later. At first we complete
the configuration of our macro.

4. The 'Timeout' parameter controls if the event list should be reloaded from time
to time in case of user inactivity. If it is set to -1 (default), the list will only be
reloaded every time the user performs a specific action (e.g. if the user loads
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the first page).

Column Selection and Resizing (Section 'Setup Events List Items And
Column Sizes')

1. Optional: Deselect the check boxes of the columns you do not wish to see
during runtime.

2. Optional: Resize the width of each column by clicking the arrow left respectively
arrow right buttons. 

Filter, Text and Color Options (Section 'Setup Events List Filters And
Display Default')

Define if you wish to see only events of a specific priority (default: All):

'Prio Default Value': Choose the priority comparison operator in the second
column and the priority to compare with in the third column:

=   Show only events that have a priority that is equal to PrioN
>   Show only events that have a higher priority than PrioN
<   Show only events that have a lesser priority than PrioN

Where PrioN can be: Prio0, Prio1...Prio7

'Group Default Value': Define if you wish to see only events of a specific group
membership (default: All):

'Alr ID Standart Value': Choose the group comparison operator in the second
column and the group ID to compare with in the third column:

=   Show only events that have a group ID that is equal to GroupN
>   Show only events that have a higher group ID than GroupN
<   Show only events that have a lesser group ID than GroupN

Where GroupN can be: Group0, Group1...Group31

Define the alarm ID default value (Alr ID Default value).
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Equal means here that you can select an event of a specific alarm ID and then
only filter the events out that have got the same (or equal) alarm ID. This setting
can be changed during runtime.

Define if you wish to see only events that are in a specific state (default: All)

'State Default Value':  Choose the state comparison operator in the second
column and the state ID to compare with in the third column:

=   Show only events that have a state ID that is equal to StateN
>   Show only events that have a higher state ID than StateN
<   Show only events that have a lesser state ID than StateN

Where StateN can be: State0, State1...State7

'Color Mode Default': Each line will be colored during runtime. There are
several modes available. The corresponding drop down defines which one will be
chosen by default.

State Color Mode: Color depends on the event state
Group Color Mode: Color depends on the group membership
Prio Color Mode: Color depends on the event priority

'Display Long Event Texts' Check 'Display Long Event Texts' to see the long
version of the event description during runtime.

'Display Long Event Texts' You may also check 'Display Event Texts On 2
Lines' in order to ensure that the text fits into the column width.

Setup the Color Settings (Section 'Setup Events Colors') 

1. This section of the configuration dialogue is reserved for the color definition of
each mode. Setup the colors according to your own needs for each mode step-
by-step.

2. Click on the white buttons to define each color
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3. Confirm your configuration with 'OK' after finishing the color definition. 

Defining the Event Texts

As mentioned in the previous steps, the event texts can be defined in language
dependant ASV files.
In our example the beginning of each file is 'AL_eventTexts'. In order to complete
the file name the browser takes a language dependant suffix during runtime.

Here is the complete ASV file name syntax:

AL_Name_LanguageDependantSuffix.ASV

The italic written part of the name depends on your configuration
The bold/blue written part of the file name is predefined
LanguageDependantSuffix will be dereferenced with the value of the HTML
TAG 'LANG_SYMB'

The 'Language Dependant Suffix' has its origin in the corresponding language
CSV file. For 'LANG_SYMB' please use small identifiers with two characters like
DE, FR or EN (you may lookup the language codes in ISO 639-1).
After the definition of your language CSV files you need to set the HTML TAG
called 'LANG_SYMB' in each language file. 

Please see chapter Multilingual HMIs in order to learn how to setup a language
file like 'en.csv'. 
The following lines show the file format of an ASV file:

#!Version;1
#!BB1
#!DEFSTATUS;DefStat1;DefStat2;DefStat3;DefStat4;DefStat5;DefStat6;
DEFSTATUS;m y state 1 string;m y state 2 string;
#!EB1
#!BB2
#!ID;ShortText;DetailedText;Help;Status1;Status2;Status3;Status4;Status5;
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Status6;Status N
1;M otor1;Ventilation Kino 1 Cooler pum p m otor1 protection tripped; M otor1
Power;Norm al;Fault
2;M otor2;Ventilation Kino 2 Cooler pum p m otor2 protection tripped; M otor2
Power;Norm al;Fault
3;M otor3;Ventilation Kino 3 Cooler pum p m otor3 protection tripped; M otor3
Power;Norm al;Fault
4;M otor4;Ventilation Kino 4 Cooler pum p m otor4 protection tripped; M otor4
Power;Norm al;Fault
5;M otor5;Ventilation Kino 5 Cooler pum p m otor5 protection tripped; M otor5
Power;Norm al;Fault
6;M otor6;Ventilation Kino 6 Cooler pum p m otor6 protection tripped; M otor6
Power;Norm al;Fault
#!EB2

#!Version, #!DEFSTATUS, #!BB1, #!EB1, #!BB2, #!EB2, are reserved tokens (do
not change these tokens). Other lines beginning with #! will be ignored (can be
used for comments).

Customizing The Macro

In order to adapt the macro on your own needs, feel free to remove and resize
the buttons/painter-objects. But be careful, some of the objects are Event-
Painters that are required for internal use. 

If you 'ungroup' and modify, the macro configuration dialogue will probably not
be available any more. Group all macro objects to have the dialogue again, or
use the Cross Reference dialogue instead. 

Important Notices

The browser client cannot load any alarm or event messages if
LANG_SYMB is not defined:

Ensure that a valid language CSV file is defined in your project and loaded during
runtime. It is important that the HTML Tag called 'LANG_SYMB' is defined at any
time to the appropriate language dependant suffix for ASV files.
AL_Name_LanguageDependantSuffix.ASV
Where LanguageDependantSuffix is the value of the HTML Tag 'LANG_SYMB
'.

If no language dependant CSV file is defined yet, click on the corresponding 'CSV'
button in the toolbar to define one.
After the file has been generated, check if the 'LANG_SYMB' has the expected
value (in the example below 'EN'):
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Use the menu Project-> Project configurations... and go to the tab 'Project -
Applet Advanced'.
Activate the option 'HTML Parameters in CSV file' and choose the language CSV
file:

Prepare The Project

1. If you created a new TEQ you have to generate a new html file with Project->
Generate HTML...

2. Choose File-> Save All...
3. Compile and download your project now with PG5.

How To Use The Event List Macro At Runtime

Default Mode View
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Columns 

EventID Unique event identifier

Prio Priority of the event

Group Group membership of the event

Alarm ID of the alarm type, which the event is related to

Event Text Event Description Text

Time On Time of event occurrence

State Event state

Functions and Buttons

Advanced Switches the macro view to the 'Advanced' mode

Filter Filtering Options

To To Date Jump to a specific date

Stop Loading
Next

Click this button if you wish to abort the loading of any event
files

Reload Event
List

Jumps to the first page and loads the most recent events

Advanced Mode View
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Advanced Off Switches the macro view to the 'Standard' mode

Help Text On Enables the help texts in the yellow rectangle for the 'Default'
mode view

Message Text
On

Enables or disables the message texts for the 'Default' mode
view

Short/Long Switches between long and short event descriptions

Save Saves the events occurred in the specified date range (the
two edit fields beside the Save Button) into a file 

Delete Event
List

Deletes all occurred events from the list

State Color
Mode

Switches between the color modes

Filter Mode View

Columns
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Alarm ID Filter Filter by alarm ID
In the example above we see events of all alarm IDs, since
the value -1 in the edit field stands for 'Show events of all
alarm IDs'.
You may type in any other alarm ID into the input field. 

Set Alr ID Select any of the alarm events shown in the list and then click
'Set Alr ID' in order to see only events of the same alarm ID.

Clear Alr ID Resets the alarm ID filter in order to show events of all alarm
IDs

Priority Filter Filter by event priority

Comparison
operator

=   Show only events that have a priority that is equal to PrioN
>   Show only events that have a higher priority than PrioN
<   Show only events that have a lesser priority than PrioN

Priority to
compare

Where PrioN can be: Prio0, Prio1...Prio7

Group Filter Filter by Group ID

Comparison
operator

=   Show only events that have a group ID that is equal to
GroupN
>   Show only events that have a higher group ID than
GroupN
<   Show only events that have a lesser group ID than
GroupN

Group ID to
compare

Where GroupN can be: Group0, Group1...Group31

State Filter Filter by state ID

Comparison
operator

=   Show only events that have a state ID that is equal to
StateN
>   Show only events that have a higher state ID than StateN
<   Show only events that have a lesser state ID than StateN

State ID to
compare

Where StateN can be: State0, State1...State7
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21 Painter Reference

The painters have a predefined set of action and repaint events, which
cannot be modified. For the 'Professional Edition' Editor user, these
objects can be a set of base objects which can be modified and
extended. The gallery painters are based on the basic painter types,
which are shown inside the 'Painter' toolbox.

Static Painter Objects
Dynamic Painter Objects

 

21.1 Static Painter Objects

The following painters cannot be connected to any external data sources. They
are design elements. For the general and specific properties see chapter
'property window'.

Rectangle, Ellipse, Polygon

These painters gives you the possibility to set some conditions, depending if they
are true or not, the color properties will be changed automatically. To set these
conditions click on the tab 'Border Advanced' in the property window.

Line

The line painter has the same properties as rectangle, ellipse and polygon.
Additionally you can specify in its own properties dialog tab, if you want to
have the line with an arrow at the beginning, the end or at both sides of the
line.
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Image

This Image view painter displays and updates a GIF or XBM formatted
image file. The user can define up to three different images that are
displayed as a function of a condition. The condition input is read from the
web-server (as a process point) and compared to a value, which must be
defined as a private property. More than one image can be displayed at
the same time if the images have a transparent background. The
conditions can refer to the same or different process points. The images
will be scaled to the size indicated in the common properties. The image
files could reside on the web-server this applet is loaded from or in the
local directory ..\webpages. The interior color will be visible as a
background if the images have a transparent background.

Multi Line Label

The Multine Line Label painter displays a multi line text. The source type is
a static text string or a language dependent html tag.
Please see chapter Property Window for details.

21.2 Dynamic Painter Objects

The following painters have an interactive behaviour and their properties can be
edited in property tab (double click on painter). Some of these painters have the
capability to write or modify process points on the server. Any modification, which
is done by the user, will be written instantaneously to the target. It can take a short
time until the new value is updated in the browser view because the new value
has to be reloaded from the target first. This mechanism makes sure that the
values, which are displayed inside the browser, are indeed identical to the
corresponding variables in the PCD System.

Static text
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In the properties of the static text painter you can set some conditions,
depending if they are true or not, the color properties will be changed
automatically. To set these conditions click on the tab 'Border Advanced'
in the property window. You have a additional tab to configure the text
position exactly, click on 'Text Positions Advanced' in the property
window. To show a string, click on Edit a Source in the Repaints tab and
type your text in the name field.

Edit box

This painter displays and updates a process point from the webserver it was
loaded from. When you click on it inside the browser the value can be modified
and be written back to the target by pressing "Enter". The process point can be
both, text or a number.
The 'Text Position Advanced' boarder advanced is available, see 'Static text'
painter for the description.

Button

You can change the displayed string on the button in the property window (double
click on the painter) and 'Edit a Source' in the 'Repaints' tab true and type your
string in the field 'Name'.

With the function URL Jump causes the browser to jump to a HTML page. The
page to jump to is indicated with an URL. This URL can be located on the same
web-server as well as on any other webserver, which is currently available. To
jump to a local HTML page, it is sufficient to indicate the (path and) file name. e.g.
'help.html'. To jump to another server, it is necessary to indicate the complete
URL. e.g. 'http://192.9.225.60/help.html' or 'http://www.ininet.ch/index.html'. Set
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the 'URL Jump' checkbox true and type the URL in the Field 'URL'.

With the function View Jump the browser to jump to another view inside the same
applet. The page to jump to is indicated with an integer. This integer refers to the
teq file number. For details on the numbering scheme inside an applet, see the
section 'Multiple Views' inside this manual. Set the 'View Jump' checkbox true and
type the index number of the teq view where the browser should jump to, in the
field 'view index'.

Bargraph

The 'Bar Graph' painter is able to display a process point in a graphical
representation. To enable the desired functionality, the user must indicate the
range minimum and maximum of the respective process point.
See chapter Property Window for more information's about the 'Bargraph
Advanced' tab.
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22 Editor Reference Guide

This section describes all functions and menus that are available for the
S-Web Editor.

Main Window
Property Window
Group Functions
Library Functions

 

22.1 Main Window

File Menu

New Project Creates a new project file

Open Project Opens an existing project file

Close Project Closes the current project files

Save All Saves the entire project

New file... Creates and inserts new file to the project

Open Opens a TEQ view

Close Closes the actual opened TEQ view

Save Saves the actual TEQ view

Save As... Save the actual TEQ view with a new filename

Close All Closes all opened files

Print setup … Lets you specify which printer is used by the print command
and which paper source and orientation applies

Print preview Shows a preview of the print.

Print Prints out a graphical view file *.teq including a cross-
reference of all its painter objects

Exit Closes the S-Web Editor

Edit Menu

Undo Undo the last action

Redo Redo the previously undone action

Cut Cut the selection an put it on the clipboard

Copy Copy the selection an put it on the clipboard

Paste Insert clipboard contents

Delete Delete selected painters
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Select All Selects all painters

View Menu

Toolbar Makes the toolbar visible/invisible.

Status Bar Show or hide the status bar

Painters Library
Toolbar

Show or hide painters library toolbar

Layout Toolbar Show or hide layout toolbar

Project Files Tree
Toolbar

Show or hide project files tree toolbar

Painter Config Tree
Toolbar

Show or hide painter config tree toolbar

Zoom Zoom in/out view

Project Menu

Add to project  

New Create and insert a file into S-Web Editor project

File Inserts files into S-Web Editor project

Remove from
Project...

Removes a file from project.

Remove/Delete from
Project...

Remove a file from project and delete it from disk

Import PPOs file
(tcr)...

Imports an existing TCR file into your project

Import Containers file
(itq)...

Imports an existing ITQ file into your project

Reload HDLog Files... Reloads project's HDLog files

Project
Configurations…

Configures the project view defaults. If you change a value in
this window, only the views you create after, have the new
properties.

Project Configuration ...: Project - TEQ Configurations
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Width: Default width of views when creating new views from S-Web Editor.
During runtime it defines HMI's width.

Height: Default height of views when creating new views from S-Web
Editor. During runtime it defines HMI's height.

Background
Color:

Default background color of views & painters. This is also the
HTML's background color.

Foreground
Color:

Default outline color for painters

Font: Default font, font style and font size for new painters

Outline Width: Default outline width for painters (in pixel)

Outline Style: Default outline style for painters (solid, dashed or dotted)

background
TEQ:

Default background TEQ view (see chapter Using Fore- And
Background TEQs)

foreground
TEQ:

Default foreground TEQ view (see chapter Using Fore- And
Background TEQs)

csv files
(update):

The editor will create the CSV files defined in the list 'csv files
(update)' if you click Project->Generate HTML TAGS CSV file
After the CSV file is created once, the 'Generate HTML TAGS CSV
file' functionality updates your existing CSV files.
If you define a new 'HTML TAG' reference, the editor will
automatically add it (on the first line) to your existing CSV files, if
you use 'Generate HTML TAGS CSV file'. The editor keeps all your
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translations that you have already made. If you remove 'HTML
TAG' references from your HMI, the editor will show a dialogue.
You have the choice between keep or remove old 'HTML TAG'
references.

(see chapter Multilingual HMIs)

scalable html: Define HTMLs that resize the HMI during runtime according to a
defined factor. Scale your HMI up to 200% for example without
need to change your TEQ-Views. MicroBrowser and IMaster Applet
will resize the TEQ-Views at runtime if you type in the URL of your
new 'scalable' HTML file instead of your standard HTML.

Factor 2.000000 means 200% of 640x480 which is 1280x960
Please note:
Down-scaling (factors < 1.0) is supported with IMaster-Applet. With
the Micro-Browser up-scaling (factors > 1.0) works fine. However
down-scaling does not work correctly and is therefore not
recommanded!
Click 'Add' to define new scalable HTMLs, you don't have to type in
anything manually. After the next 'Build All' the S-Web Editor will
generate and add the new HTML files to your project.

Saia HDLog
Files:

Path to the HDLog files generated by the PG5 Tool

Saia Project
type:

Saia Standard or Saia XX7

Project Configuration ...: Project - Applet Advanced
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Debug: Java console debug messages. If this checkbox is activated the
Java console shows exception messages from the Java Virtual
Machine.
To open the Java console if you work with internet explorer and
Sun java plugin use the menu Tools->Sun Java Console
To open the Java console if you work with internet explorer and
Microsoft plugin use the menu View->Java Console

Order per view: If this option is activated the client applet only gets the PPOs of the
actual view from the target.
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Trend/Alarm
Date/Time
Format

This setting
applies only to
trending and
alarming macros

Format Example Corresponding CSV Entry
dd.mm.yyyy HH:mm:ss 01.12.2009 16:09:03 PM_AM;0
yyyy.mm.dd hh:mm:ss a 2009.12.01 04:09:03 pm PM_AM;1
dd.mm.yy HH:mm:ss 01.12.09 16:09:03 PM_AM;2
yy.mm.dd hh:mm:ss a 09.12.01 04:09:03 pm PM_AM;3
dd-mm-yyyy HH:mm:ss 01-12-2009 16:09:03 PM_AM;4
yyyy-mm-dd HH:mm:ss 2009-12-01 16:09:03 PM_AM;5
dd-mm-yy HH:mm:ss 01-12-09 16:09:03 PM_AM;6
yy-mm-dd HH:mm:ss 09-12-01 16:09:03 PM_AM;7

Format Example Corresponding CSV Entry
dd/MM/yyyy HH:mm:ss 24/05/2011 10:17:24 PM_AM;8
yyyy/MM/dd HH:mm:ss 2011/05/24 10:17:24 PM_AM;9
dd/MM/yy HH:mm:ss 24/05/11 10:17:24 PM_AM;10
yy/MM/dd HH:mm:ss 11/05/24 10:17:24 PM_AM;11
M/d/yyyy h:mm:ss a 5/24/2011 10:17:24 AM PM_AM;12
M/d/yy h:mm:ss a 5/24/11 10:17:24 AM PM_AM;13
dd.MM.yyyy HH:mm 24.05.2011 10:17 PM_AM;14
dd.MM.yyyy 24.05.2011 PM_AM;15
dd.MM.yy HH:mm 24.05.11 10:17 PM_AM;16
dd.MM.yy 24.05.11 PM_AM;17
HH:mm:ss 10:17:24 PM_AM;18
h:mm:ss a 10:17:24 AM PM_AM;19
HH:mm 10:17 PM_AM;20

This setting will be added to your project as a HTML TAG.
Therefore The date and time format can be redefined for each
language file, in order to handle regional differences.
You have to manually set the HTML TAG 'PM_AM' to the
corresponding index.
If no CSV language file has been defined, the HTML TAG is only in
the project's HTML file:

Encode Special
Chars:

Activate this option to ensure that PPOs with special chars (other
than 7 Bit ASCII) in their name will be processed correctly

Decimal Symbol Defines the decimal symbol for floating point values in log files
made by Trending Macros.

period: Update period of process points (PPOs) in milliseconds

main teq: Initial view when loading the HMI

Message Box: Message Box (MsgBox.teq) for error messages. E.g., this dialog
shows a message if the user tries to write a value which is out of
the range given by min. and max. (see chapter Initialising
Processpoints).

Message box
teq:

Filename of the message box TEQ. In most cases you shouldn't
modify this filename. Erase the filename if you don't want to see
any warnings or error messages during runtime.
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Nbr Errors /
Warn:

If a CGI request fails N times (N = Nbr Errors / Warn), the Message
Box shows a warning. If you define 3 for example, one failed CGI
request will not force a warning message. Only if three CGI
requests failed consecutively a message will be shown.

Warn display
time:

Number of seconds before the warning buttons disappears
automatically. (0 means that it will not disappear automatically)

HTML
Parameters in
csv file:

Activate this option if you want to use CSV files

csv file: This CSV file will be reloaded periodically. If you have a 
Multilingual HMI the CSV file should be the filename of your default
language CSV file.

static csv file: this CSV file will be loaded at applet start and never reloaded

Action mode:  

BROADCASTED
ACTION

In the case of overlapping painters, all painters will receive the
given event (for example a mouse down event).
BROADCASTED ACTION should not be used for new projects.
Can be used for compatibilty reasons only.

CONSUMED
ACTION

The first painter that receives the action (and implements an
action) will consume it.

Browsing mode:  

DEFAULT In the DEFAULT mode every client navigates independently from
each other.

MIRROR The name of the actual view will be stored in a PPO. So every
client will see the same view at the same time.
MIRROR should not be used for new projects. Can be used for
compatibilty reasons only.

Mirror PPO
Name:

The name of the PPO which contains the name of the actual view
during runtime.
Mirror PPO should not be used for new projects. Can be used for
compatibilty reasons only.

Loading mode: These options control the way how the Java Virtual Machine loads
the MMI. The upload mechanism can be optimized by the user for
different situations.

Standard Load Default setting.
Loads all TEQ-views at initialization and stores all view's objects
into the RAM memory during runtime. Most users don't mind the
HMI using some time when it first starts up, but they accept no
performance draw-backs in normal operation. This setting allows
the fastest possible reactions at runtime.

Load When
Needed & Keep
Objects

Optimized for operation using slow modem lines. The client
browser is a regular PC with sufficient RAM memory.
Loads the TEQ-views and stores view's objects into into the ram
memory (keep object instances) when the user first visits the TEQ-
view.

Load When
Needed & Keep
Teqs

Optimized for operation using slow modem lines. The client
browser has a Java VM with limited RAM memory.
Loads the TEQ-views only when the user first visits them and
keeps only the TEQ-view file in RAM memory (not the TEQ-view's
objects)

Load When
Needed & Keep
Nothing

Optimized for operation using slow modem lines. The client
browser has a Java VM with very limited RAM resources.
Loads the TEQ-views only when the user visits them and after a
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TEQ-jump all TEQ-view's objects and the TEQ-view file will be
erased from RAM memory.

Project Configuration ...: Project - Build Advanced

With the settings in this tab you can decide what happens if you click on the 'Build
All' button.

Make Memory
Foot Print Check

Make a memory foot print check according to the given hardware
profile

Force Teq Files
saving as 5_13
format (in["..
\Html"] folder)

Choose this option if you use MicroBrowser clients that do not
support a teq format higher than 'g'. If you modify an existing
project, it is automatically converted to the new format unless you
select this option. This option is only active as long as you do not
use functions that require a newer format. If you do so, the editor
will issue a warning.

5.14 file format will not run on older MicroBrowsers unless you
make a firmware update.

Convert
project's GIF to
BMP

Creates for every GIF a monochrome image in the BMP format

Generate Spider
Font files

Creates the S-Web Editor FNT font files according to the defined
HTML Tags and fonts

Generate/Update
Scalable html
files

Generates or updates scalable HTML files
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Generate/Update
language csv
files

Generates or updates CSV language files

Generate html
file

Generates the HTML file

Update
containers/ppo
init files (ITQ/
TCR)

The modified files will be saved and the Container/PPO
initialisation files (ITQ/TCR) will be updated

Save modified
files (TEQ)

All modified files will be saved if you click 'Build All'

Add Macro files
in project sub
folder

Activate this if you want to deploy your project together with the
macro dialogues used in your project. If you do not set this option
and open the project in another editor that has not used some of
the macros, the respective dialog will not be available and the
CrossRef dialogue will open instead.

Warn User If
Problem On Add
Macro Files in
Project Sub
Folder

Every time you insert a macro into your project, a temporary
directory with some settings will be copied. These settings are
required for macros with dialogues. If this directory is missing, the
macro will work during runtime anyway. This setting allows to
suppress the warning, in case of such a directory is missing.

Check For
Unused
HTMLTAG

If you do not want the editor to remove unused HTML TAGs on
'Build all', it makes sense to deactivate this feature (e.g. makes
sense when using some special HTML TAG offset syntax).

Check For
Forbidden Char
In Project's File
Names

Since there are some special characters, which can cause
problems in certain web server's, you have the possibility to let the
editor warn you, if any of these characters are used in a file name.

Project Configuration ...: Project - Advanced

2 Bits colors
paint

Shows the whole HMI in grey scales to see for example how
the eDisplay would display the HMI



200

Saia-Burgess Controls Ltd. Editor Reference Guide

Main Window

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

Hardware
profile

Path to the folder that contains the hardware profile. The S-
Web Editor uses the hardware profile to make the memory
foot print check. This can be useful if you work with the
eDisplay to survey for example the maximum number of
Container variables

Macro Lib Path Defines the path of the Macro Library (supports relative and
absolute paths)

Grid configurations...

Configures the grid:
Grid snap aligns all selected objects to the actual grid settings. If set to true, all
objects will be aligned to the current grid settings. An object will only be aligned if
the user selects and moves it. Changing this setting from false to true will not
affect objects until they are re-selected.

Grid visible Shows or hide the grid

Grid snap Grid snap mode

X <-> Horizontal grid spacing

Y <-> Vertical grid spacing

Grid Color Sets the grid color

Init Containers...

See chapter Initialising Containers
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Init PPOs...

See chapter Initialising Processpoints (PPOs)

Generate HTML...

Creates a HTML source code including the projects applet and components.

Build All

Build project files (see Project Configuration)

Download Project

Download project files via FTP

Generate HTML TAGS CSV file...

see chapter Multilingual HMIs

Generate Cross Ref file...

Generates a Cross Ref file of all project objects (named 'projectnameCrossRef.
txt') in the project directory

Generate Scalable HTML files

Generates project defined scalable HTMLs

Generate Font files

Generates font files containing all characters needed in the project's HTML Tags

Convert project's Gif to Bmp

Converts all GIF images to grey scale BMP images

TEQ view configurations...
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Width: Default width of views

Height: Default height of views.

Background
Color:

Default background color of views & painters

Foreground
Color:

Default outline color for painters

Font: Default font for new painters

Outline Width: Default line width for painters

Outline Style: Default line style for painters

background TEQ Default background TEQ view

foreground TEQ Default foreground TEQ view

Project info
replace

Please make a backup of your HMI before using 'Project info
replace' because modifications will take effect immediately and
can not be undone.

This function is used to replace an info over the whole S-Web Editor
project. An info can be any reference to one of the following types:
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PPO, HTML TAG, STRING, FILE, CONTAINER, TEQ INDEX, URL,
PASSWORD PPO, PASSWORD CONTAINER, CGI, FKEY.

In the example below we replaced the PPO with the name 'PDP,,
R1003,d' with the PPO 'PDP,,R1005,d' over the whole S-Web Editor
project.

Help Menu

About.. Opens a dialogue showing version information and more
details about the S-Web Editor software release

Layout Menu

Align  

Left Left edge selected objects

Right Right edge selected objects

Top Top edge selected objects

Bottom Bottom edge selected objects

Center  

Horizontally Center horizontally

Vertically Center vertically

Make same size  

Width Resize selected object on same width

Height Resize selected object on same height

Both Resize selected object on same width and height

Order  

To Back Sends selected object to back

To Front Sends selected object to front
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Group  

Group Group selected objects

UnGroup Ungroup selected objects

Edit Polygon
points

Edit polygon’s points Activate this to alter each corner point of
an already drawn polygon.

Cross Ref... See chapter Group Functions

Rotate Polygon You can rotate the selected polygon painter by using this
menu function or by clicking on the corresponding button:

Tools menu

Tool
Configuration

reserved for future use

22.2 Property Window

If you double click on a painter a standard dialogue with all properties will appear.
They are grouped in different tabs. Every painter has other properties therefore
the same tabs does not necessarily have the same possibilities.

Dialog Tabs

General Tab

The user can set the position, size, interior & outline color, line width and font for
the active painter. This tab is available for all painters.

The 0/0 position is at the upper left of a drawing. The X-axis goes from left to right
and the Y-axis from top to bottom. The fonts that can be selected are resources
supplied by the Java Virtual Machine which currently runs these applications, so
the results may slightly vary when running in a different environment like a
browser, and there might be minor differences between different browsers, as
they do not use the same Virtual Machine. It is not possible to access fonts, which
are loaded into the operating system of the PC.

With 'Hide and Disable for Groups' you can hide or disable a group. You can also
define a condition, which must be true if the group should be hidden or disabled.
The hide/disable will be set for all that group's painters.

Painter X Offset and Painter Y Offset allows you to define a offset in pixel. The
client browser calculates the new painter position each repaint during runtime.
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Repaints Tab

With this tab you can define the data's which should be displayed by the painter.
Furthermore you can control the visibility of the painter. This is available for all the
painters such as 'Static Text', 'Edit Box', 'Image', 'Bargraph' and 'Button'. The
types that are available for certain graphical objects are CONTAINER, FILE,
HTML TAG, PPO and STRING.

CONTAINER - A container is a local variable, which has a scope within the actual
applet/view. Containers are used to exchange values between different painters in
a view or between different views of the same applet.

FILE - This is used to browse an image file of type *.gif and the file name is
placed in the field Name.

HTML TAG - This is used to configure a text as a HTML tag. If the Type =
STRING and Name = 'Switched_On' is configured then the HMI will always obtain
the text 'Switched_On'. If the Type = HTML_TAG and Name = 'Switched_On' is
configured then the HMI also obtains the text 'Switched_On' if you don't do
anything else. However, in the HTML-start page, <your_projectname>.html, you
can manually add lines of the form <PARAM NAME='<Switched_On>'
VALUE='On'>
Depending on the Value, the text 'On' will be displayed in the HMI.

PPO - Stands for Process Point. A process point corresponds to a PCD variable
(R, T/C, F, I/O,…) that is used within the Web application. This variable can be a
symbolic name taken from the resources of PG 5 or it can be directly used in the
tag form PDP,,R1000,D. Refer to the Web Server Manual 26/790 of how to define
the tag with other media and/or formats.



206

Saia-Burgess Controls Ltd. Editor Reference Guide

Property Window

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

STRING - This is used to display a simple text string.

For example to change the displayed string of a button, set 'Edit a Source' true
and type your string in the 'Name' field.

To insert an image you have to create an image painter then make a double click
on it, click on the tab 'Repaints'. Set 'Edit a Source', choose the entry 'FILE' in the
drop down menu 'Type', click on 'Browse' and select the image. Set 'On
Condition' if you want to show the image only if a specific condition is true. Click
on 'Hide Painter On Condition' if you want to hide the Image if a defined condition
is true.

In the 'Repaints' properties of the 'STATIC TEXT' painter you can define the string
you want to show: Click on Edit a Source, choose the Type STRING in the drop
down menu and type the text in the Name field.

You can configure two repaint sources for each painter. Use the 'On Condition'
feature to activate a source depending on the content of a process point.

On Conditions

You are able to show/hide respectively disable/enable painter-objects depending
on the result of a condition.
The two data sources will be converted into double precision floating point values.
If that did not work, as for variables containing a string, it tries to check if both
strings are equal. If they are not equal, the length of the strings will be compared.

Actions Set Variables

This tab is only available for 'Button' painters.
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Set Variables during mouse down or mouse up event.

Actions Toggle Increment Variables

This tab is only available for 'Button' painters.

You can also toggle or increment a variable on button mouse event.

Actions Jump

This tab is only available for 'Button' painters.
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With 'View Jump' you can jump to a specific view defined by the view name. With
the action 'Back Button' the browser jumps to the view where the user came from.
This information is automatically cached in the 'LastPage' Container. With 'URL
Jump' the browser jumps to the defined URL if the user clicks on the button.

You can also set a variable by the mouse down or up event, toggle a button or
increment a variable.

Hide and Disable Painter Tab

In the tab 'Hide and Disable Painter' you can hide or disable a painter. You can
also define a condition, which must be true if the painter should be hidden or
disabled.

Border Advanced Tab

This tab is available for all painters. It gives you the possibility to change the color
attributes of a painter dependently of a variable value (process point or container).
With 'Color Conditions' you can specify the minimum to maximum range of a
process point or container. You can choose between two or three colors for the
interior and for the outline color.
If you choose '2 colors on condition' you can compare a variable against 0 or 1
and define the corresponding color for the interior and the outline of the painter.

Furthermore you can activate the interior and outline color based on a condition.
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Text Positions Advanced Tab

This tab is available for 'Button' and 'Static Text' painters. The 'Text Positions
Advanced' tab gives you the possibility to center and align the text within the
painter. Each align you can activate on a condition.

Bargraph Advanced Tab

The 'Bargraph Advanced' tab is only used for the bargraph painter.

Source Ranges: configure the min. and max. value that should
be displayed. The min. value belongs to an
empty bargraph (0 %) and the max. value to a
full bargraph (100%). The process point to be
represented can be configured in the Repaints-
tab of the property dialog.
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Orientation: sets the orientation of the bargraph

Scale: configures the scale spacement and visibility.

Line Advanced Tab

The 'Line Advanced' tab is only used for the 'Line' painter. Here you can define if
the line should have an arrow at the beginning, the end or at both sides.

Painter Configuration Window

At the bottom left of the main window there is the painter configuration window.
Each time you select a painter in a graphical teq-view, its main properties were
displayed in the configuration window. Main properties are the repaints and action
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settings of the painter. Furthermore all text strings including symbolical references
were listed in a cross-reference section. There you can change a string by right-
clicking on it and selecting 'Rename Info'.

Function Key

The 'Function Key'-tab is only available for button painers. For each button you
can define a keyboard shortcut.
The keys 'F1' to 'F12' have a special syntax. You have to define 'FKEY_1' for the
key 'F1' for example ('FKEY_1'...'FKEY_12').
If you defined 'FKEY_1' as the function key, the user can press 'F1' on the
keyboard (this will trigger a mouse down event).
This works only in MicroBrowser not in a java-applet webbrowser client.

Multiline-Repaints

The 'Multiline-Repaints'-tab is only available for multi line painters. You can type in
a static multiline text into the field 'Multilined String'.
If you activate 'Auto adjust multiline text' the painter will automatically insert a
carriage return in the displayed text if its length exceeds the painter's width.
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If you choose 'HTML TAG' as the source type you can work with language
dependent csv files. In the csv file you have to work with '\n' (as two characters) to
make a new line:

line1\nline2\nline3
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22.3 Group Functions

Group/Ungroup

By grouping together several painter objects you can modify the properties of the
individual painters together. Furthermore, such a group of painter objects can be
stored as library macro and reused in new S-Web Editor projects.

First you have to select the painters, which should be in the group. (Hold
on SHIFT and click on the painters or draw a frame around the painters
with the left mouse button pressed). To group the selected painters click
on the group symbol in the toolbox

To ungroup the selected group, click on ungroup symbol in the toolbox

To edit the groups properties make a double click on the group and the Group
Dialog will appear.

Group Dialog - Advanced Select Tab

The 'Advanced Select Window' gives you the possibility to edit all painters in the
group. Double click on the group of painters you want to configure and the
property dialog of this group will appear.
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Group Dialog - General Tab

Here you can set some common properties like size, position, color, border and
font. For each property you can indicate if it should be a common property for all
the painters in the selection or not.

You can set common properties for the painters you have selected, or for one
before created group (not both at the same time).

Press 'OK' to confirm your modifications.

Activate the checkbox 'Set Group Properties' if you have selected a group.

Cross Reference

In the 'Cross Reference' window you can redefine all the strings and references
used by the individual painters in the group. In the example below is a string used
by one painter in the group. Selecting it will copy it to the edit field at the top of the
dialog tab. Now you can change it to your desired value and update it by pressing
the button 'Update'. This function is very useful if you have a lot of painters. If you
have a group with many buttons, you can define other references for all buttons
by one click. Simply select the painters you want to set a reference and type the
new reference in the edit box, after this click on the 'Update' button.
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With the button 'Find/Replace' you can quickly change all occurrences of a string
or substring.

Use 'Macro Find/Replace' to quickly change all occurrences of group names in
macros.

The colour information (R,G,B values) you see in the Cross Ref screenshot above
was defined in the 'Border Advanced' tab of a Bargraph Painter:



216

Saia-Burgess Controls Ltd. Editor Reference Guide

Group Functions

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

22.4 Library Functions

With the library functions you can easily store your own painters in a library. The
library is a directory called MacroLib which resides in your PG5 program directory.

Adding A Painter Object To The Library

After having designed your own painter by the use of the basic painters you can
group them together using the group functions described above and select out of
the Library menu the command Insert object into Library... A dialog will appear
where you can give your object a filename (extension *.tlb) and store it into the
"MacroLib" directory.

Inserting A Painter Object From The Library

With the menu function Library->Get object from library... you can insert a library
object into the active teq-view. After having inserted such an object you normally
should alter its references. This is done by double-clicking on it which will pop up
the group dialog. Select the Cross-reference tab and change the references
according to your needs.

Removing A Painter Object From The Library

With the menu function Library->Remove object from library.. you can remove
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and delete a library object. A file selection dialog will appear where you can select
the object(s) to be removed.

Modify Macro From Library

With the menu function Library->Remove object from library.. you can modify an
existing library object. You are not able to overwrite existing macros.
Please see also chapter 'Working With Macros'

22.5 Custom Color Dialog

Every time you define a color in the S-Web Editor the custom color dialog will be
shown.
This dialog allows you to pick up one of the basic colors or to define your own
custom color.

To define a custom color simply pick a color from the color matrix or define a
specific RGB value and click 'Add to Custom Colors'.
The already defined custom colors will also be shown in this dialog.

If you close the S-Web Editor the custom colors will be lost!
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23 Trouble Shooting

23.1 WYSIWYG For Fonts

The principle of WYSYWYG (what you see is what you get) in S-Web Editor
related to font size and font style is restricted. An absolutely identical behaviour on
all different platforms (Editor, Java Clients on different OS's, MicroBrowser XP,
CE and embedded) cannot be guaranteed due to fundamental differences in font
handling and font libraries.

The font as you see it in the S-Web Editor doesn't look like the same as on client
during runtime in every case.

This is because not every client (MicroBrowser, Sun VM or Microsoft VM) has the
same font resources as available in the S-Web Editor.

If you choose a specific font and size in the S-Web Editor that is not available on
your client. Then the client will automatically choose a font which is similar to the
defined one.

E.g., if you choose a font style that is only available in a larger font size, it can
cause problems in displaying text fields because your text fields are maybe too
small. To solve this problem, choose another font size or enlarge the text field. To
improve the results dealing with this issue, it is recommended to use text fields
that are up to 20% larger than the size that is displayed in the editor. The
'Tahoma' font will produce the best results.

Refer to the chapter 'Working With MicroBrowser' for details about fonts in
MicroBrowser.

23.2 Error Messages S-Web Editor

File

Description

File / folder access

Error Messages

ERROR during dir copy process couldn't create the needed folder so exits :

ERROR during dir copy process couldn't find the needed folder so exits :

ERROR during dir copy process for file :

ERROR can't Adds the file to project file should be in project folder :

ERROR While creating project [ xxxx ]!
couldn't copy the tool's runtime library [ yyyy ] into project directory

ERROR While creating project [ xxxx ]!
couldn't copy the msg box TEQ file [ yyyy ] into project directory

ERROR This is not a valid folder.
Please select a valid folder.
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ERROR in macro configuration Dialog can't find the macroTemp folder :
So exits function now

ERROR in GetMacroDlgDataServRootFile returned null file for:

ERROR while renaming file process; can't delete org file:

ERROR while removing-deleting file process; can't delete file:

ERROR during insert Macro's extra files into project;
Can't copy the temp file to insert [xxxx] in actual project folder

ERROR during insert Macro's extra files into project;
The temp file to insert [xxxx] doesn't exist !

ERROR while removing-deleting file process; can't delete file from project's
SAIA_MODIFIED_FILES_FOLDER_NAME " folder: "

ERROR during project file open; unable to change working directory

ERROR during project's file open; unable to change working directory to actual
opening file directory

ERROR during insert file into project; Can't close the file

ERROR during insert file into project; Can't find the file

ERROR during file open; Can not find a frame for document to activate.

ERROR during file open; Can not find a view for document to activate.

ERROR On new file insert; such kind of file can't be new instanciated and
opened in that way for file :

ERROR On new Html file insert; no html template found for file :

ERROR during remove-delete file from project; Can't delete file :

ERROR while creating project; Couldn't generate the init container ITQ file to
put in project directory

ERROR while creating project; Couldn't generate the init ppo TCR file to put in
project directory

ERROR during TEQ file save; file is null so returns

ERROR on make new macro; No macro template found for file :

ERROR during copy file into Saia Converted runtime files folder
([ SAIA_MODIFIED_FILES_FOLDER_NAME" ]).
Couldn't find the file : "

ERROR in rename action got Null Pointer so no new name update made.

Found a file with forbidden char in name; This may cause problem on
Some server so please make sure to use valid name for file :

ERROR in project deployement couldn't create the deploy folder so exits :

ERROR in project deployement couldn't find the deploy folder so exits :

ERROR in project deployement can't find project file :

ERROR in project deployement during usb copy of project file :

ERROR While opening project [ xxxx ]!
couldn't copy the tool's runtime library [ yyyy ] into project directory
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ERROR While opening project [ xxxx ]!
couldn't copy the msg box TEQ file [ yyyy ] into project directory

ERROR in project opening : unable to change working directory ! to the given
directory :

Selected folder must be a SubFolder of the application's installation Path
please select a valid Folder !

so project save process failed.

Macro name can't be equals to the original macro to modify name!
Please enter a valid file name !

ERROR file name length > 24 not allowed (please define a valid file name)

ERROR file name contains spaces or + or . chars not allowed
(please define a valid file name)

That file can't be renamed !

ERROR while generating Old teq format folder files couldn't create folder :

ERROR while generating Old teq format folder files couldn't copy file [ xxxx ] to
the destination file[ xxxx ] seems in readonlymode or locked from an other
process
please first make sure to free all the source and destination files!
Do you wish to continue ?

ERROR while generating Old teq format folder files! couldn't find the project
file [ xxxx ]
Do you wish to continue ?

ERROR can't generate the macro lib needed temp FOLDER :

ERROR while generating Macro's Temp folder!

ERROR during ITQ merge; the selected file name is empty!

ERROR during TCR merge; the selected file name is empty!

Please enter a valid project NAME

Please select a valid project Path Loaction

Please select a valid HW Specific project

ERROR occured in HW Specific project's profile file path

ERROR: no document templates registered with CWinApp -
STRINGTABLESTR_MAINFRAME

ERROR On File Open no template found for file

ERROR On File Open such kind of file can't be opened in that way for file

ERROR: On File Open Can not find a frame for document to activate.

ERROR in CProjectConfigsDoc::UpdateInitContainersTeq couldn't generate
the init container teq file to put in project directory

ERROR in CProjectConfigsDoc::UpdateInitContainersTeq project name
contains non valid char for tcr file name for :

ERROR in CProjectConfigsDoc::UpdateWritesPPOInitDoc() While generating
Saia Converted runtime files folder
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([ SAIA_MODIFIED_FILES_FOLDER_NAME" ]) folder !!"

ERROR in CProjectConfigsDoc::OnMergeTcr() , the selected file name is
empty!

ERROR in CProjectConfigsDoc::OnMergeTcr() , the selected file name is the
actual project init ppo file so nothing to do!

ERROR in CProjectConfigsDoc::OnMergeITQFile() , the selected file name is
the actual project init containers file so nothing to do!

ERROR in CProjectConfigsDoc::OnMergeITQFile() , the selected file name is
empty!

ERROR in CProjectConfigsDoc::UpdateInitPPOFile project name contains non
valid char for tcr file name for :

ERROR in CProjectConfigsDoc::UpdateInitPPOFile() couldn't generate the init
ppo teq file to put in project directory

ERROR in CProjectConfigsDoc::UpdateInitContainersTeq project name
contains non valid char for tcr file name for :

ERROR during project's files check/update.
For Project file :
not found Do you want to erase it from the project files list and go on opening
project
or cancel the project opening ?

Possible Causes

- File/Folder does not exist
- File is being use by another program
- File not accessible
- File is write-protected
- Not a valid file type
- Invalid file name

Solutions

- Create file or folder
- Close other programs
- Adjust file access permission
- Change file name

Resource

Description

Not enough resources to run program properly

Error Messages

ERROR in CGraphicDriver::FillRect can't create pen

ERROR in CGraphicDriver::SetPixel can't create pen

ERROR in CGraphicDriver::DrawLine can't create pen

ERROR in CGraphicDriver::DrawLine2 can't create pen
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ERROR in CGraphicDriver::FillPolygon can't create brush

ERROR in CGraphicDriver::FillPolygon can't create pen

PPO Selector Dlg can't display more then xxxx variables …

ERROR during Container init; couldn't create the container Init Dialog

ERROR during PPO init; couldn't create the PPO Init Dialog

ERROR in TEQ View drawing; Can't create Graphic pen Object

ERROR in TEQ View drawing; Can't create Graphic font Object

ERROR on TEQ View drawing; LButton Up Resizing can't find painter in list for
r =

ERROR on TEQ View drawing; Update selected zone can't find painter in list
for r =

ERROR in TEQ View Print; Can't create Graphic pen Object

ERROR in Editor create; Failed to Initialize Sockets

ERROR couldn't create the FTPDownloadDlg !

ERROR On Help Finder waiting for a *.chm help file name extension but found
:

Failed to create menubar

Failed to create Properties window

Failed to create Project Files view

Failed to create Project View_Explore view

Failed to create status bar

Failed to create toolbar

Failed to create painters toolbar

Failed to create view layout toolbar

Failed to create docking windows

Failed to create Project View_Explore window

Failed to create Project Files view

Failed to create Output window

ERROR: On File Open Can not find a view for document to activate.

Failed to create output tab window

Failed to create output windows

ERROR couldn't create the Var selector Dialog !

Failed to create Properties Edit

Failed to create Properties Grid

ERROR: can't update inserted files tree dialog

Possible Causes
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- Too many PPOs or painters defined
- Not enough RAM
- Program files corrupted

Solutions
- Delete PPOs or painters
- Install more RAM
- Re-install PLC editor

Font Generator

Description

Problem running FontGenerator

Error Messages

Exception in CProjectConfigsDoc::GenerateSpiderFontsFiles The
SpiderFontGenerator Process could not be started...

ERROR1 in FontGenerator while parsing fonts list file so exits Font Generator
now

ERROR2 in FontGenerator while parsing fonts list file so exits Font Generator
now

ERROR3 in FontGenerator while parsing fonts list file so exits Font Generator
now

ERROR4 in FontGenerator while parsing fonts list file so exits Font Generator
now

ERROR5 in FontGenerator while parsing fonts list file so exits Font Generator
now

ERROR6 in FontGenerator while parsing fonts list file so exits Font Generator
now

ERROR7 in FontGenerator while parsing fonts list file so exits Font Generator
now

ERROR8 in FontGenerator while parsing fonts list file so exits Font Generator
now

Possible Causes

- Problem while parsing
- FontGenerator.exe too old
- FontGenerator.exe corrupted

Solutions

- Execute „build all“
- Reinstall PLC editor

FTP Download



224

Saia-Burgess Controls Ltd. Trouble Shooting

Error Messages S-Web Editor

Manual: Saia® S-Web Editor | Document-No. 26/838 | Edition EN06 | 2011-06-20

Description

Problem with FTP or internet connection

Error Messages

FTP Download failed

Cannot open an Internet Session. Please check your internet configuration.

An exception occurred when attempting to create an FTP connection.
Please check your internet configuration and make sure your environment
Is set up with WININET.DLL in the path.

Please enter a valid FTP URL

An FTP connection has not been established.

FTP download not possible because no valid ftp connection available! for
project file :

ERROR no actual valid ftp connection !

ERROR in FTP download for file :

Possible Causes

- No connection to Internet possible
- Invalid FTP URL
- Not connected via FTP

Solutions

- Connect to FTP Server
- Ensure internet connection
- Check FTP URL

HDLog

Description

Problems with files defined in project's teq-configuration

Error Messages

ERROR in HDLog File parsing ; can't find HDLog file :

ERROR in HDLog File parsing ; can't find HDLog file's starting string :
so exits parsing now for file :

ERROR in HDLog File parsing ; can't find HDLog file's parameter :

ERROR in HDLog File parsing file's parameter :

found wrong value in parsed line :

ERROR in HDLog File parsing for curve definition Number :
So exits parsing for that curve now for file :

Possible Causes

- File does not have correct format
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Solutions

- Check HDLog files

Memory Foot Print

Description

Project not suitable for selected HW Settings

Error Messages

ERROR in Memory foot print check ; can't find HW profile file :

Project's memory foot print check for project :

] Project's val =

Project's Memory foot print check

TEQ Views Memory foot print check

check Memory foot print FILE GENERATED FROM PLC EDITOR on :

TEQ View Memory foot print check for TEQ :

] TEQ view's val =

According to default HW profile defines

According to Spider HW profile file :

WAS OK

FOUND INCOMPATIBILITIES FOR SOME HW SETTINGS

For more informations read the memory foot print check log file :

And please adjust the project to HW settings limits then rebuilt the project.

Memory foot print check OK for [

Memory foot print check NOT OK for [

<=

Possible Causes

- Project exceeds limits of selected HW
- HW profile unknown

Solutions

- Adjust project's limits according to selected HW profile and rebuild project
- Select valid HW profile file

License
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Description

Problem checking license

Error Messages

ERROR Can't find the Saia license check dll

ERROR in loading the Saia license check dll

ERROR while getting the Saia license check dll's needed function's address

ERROR with Saia license check dll, so the WebEditor exits now!

Editor found no valid Spider license file to run.
Use the ABORT button if you wish to exit Editor.
Use the RETRY button if you wish to install a valid spider license file;
you will then have to select the path for the editor's license key file
(PLCEditorKey.spl) you got with your installation setup.
use the IGNORE button if you just wish to run the editor in Demo mode

New Ininet License File install Failed!

Editor found incompatible Spider license file since Editor type [ xxxx ]
is different from editor you are running.
Use the ABORT button if you wish to exit Editor.
Use the RETRY button if you wish to install a valid spider license file.
use the IGNORE button if you just wish to run the editor in Demo mode

Editor found incompatible Spider license file since Editor Release [ xxxx ]
is different from editor you are running.
Use the ABORT button if you wish to exit Editor.
Use the RETRY button if you wish to install a valid spider license file.
use the IGNORE button if you just wish to run the editor in Demo mode

Editor found incompatible Spider license file since Editor Release
UNKNOWN .
Use the ABORT button if you wish to exit Editor.
Use the RETRY button if you wish to install a valid spider license file.
use the IGNORE button if you just wish to run the editor in Demo mode

Editor Spider license check failed.
Use the ABORT button if you wish to exit Editor.
Use the RETRY button if you wish to install a valid spider license file.
use the IGNORE button if you just wish to run the editor in Demo mode

Editor Spider license check failed so exits

Possible Causes

- DLL corrupt
- License invalid

Solutions

- Re-install Editor
- Get new license

Demo Restrictions
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Description

Action exceeds demo limitation (only in nanoBrowser projects)

Error Messages

The editor exceeds the number of allowed PPO variables so the application
will exit without saving the project's files !

The editor exceeds the number of allowed TEQ views so the application will
exit without saving the project's files !

The editor exceeds the number of allowed PPO variables so the application
won't save any project's file !

The editor exceeds the number of allowed TEQ views so the application won't
save any project's file !

The editor exceeds the number of allowed PPO variables so the application
will generate a corrupted html file !

The editor exceeds the number of allowed TEQ views so the application will
generate a corrupted html file !

The editor exceeds the number of allowed PPO variables so the application
won't save any changes since last save until the variables number is ok for the
editor !

The editor exceeds the number of allowed TEQ views so the application won't
add any new view to the project until the views number is ok for the editor !

The editor exceeds the number of allowed PPO variables so the application
won't save the TEQ view file !

The editor exceeds the number of allowed TEQ views so the application won't
save the TEQ view file !

ERROR the demo editor can only open default demo project names :

ERROR while opening project : The demo editor can only open default demo
project names :

ERROR the actual demo editor can only open default demo project with
project version number greater as the one you try to open so stops !!

ERROR while opening project :
The project opening index exceeds the MAX opening index for the demo
editor.

Possible Causes

- Inserting macro containing enough PPOs to exceed limits
- Exceeding maximum number of teq views or PPOs
- Opening a project created with a full version of the PLC editor

Solutions

-

GIF to BMP

Description
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Problem converting GIF image to Bitmap

Error Messages

ERROR in during convert GIF to BMP file; can't find project file :

ERROR in during convert GIF to BMP file; can't find image in Graphic driver
for file :

ERROR in during convert GIF to BMP file while generating BMP file :

ERROR in during convert GIF to BMP file; can't get image's HBITMAP in
Graphic driver for file :

ERROR in during convert GIF to BMP file :

Possible Causes

- Incompatible GIF format
- File corrupt

Solutions

- Convert to correct GIF format, first
- Repair GIF

Basic Interpreter

Description

Macro not suitable for editor's basic interpreter

Error Messages

Basic Script Command Do Sleep is not supported!

Basic Script Command Do Input is not supported!

Possible Causes

- Incompatible macro

Solutions

- Macro can't be used

CspiderTextDoc

Description

Program files corrupt

Error Messages

ERROR in CSpiderTextDoc::GenerateHTMLTAGStemplateCSVFile()
prjConfigs is NULL!

ERROR in CSpiderTextDoc::GenerateFTPDownloadLog() prjConfigs is NULL!
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ERROR in CSpiderTextDoc::GenerateHTML() prjConfigs is NULL!

ERROR in CSpiderTextDoc::GenerateSpiderFontsList() prjConfigs is NULL!

ERROR in CSpiderTextDoc::GenerateSAIAPPOInit() prjConfigs is NULL!

Possible Causes

-

Solutions

- Reinstall PLC editor
- Report to support

PCL Remote API Log File Message

Description

Messages in log file when using PCL Remote API (no message boxes...)

Error Messages

ESM insert macro function found yet existing files in project
PLC Remote API automatic returned : OVERWRITE for ALL

ITQ merge function found yet defined containers in project
PLC Remote API automatic returned : OVERWRITE for ALL

TCR merge function found yet defined PPOs in project
PLC Remote API automatic returned : OVERWRITE for ALL

Possible Causes

-

Solutions

-

Teq File Format

Description

Problems handling invalid teq files

Error Messages

ERROR while opening background TEQ file [ xxxx ], first char errorso stops
reading file !

ERROR during TEQ file open; first char Error for file :

ERROR in CProjectConfigsDoc::Serialize while reading
m_newDiagramOutline styles

ERROR while opening TEQ file [ xxxx ], first char error so stops reading file !
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Possible Causes

- Invalid format

Solutions

- Recreate teq file

Background / Foreground Teq

Description

Teq defined as background or foreground is same as teq file edited

Error Messages

ERROR while adding background TEQ name to actual doc , won't add the
TEQ name background TEQ list because same name for file :

ERROR during background TEQ define; The background TEQ defined is the
same as the teq in which it should be defined as background so won't be done
for :

ERROR during background TEQ define; The TEQ file yet contains more then
2 defined back/forground TEQ so no new one added

ERROR : The TEQ configuration : back/foreground TEQ name is the same as
the TEQ itself so that setting is skipped !
Please check the back/foreground TEQ's configurations .

Possible Causes

- Teq file currently being edited or opened contains a background or foreground
teq with the same name

Solutions

- Change background or foreground teq
- Change name of teq currently being edited

Recursive Teq Files

Description

Possible recursion in teq file detected

Error Messages

ERROR while opening TEQ file [ xxxx ], a back/ForegroundTeq defined with a
second inner Back/Foreground defined in was detected , since that may cause
looping problem the background isn't loaded please check the defined back/
foreground teqs .

Possible Causes

- Teq file contains a background or foreground teq file which itself contains a
background or foreground teq file. This can lead to problems And is therefore not
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allowed

Solutions

- Set a teq file as back- or foreground which does not contain a back- or
foreground teq file

Project: Editor Version

Description

Problems with files generated with an other version of the PLC editor

Error Messages

ERROR in CProjectConfigsDoc::UpdateInitPPOFile found a init ppo tcr file with
old naming notation so tries to rename it and use this one. !

ERROR in CProjectConfigsDoc::UpdateInitContainersTeq found a init
container itq file with old naming notation so tries to rename it and use this
one. !

ERROR in project file while reading version nr greater as actual editor version
number so stops !!

Possible Causes

- Files were generated with either an older or a new version of the PLC editor than
the editor currently used

Solutions

- If an older version is required, try this editor's conversion or use an older version
- If a newer version is required, the editor needs to be updated

Macedit Process

Description

Problems starting a macro dialog

Error Messages

ERROR in MacroDlg The Macedit Process could not be started !

ERROR in MacroDlg The Macedit Process could not be started (last MacroDlg
process still running) !

ERROR in MacroDlg The Macedit Process could not be started
(MacroDlgWebServerThread is null) !

ERROR in MacroDlg The Macedit Process could not be started (no free tcp
port found) !

Possible Causes

- An other macro is already running
- The macro dialog's webserver is not running or can not open a port
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Solutions

- Close running macro
- Reload macro dialog
- Restart PLC editor

Macro Dialog Dataserv

Description

Problems concerning the macro dialog dataserver

Error Messages

ERROR macro configuration Dialog dataserv unknown return so kill dialog!

ERROR macro configuration Dialog PLC Dataserv side error during add
modbust struct to project's modbus struct imported files List

ERROR macro configuration Dialog PLC Dataserv side error during remove
modbust struct from project's modbus struct imported files List

ERROR macro configuration Dialog PLC Dataserv side error during modify
modbust struct in project's modbus struct imported files List

ERROR macro configuration Dialog dataserv timeout return so kill dialog!

ERROR macro configuration Dialog timeout so kill dialog!

ERROR macro info to configure's index does not exist in that macro for
macroInfo to configure :

ERROR macro configuration Dialog PLC Dataserv side basic script error
during proceed arguments :

ERROR macro configuration Dialog PLC Dataserv side basic script error
during proceed no basic file name found in arguments !

ERROR macro configuration Dialog PLC Dataserv side basic script error
during proceed for basic file name :

ERROR macro configuration Dialog PLC Dataserv side basic script error
during generates project's needed hdlog file

ERROR macro configuration Dialog PLC Dataserv side error during
generates project's needed modimpList file

Possible Causes

- Problem with MicroBrowser serving the macro dialog
- Not enough resources to load macro dialog (see „Resource“)

Solutions

- Reload macro dialog
- Restart PLC editor
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Macro Dialog Values

Description

Problems with values set in macro dialog

Error Messages

ERROR during macro configuration with MacroDlg; Found [ xxxx ] macro label
Painters so returns.

ERROR during macro configuration with MacroDlg; The name found in macro
label Painter is empty so returns.

ERROR during macro configuration with MacroDlg; First selected painter
groupNbr <=0 so returns.

ERROR during macro configuration with MacroDlg; First selected painter is
null so returns.

ERROR during trend configuration the trends configuration string would
become too long with that new trend configuration so won't add this one

ERROR On Macro Online trend Update button: no valid trend selected to
update! please select one!

ERROR update a trend the trends configuration string would become too long
with that new trend configuration !

ERROR On Macro Online trend Index change: available trends list selected
index greater as list max size!

ERROR On Macro Online trend Remove button: available trends list selected
index greater as list max size!

Possible Causes

- Not a valid value
- Number of values exceeds maximum
- Field empty
- Creating a macro with a teq file containing several macros (Problem with
multiple macro labels)

Solutions

- Check value entered in field(s)
- Reduce number of values

Program Error

Description

Invalid program state

Error Messages

ERROR in CConditionExpression destructor , expression member not ok with
expression type defined!

ERROR during CrossRef generation; no Cross Ref file template found for file :
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ERROR during CrossRef generation;() can't generate a cross ref file no project
opened

ERROR While creating project [ xxxx ]!
couldn't find the tool's runtime library [ yyyy ] to put in project directory

ERROR While creating project [ xxxx ]!
couldn't find the msg box TEQ file [ yyyy ] to put in project directory

ERROR while creating project; Couldn't find the runtime library
IMasterExternJar to put in project directory

ERROR during loading the Saia PG5_PPO_Selector dll

ERROR during getting the Saia PG5_PPO_Selector dll's function address
PcdBrowseForSymbolDlg2

ERROR the Saia PG5_PPO_Selector dll has thrown an exception.

ERROR While opening project [ xxxx ]!
couldn't find the tool's runtime library [ yyyy ] to put in project directory

ERROR While opening project [ xxxx ]!
couldn't find the msg box TEQ file [ yyyy ] to put in project directory

ERROR Can't init PPO vars, no project opened !

ERROR in CSpiderTextDoc::WriteSpiderPPOListCSV() prjConfigs is NULL!

ERROR during TCR generate; project Config is NULL!

The generation of html file needs the applet main take name.
So please first configure a main TEQ for that project.
(Menu : Project -> Project Configurations...Main TEQ)

ERROR OnHtmlNewInsert() can't generate a html file no project opened

ERROR while update csv.lst file name can't find file :

ERROR during ITQ merge; no project opened

ERROR during TCR merge; no project opened

Can't generate new project since no profile file (*.shp) found in editor
installation directory

ERROR in Release Selector application, couldn't generate the h file

ERROR OnProjectGeneratehtmltagscsv() can't generate a csv file no project
opened

Possible Causes

- No project opened
- Program installation corrupt

Solutions

- Open project
- Report to support
- Reinstall PLC editor
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23.3 Error Messages IMaster Applet

Webserver

Description

URL not found on PLC's webserver

Error Messages

cgiOrderValues failed ! ( xxx ) WEB SERVER problem !!

cgi_call failed ! [ xxxx ] ( yyyy ) WEB SERVER problem !!

WEB SERVER problem !!

Possible Causes

- No connection to webserver
- Invalid path

Solutions

- Check physical connection to PLC (i.e. ping)
- Check path
- Check webserver version on target PLC

HTML parameter not found

Description

Parameter in HTML file needed for applet not found

Error Messages

HTML Parameter not found! [ AppletName ]

HTML Parameter not found! [ ProjectName]

HTML Parameter not found! [ Main ] or not correct, xxxx

HTML Parameter not found! [ Main ] or not correct, xxxx

Possible Causes
- Wrong HTML file
- Invalid HTML file

Solutions

- Call right URL
- Generate new HTML file with PLC Editor and download project to PLC again

File not found

Description

File requested from webserver was not found
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Error Messages

Loading file failed! : xxxx

Loading file failed! : xxxx

Loading file failed! : xxxx

Loading file failed! : xxxx

Possible Causes

- Webserver problem
- File not available on target PLC

Solutions
- Check for webserver problems
- Download whole project to PLC, again

Value out of bounds

Description

Value entered exceeds range defined for this PPO

Error Messages

value out of bounds ! [ xxxx ... yyyy ]

value out of default valid ranges !

Possible Causes

- Value entered i.e. a TextField exceeds limits defined for this PPO in the project's
TCR file
- Limits defined for this PPO in the PLC project are wrong

Solutions

- Choose value within the defined limits
- Change PPO limits in editor (init PPO)

23.4 Warnings Messages S-Web Editor

File

Description

File / folder access

Warning Messages

WARNING : [ VPIAPPLETHTMLNAME " ] not found or invalid ! "

WARNING while updating project's MacroLibTemp for :

WARNING while updating Tool's MacroLibTemp can't generate tool's temp
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folder for :

WARNING while updating Tool's MacroLibTemp can't find tool's
MacroLibTemp subfolder for :

WARNING while updating Tool's MacroLibTemp for :

WARNING didn't found any corresponding fnt file
In project directory and coulnd't create it
So makes nothing for file name :

Details

File or folder could not be found/created/opened. For more information see File in
Error Messages.

FTP Download

Description

Warnings regarding the FTP or internet connection

Warning Messages

WARNING couldn't open the project defined remote Folder [xxxx]
So uses the root directory on target
Use the CANCEL button now if you don't want to modify the project defined
FTP remote folder.
Make sure the remote folder exists on download target.

Details

If a specified folder does not exist on the target the editor sets folder to the
target's root folder. If you wish to define a different folder you can press „cancel“.

HDLog

Description

Problems with files defined in project's teq-configuration

Warning Messages

WARNING after parsing the number of parsed curves definition is not equal to
defined record number for file :

Details

The HDLog file has either been imported wrong or is not present. The program
will proceed, nevertheless.

Recursive Teq Files
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Description

Possible recursion in teq file detected

Warning Messages

WARNING : editor found a recursive background TEQ on itself so will erase it
for TEQ :

WARNING : editor found more then 2 background teqs defined for a TEQ view
as this won't work it will save only the two first one! for TEQ :

Details
- Two teq files specifying each other as their background result in a recursion: this
will lead to problems in the MicroBrowser and is therefore prevented by the editor.
- A teq file can only have up to two background teqs

Project: Editor Version

Description
Problems with files generated with an other version of the PLC editor

Warning Messages

In project [ xxxx ]
project laoded runtime library [ yyyy ]
different from tool's one [ zzzz ]
If you want to modify the project with that tool you need to replace the runtime
library with the tool's one
Do you want to replace the runtime library with the tool's one?
Elsewhere you will just be able to open the files in read only mode , no
modification will be saved in files

In project [ xxxx ]
project laoded runtime library [ yyyy ]
may be older OR different from tool's one [ zzzz ]
If you want to modify the project with that tool you need to replace the runtime
library with the tool's one
Do you want to replace the runtime library with the tool's one?
Elsewhere you will just be able to open the files in read only mode , no
modification will be saved in files

WARNING you are opening a project made with an older version of the editor
do you really want to open that project :

Details

If a project generated with an older version is opened with a newer version of the
PLC editor some files are converted to the new format. This project then can no
longer be opened with an editor of an older version.
However, choosing to allow the newer editor to open the project will not convert
the project immediately. You will be prompted to decide whether or not to replace
the runtime library (IMaster applet): „yes“ means the project will be finally
converted to the new version of the editor; „no“ means the project will be opened
read only.
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PPO

Description

PPO variable warnings regarding name, format or unit.

Warning Messages

WARNING : editor found an empty variable name in TEQ :
Since an empty var name will only cause trouble it is now replaced by :
Please take time to have a look on those variables and give them a valid name
!

Details

- If a PPO name is left empty the editor sets a name to prevent problems in the
MicroBrowser

Painter Position

Description
Painter position exceeds size of teq view

Warning Messages

WARNING in TEQ View Painter's size and position check; Found
Polyline\Polygon painter with false size
So it will not be automatically resized please make the correction manually.

WARNING found painters with bad positions or size
In painters list to paste do you really want to paste them ?

WARNING found painters with bad positions or size in TEQ view :
do you want the PLCEditor to Resize and reposition them automatically ?

Details

Painter to be inserted has position and/or size properties that exceed the limits of
the target teq. Except for polyline/polygon painter, the painter properties will be
set to make the painter fit.

String Restrictions

Description

String is too long or contains invalid characters

Warning Messages

WARNING : editor found a too long user defined string to copy so will trunc it
before copy :

WARNING the trends configuration string would become too long (buffer max
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size = 2KB) with that new trend configuration !
[trends config string length = 90*nbrtrends+eachTrend'sNamelength]
So makes no update!

WARNING in csv generating the HTML TAG [ xxxx ] contains the csv token
separator special char[;]
so that HTMLTAG won't be put in the generated csv file until user modified it !
Press CANCEL if you don't want to continue the csv file generation

WARNING Saia File name length > 24 not allowed so won't add that file to
project :

WARNING File name contains spaces or + or . chars not allowed so won't add
that file to project :

WARNING Saia File name length > 24 not allowed on Saia Server please
check that file :

Details

String's length exceeds a maximum or contains invalid characters. Some strings
might be created automatically. For invalid characters check the warning
message.

MicroBrowser Version

Description

Problems forcing saving in 5.13 version

Warning Messages

during BuildAll project [ xxxx ] Editor found some views that needed to be
saved in a teq format newer as the 5.13 release.
Please check if you need to use the Force teq saving as 5_13 option if you
need older microbrowser clients!

Details

Some contain macros or painter that are not fully compatible with the 5_13 teq
format. They can not be fully edited anymore after saving them in 5_13.

Teq View Print

Description

Problems printing teq view

Warning Messages

WARNING in TEQ View Print; The printer configured dpi value isn't height
enought for the printing job please reconfigure it (>= 300 dpi)

WARNING in TEQ View Print; Bit blit function not supported from printer this
may cause problem for images print
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Details

- The selected printer is not configured properly: the printer's resolution needs to
be set to at least 300dpi
- The selected printer does not support bit blitting: images might not be printed
correctly

Copy Macro

Description
Copying macros containing indexed macro containers

Warning Messages

WARNING found indexed macro containers in copied painters,
so you may make copy of same macro instance,
if you need different instances of macros please use the get object
from library function
Instead of the copy\\paste function please !

Details

When you copy a macro the copy behaves exactly as the original: Editing the
original changes the copy as well. To make shure this does not happen, create a
new macro instance ('Library/get object from library')

CSV File

Description

CSV file not specified or not found

Warning Messages

WARNING didn't found any corresponding csv file
in project directory and coulnd't create it
So makes nothing for file name :

WARNING the project's CSV Files to update list is empty
please first configure that list in project settings !
Would you now to add one csv file to that list ?

Details

- Before the csv files can be generated automatically they have to be defined in
the project's settings

- The csv files specified in the project's settings have to exist

Unused HTML Tags
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Description

HTML tags defined in CSV file but not used in project

Warning Messages

WARNING found HTML tags in csv files that are no more used in actual
project
Do you want editor to delete those HTML Tags?

Details

When building the CSV files the editor checks all HTML tags in all the teq files
against the HTML tags in the CSV file. If a tag tag in the csv is not used in the
project's teq files. By clicking „yes“ all these unused tags in the CSV file are
deleted, otherwise they remain in the file (this can be necessary if you use
dynamic tags, for instance a HTML tag „text@PPO_textID@“ in a painter could
be resolved into „text1“, „text2“, … by the dataserver – unknown to the editor –
and will require a respective entry in the csv file)

23.5 Dialogs Messages S-Web Editor

Message:

Select Your Project's Deployement Location

Description:

The location can be a local or network path.

Message:

Import Extended Macros Needed Files Confirm Actual project yet
contains a file named :

Description:

The macro-object contains a file that has the same name than a project file

Message:

Import PPO File Confirm
Actual project PPO settings yet found for PPO :
Do you want to keep actual settings for that ppo or use the ToImport TCR file's
one ? [project settings = xxxx] [Import TCR settings = yyyy];

Description:

Keep:
Project's PPO settings
Keep for All:
Project's PPO settings (for all PPO variables)
Overwrite:
Use new imported settings
Overwrite for All:
Use new imported settings (for all PPO variables)
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Message:

Import Editable Container confirm
Actual project Container settings yet found for editable Container :
Do you want to keep actual settings for that container or use the ToImport ITQ
file's one ?
[project settings = xxxx] [Import ITQ settings = yyyy]

Description:

Keep:
Project's container variable initial value
Keep for All:
Project's container variable initial value (for all container variables)
Overwrite:
Use new imported settings
Overwrite for All:
Use new imported settings (for all container variables)

Message:

Import Non Editable Container confirm
Actual project Container settings yet found for NonEditable Container :
Do you want to keep actual settings for that container or use the ToImport ITQ
file's one ?

Description:

Keep:
Project's container variable initial value
Keep for All:
Project's container variable initial value (for all container variables)
Overwrite:
Use new imported settings
Overwrite for All:
Use new imported settings (for all container variables)

Message:

Display the FTPDownload log file ?

Description:

The log file contains a list of all files and indicates if the download was successful
or not.

Message:

Project's Files saved on target Succeed

failed for some files:

For more informations read the ftpDowlnload log file :
FTP download on target IP Address :
FTP download in target Folder :
FTP download for project files :
FTP connect WEBS dir NOT FOUND so creates it and jumps in
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Description:
FTP download status messages

Message:

Do you now wish editor to use the spiderFontsList.txt file and generate
the project's needed font files?

Description:

spiderFontsList.txt contains a list of used font types to create font files.
The created Font Files are used e.g. for NanoBrowser (based on spiderFontsList.
txt).

Message:

Select Your New MacroLib's Location

Description:

The location can be a local or network path.

Message:

Please modify now the macro in MACROMODIFY_TEMPTEQNAME "
view.
Then group the modified macro and save it with a new macro name.
Please note that the editor is now in a special mode with limited function for
modification in " MACROMODIFY_TEMPTEQNAME ".
Editor will go back in default mode when you 'll save the modified macro."

Description:

The editor switches into a reduced functionality mode while modifying macros.
Please see chapter 'Working with Macros' for details.

Message:

Actual project ppo settings yet found for PPO :
Do you want to keep actaul setting for that ppo or use the to merge file's one ?

Description:

Defines the behaviour if the imported TCR contains the same PPO variable than
the project, but with other settings.

Message:

This object can not open a standard dialog.
Use CrossRef to modify

Description:

This painter-object was not configured with the painter properties standard
dialogue.
For example in case of Event Painter objects or other more complex painter-
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objects.

Message:

This object can not open a standard dialog.
Do you want to use CrossRef to modify it ?

Description:

This painter-object was not configured with the painter properties standard
dialogue.For example in case of Event Painter objects or other more complex
painter-objects.

Message:

Save actual project's changes in ... before closing actual one ?

Description:

Project save dialogue before closing the project

Message:

Save actual project's changes in ... before Build All ?

Description:

Project save dialogue before starting the 'Build All' process

Message:

Save actual project's changes in ... before FTP Download ?

Description:

Project save dialogue before starting the FTP download

Message:

Save actual project's changes in ... before opening new one ?

Description:

Project save dialogue before opening a new the project

Message:

Save actual project's changes in ... before Init PPos ?

Description:

Project save dialogue before showing the PPOs initialisation dialogue.

Message:
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Select A New HW Specific Sub Folder

Description:
Directory for target specific files (e.g. hardware profile).
The hardware profile contains default project settings for a specific device.

Message:

Select Your New Project's Location

Description:

The location can be a local or network path.

Message:

Project's PPOs Compatibility Check for project : According to Target's PPO
settings file : FOUND INCOMPATIBILITIES FOR SOME PPOS

For more informations read the PPOs check log file :

Description:

SAIA xx7 compatibility for PPO settings.

Message:

ERROR in Build all , the generation of html file needs the applet main TEQ
name
so please first configure a main TEQ for that project
(Menu : Project -> Project Configurations...main TEQ)

Description:

Every HMI project needs a main TEQ to start

23.6 Critical Issues With Larger Web Editor Projects

Maximum size of Web Editor projects

To determine the maximum size of Web Editor projects, the crucial figures are
the maximum number of PCD data points (PPOs) and/or the maximum number
of TEQ pages (views). These limits are mainly determined by the size of the RAM
disk in the PCD Web Server. The behaviour and the use of the RAM disk are
explained in Section 2 of this document. For the beginning of 2006, new official
firmware versions are planned, which will resolve the RAM disk problems. $
versions are already available (see 2.2). Depending on the project size and the
type of communication link (e.g. modem, gateway), it may also be necessary to
modify other timing parameters. These are described in section 3.

RAM disk

The maximum RAM disk size is dependent on the PCD type:
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PCD type FW version max. RAM disk [kB]

PCD3.Mxxxx 1.10.xx 48

PCD2.M480 1.10.xx 48

PCD2.M170 017 32

PCD2.M150 $C6 32

PCD1.M1x5 0A1 32

PCS1.Cxxx 01A 5

The RAM disk should always be set to the maximum size. In the firmware
versions listed
above, the default setting represents the maximum value.

What is RAM disk used for?

Where a browser (or Java applet) reads the PCD variables (R/T/C/I/O etc.) with
the CGI functions "OrderVal.exe" and "ReadFile.exe", matching files are stored in
the RAM disk. Web projects created with the Web Editor use these functions.

The size of the files in RAM disk is dependent on the number of PCD data points
(PPOs).

The following values apply:

PCD type from
firmware

max. RAM
disk size

max. no. of PPOs
with 

max. no. of
PPOs 
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version* fw version* with older fw

PCD3.Mxxxx 1.10.xx 48 2500 600

PCD2.M480 1.10.xx 48 2500 600

PCD2.M170 020 32 1500 600

PCD2.M150 $C6 32 1500 -

PCD1.M1x5 0A1 32 1500 600

PCS1.Cxxx BA5 5 250 100

The following formula was used to calculate the maximum number of PPOs:

(Max RAM disk size)/20 bytes = Number of PPOs

20 bytes is an average value for PCD media access (e.g. PDP,,R8000,d).

The maximum values listed above assume that the RAM disk contains only one
file. This will be the case where the "order per view" option is not set in the Web
Editor, i.e. the PCD variables from all TEQ views (screen pages) are refreshed
cyclically from a single Project Data File.

If the maximum number of PCD variables is exceeded in a given project, older
firmware versions may cause the PCD to crash. In systems with new versions, all
PCD variables are no longer refreshed, and a "No message" error will be
displayed in the browser. There will also be an entry "WEB RAM TOO SMALL" in
PCD history.

Where the RAM disk contains multiple files, the number of values per file will be
reduced accordingly.

When does a RAM disk contain multiple files?

If the "Order per view" option is set in the Web Editor, a separate file will be saved
to the RAM disk for every web page (TEQ view) called. In this case, only the PCD
variables for the TEQ view (web page) visible in the browser will be read cyclically
by "OrderVal.exe" and "ReadFile.exe". This has the advantage that shorter
refresh times can be achieved.The disadvantage of this option is that a separate
file is saved to the RAM disk for every TEQ view. Once a page has been called,
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the file stays in RAM disk. The number of files in RAM disk is restricted, limiting
the maximum number of TEQ views in a Web Editor project.

The maximum number of TEQ view pages with the "order per view" option set is
dependent on the PCD type and firmware version:

PCD type from
firmware
version*

max. RAM disk
size

with fw
version*

with older
fw

PCD3.
Mxxxx

1.10.xx 48 48 12

PCD2.
M480

1.10.xx 48 48 12
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PCD2.
M170

020 32 32 12

PCD2.
M150

$C6 32 32 -

PCD1.
M1x5

0A1 32 32 12

PCS1.
Cxxx

BA5 5 0 0

The "order per view" option should not be used with the PCS1 (RAM disk too
small).

With new PCD systems (PCD2.M5xxx, PCD3.Mxxx) the RAM-Disk is managed
automatically. In case it becomes full either the oldest file is deleted or the whole
RAM-Disk is re-initialised.

Setting the timing parameters

In principle, the timing behaviour of access to the web pages can/must be set in
four other places:

a
)

The priority of the Web
Server "task" in the
PCD

(can be set in the Web Builder)

b
)

The Response timeout
for the S-Bus

(can be set in WebConnect)

c
)

Communication
(request) timeout for
the S-Bus

(can be set in the Web Builder)

d
)

The refresh time for the
Java applet

(can be set in the Web Editor project)

a) The priority of the Web Server "task" in the PCD

This setting defines how the
CPU should split its capacity
between the Web Server and
the PLC task. The higher the
priority, the more CPU time is
used for the Web Server task,
and the shorter the response
time achieved.
The example on the right
should be interpreted as
follows:
for 21 ms, the CPU processes
the "normal" user program; for
4 ms, the Web Server task is
processed.
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b) The response timeout for the S-Bus in the WebConnect software

On the WebConnect
Setup page (where the
connection to the PCD is
configured: http://
localhost/setup), a
"Response timeout" can
be defined.
For every telegram sent
from the WebConnect
software to the PCD, the
software waits this long
for a response from the
PCD.
This "Response timeout"
only needs to be
considered in the case of
modem communication
or Web Server access
via a gateway.
With modem
communication, a
minimum timeout period
of 4 seconds has to be
defined.

c) Communication timeout (Request timeout) for the S-Bus in the Web-
Builder

The key combination "CTRL + Saia" can be used to call up the hidden Advanced
Settings menu in the Web-Builder.

The Communication timeout must be adjusted on a PCD Web Server station
accessed via a modem or a PCD gateway. This timeout must be set to a higher
value than the "Response timeout" mentioned above. As a rule of thumb, it could
be set twice as high.

What is this timeout used for?

With S-Bus, WebConnect has to issue several S-Bus requests before a web page
is completely loaded. The Communication timeout is the maximum time between
requests. If this time is exceeded, the Web Server performs a reset and the
requested

page is not displayed in full.
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d) Refresh time of the PCD variables with the Java applet in the Web
Editor

This parameter defines the refresh time for the PCD variables in the web browser.
The parameter is set in the Web Editor under "Project - TEQ Configurations", in
the "period" field under "applet params".
If the refresh time is too short, the applet will send a new request to the PCD as
soon as the PCD has responded to the preceding request.

To avoid an unnecessary communication load, the refresh time should be set as
high as possible.
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24 Abbreviations

HMI Human Machine Interface, i.e. a PCD.Web-Server view
displayed at a Web panel or PC browser.

*.prj File extension for a PCD.Web-Server project file generated
by the
S-Web editor.
A PCD Web-Server project includes everything to form a
HMI on a touch panel or in a browser.

View A view is what the user of a HMI sees at one moment inside
a window or a browser. A *.teq file implements a view.

*.teq File extension for a PCD. Web-Server view file generated by
the S-Web Editor.

*.tcr File extension for the Web-Editor PPO variable initialisation
file. It contains all PCD-Variables of the Web-Editor project
with its definitions for the display format and input ranges.

*.itq File extension for the Web-Editor Container variable
initialisation file. It contains all container variables of the
Web-Editor project with its initialisation values.

*.esm File extension for a S-Web Editor macro object.

*.tlb Since version 5.12 the editor creates macro files with *.esm
file extension. The editor is backward compatible with *.tlb
files which is the old macro format.

Painter A painter is a graphic object, which is used by the S-Web
Editor. This object is programmed in JAVA. Several painters
were packed into an Applet that resides on an embedded
system.

Applet A Java program, which can be launched in a browser from
within a HTML page.

PPO Process Point: A process point corresponds to a PCD
variable (R, T/C, F, I/O,…) that is used within the Web
application

Contain
er

A Container is a local variable, which has a scope within the
actual applet/view. Containers are used to exchange values
between different painters in a view or between different
views of the same applet

IMaster.
jar

File that contains all the required java classes used in the
applet as well as the main class which starts the applet
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